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Textbook Purpose 
This text was created to provide students enrolled in Technical Education Programs or professionals in 

business and industry with contextual learning opportunities to develop the necessary computer skills to 

function in the 21st-century workforce in a non-IT technical field.  

Topics and skills provided in this text include using and changing the Windows desktop; downloading 

software from the internet; the file hierarchy and saving files; using the basic functions of word 

processing, spreadsheet and presentation software to create and format documents; the use of email 

clients to send messages; how to attach documents and organize tasks; connecting to and using the 

internet; searching the web effectively; working with sounds and picture files, and understanding 

privacy issues and how to prevent identity theft when using computers and the internet. In addition, 

content regarding Microsoft Office, including Word and Excel will be covered in great depth.  

All images and content unless referenced are taken from the author’s expertise and personal computer 

and may be shared freely as appropriate. 
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Chapter 1: How does a computer work? 
Computers are amazing devices that have transformed our world. However, before we can begin using 

one, we first must have a basic understanding of how a computer works. Chapter1 focuses on the 

hardware and design of a computer first to provide the user with an adequate foundation to begin to 

master all of the capabilities of a computer. 

What is a computer? 

A computer is an electronic device that can manipulate, process, and execute information or data. You 

can use a computer to type and share documents, send an email, play video games, and browse the Web. 

You can also use it to edit or create spreadsheets, presentations, and even videos, and create other 

computer programs. 

Hardware and software 

There are two main components of a computer: hardware & software 

• Computer Hardware is all of the physical parts of your computer like the keyboard and mouse.  

It also includes all the computer's internal parts,  

• Computer Software is the code/instructions that are programmed to be executed by the 

computer. The software directs the hardware what, when, and how to do something. Examples 

of software include web browsers, games, and word processors. Below, you can see an image of 

Microsoft PowerPoint, which is used to create presentations. 

 

What are the different types of computers? 

There are billions of computers in our society today. Computers can come in all shapes and sizes, and 

they perform a variety of functions to allow our society to function. You use computers to purchase 

goods, perform a math calculation for a test, or watch tv. It would be hard for you to complete a day 

without directly or indirectly using a computer.   
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Desktop Computers 

Desktop computers are usually large and 

designed to be typically made up of a few different parts including the computer case, monitor, 

keyboard, and mouse. Typically, Desktops are the most powerful computers. 

Laptop Computers 

The second type of computer that is the most popular type of 

traditional computer at present is a laptop computer. Laptops are battery-powered computers that are 

portable than desktops, allowing you to use them almost anywhere. Most laptops have all of the 

components of a computer connected so you can easily move your computer. Laptops are usually less 

powerful than desktops. 

This Photo by Unknown Author is licensed under CC BY-NC 

This Photo by Unknown Author is 

licensed under CC BY-SA 

http://pngimg.com/download/17489
https://creativecommons.org/licenses/by-nc/3.0/
https://en.wikipedia.org/wiki/PowerBook
https://creativecommons.org/licenses/by-sa/3.0/
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Tablet Computers 
Tablet computers are a relatively new form factor of computers. Tablets are handheld computers that 

are meant for more mobility than laptops. They use touch screen navigation instead of a keyboard or 

mouse. The iPad is an example of a tablet computer. 

Servers: 

Servers are used to provide information to other computers 

or devices on a local area network (LAN). Servers usually have large hard drives for storage and are very 

powerful computers. Servers are not usually meant for consumers and are stored in racks by IT 

professionals to help with cooling. Servers can often run hundreds of computers at once. 

Other types of computers 
Many of today's electronics are computers, though we don't always think of them that way. Here are a few 

common examples. 

Smartphones: Many cell phones can do a lot of things computers can do, including browsing the 

Internet and playing games. 

Wearables: Wearable technology is a general term for a group of devices—including fitness 

trackers and smartwatches—that are designed to be worn throughout the day.  

Game consoles: A game console is a specialized type of computer that is used for playing video 

games on your TV. 

TVs: Many TVs now include applications—or apps—that let you access various types of online content. 

For example, you can stream video from the Internet directly onto your TV. 

This Photo by Unknown Author is 

licensed under  

https://en.wikipedia.org/wiki/Web_hosting_service
https://creativecommons.org/licenses/by-sa/3.0/
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Components of a Computer:  
The next few pages describe all of the components that make up a computer. While computers do come 

in various sizes and shapes, they all share common attributes to function. 

Computer Case:  

The computer case is the metal and plastic box that contains the 

main components of the computer, including the motherboard, central processing unit (CPU), and 

power supply. The front of the case usually has an On/Off button and one or more optical drives.  

Computer cases come in different shapes and sizes. A desktop case lies flat on a desk, and the monitor 

usually sits on top of it. A tower case is tall and sits next to the monitor or on the floor. All-in-

one computers come with the internal components built into the monitor, which eliminates the need 

for a separate case. 

This Photo by Unknown Author is 

licensed under CC BY-SA 

http://en.wikipedia.org/wiki/File:Antec_900.jpg
https://creativecommons.org/licenses/by-sa/3.0/
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Computer Monitor  

The monitor works with a video card, located 

inside the computer case, to display images and text on the screen. Most monitors have control 

buttons that allow you to change your monitor's display settings, and some monitors also have built-in 

speakers. 

Keyboard & Mouse 

The keyboard is one of the main ways to 

communicate with a computer. There are many different types of keyboards, but most allow you to 

accomplish the same basic tasks. The mouse is another important tool for communicating with 

This Photo by Unknown Author is licensed under CC BY-SA-NC 

This Photo by Unknown Author is licensed under CC BY-

SA 

http://technofaq.org/posts/2013/07/liquid-crystal-displays-a-brief-study/
https://creativecommons.org/licenses/by-nc-sa/3.0/
http://www.technewsradio.com/
https://creativecommons.org/licenses/by-sa/3.0/
https://creativecommons.org/licenses/by-sa/3.0/
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computers. A computer mouse functions as a pointing device on the screen allowing the user to select 

and manipulate objects. 

Motherboard: 

If a computer were a human being, the motherboard 

would be the spinal cord. The motherboard is a thin circuit board that connects all of the elements of a 

computer together. Examples of items connected to the motherboard include the CPU, memory, 

connectors for the hard drive and optical drives, expansion cards to control the video and audio, and 

connections to your computer's ports (such as USB ports). The motherboard connects directly or 

indirectly to every part of the computer. 

This Photo by Unknown Author is licensed under CC BY-

SA 

https://en.wikipedia.org/wiki/PlayStation_technical_specifications
https://creativecommons.org/licenses/by-sa/3.0/
https://creativecommons.org/licenses/by-sa/3.0/
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CPU/Processor 

Continuing the human being analogy, if a computer were a 

person, the central processing unit (CPU), also called a processor, would be the brain. The CPU is located 

inside the computer case and is situated on the. The job of a CPU is to carry out commands. Whenever 

you press a key, click the mouse, or start an application, you're sending instructions to the CPU. 

The CPU is usually a two-inch ceramic square with a silicon chip located inside. The chip is usually about 

the size of a thumbnail. The CPU fits into the motherboard's CPU socket, which is covered by the heat 

sink, an object that absorbs heat from the CPU and usually a fan. A CPU can be cooled passively through 

just the heat sink, through a fan, or liquid-cooled. 

A processor's speed is measured in megahertz (MHz), or millions of instructions per second; and 

gigahertz (GHz), or billions of instructions per second. A faster processor can execute instructions more 

quickly. However, the actual speed of the computer depends on the speed of many different 

components—not just the processor. 

This Photo by Unknown Author is 

licensed under CC BY-NC-ND 
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RAM (Random Access Memory) 

RAM is your system's short-term memory. Whenever your computer 

performs calculations, it temporarily stores the data in the RAM. The system retrieves the information 

to be sent to the processor or other components when needed. Ram only provides temporary storage- 

when the computer is off, all of the information stored in Ram is erased. RAM is measured in megabytes 

(MB) or gigabytes (GB). The higher the RAM, the more applications and programs that can be run and 

executed at the same time. One of the fastest ways to speed up a sluggish system is to add more RAM. 

Hard Drive 

 

This Photo by Unknown Author is 

licensed under CC BY-SA 
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The Hard Drive is your computer’s long term memory. The data is also persistent, which means that the 

information is stored on the drive even when there is no power to the drive. The hard drive is where 

your software, documents, and other files are stored. The faster the hard drive, the faster your 

computer can start up and load programs. 

Power Supply 

The power supply unit in a computer converts the power from 

the wall outlet (AC) to the type of power needed by the computer (DC). It sends power through cables to 

the motherboard and other components and also ensures that the power is regular and reliable. 

Expansion Cards (Video card, Sound card, Network Card, etc. 

Some computers can be expanded or upgraded. Desktop 

computers often have expansion slots on the motherboard that allow various types of expansion cards 

This Photo by Unknown Author is licensed 

under CC BY-SA 

This Photo by Unknown Author is licensed under 

CC BY-SA 
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to be added for a fast connection to the CPU. These expansion cards are called PCI (peripheral 

component interconnect) cards. Adding cards could increase the quality or performance of the software 

used on a computer. Video editors, for example, install a powerful graphics card to aid them in their 

editing work.  

What is an Operating System? 
An operating system is a computer program that runs on a computer. It manages all the hardware of the 

computer and the applications which run on a computer. An operating system makes sure all the 

hardware and software are working together in harmony. Every computer has some sort of operating 

system. Listed below in table 1.1 are examples of Operating Systems per type of computer. 

Type of Computer Examples of Operating Systems 

Desktop & Laptop Windows 
macOS 
Linux (many distributions) 

Mobile iOS 
Android 

Wearable WatchOS (Apple) 
WearOS (Android) 

TV Xbox 
Android TV 
tvOS 
Roku 

TABLE 1.1 OPERATING SYSTEM EXAMPLES BY COMPUTER 

Unless you are building your own computer, an operating system is installed on the computer you 

purchase. All consumer operating systems use a graphical user interface or GUI. A GUI lets you use your 

mouse to select icons, buttons, and menus. Everything is displayed on the screen using a combination of 

graphics and text. Each operating system's GUI has a different look and feel, so if you switch to a 

different operating system it may seem unfamiliar at first.  For the purposes of this course, we will study 

the Windows Operating System (Windows 10). Obviously, there are many vibrant and fully-functional 

operating systems available to users in a variety of form factors. While all operating systems perform 

similar functions, how they perform those functions can very slightly. This text will focus on Windows 10 

as it is the preferred operating system in the professional and business world. 

Microsoft Windows 
The most common operating system is Microsoft Windows. While there have been many different 

versions of Windows, the current version is Windows 10.. Windows comes pre-loaded on most new PCs, 

which helps to make it the most popular operating system in the world. We will be studying Windows 10 

in the next chapter. In general, most PC’s built since 2011 are capable of running Windows 10 in varying 

performance capacities.  
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Summary: 
As this section describes Computers are a complex combination of hardware and software working 

together to help the user complete his or her tasks. So many functions of the 21st-century world rely 

upon these computers working together to make our lives easier and more productive. Understanding 

the components of a computer will help you better understand how to most effective in repairing, 

maintaining, and using all the computers you interact with daily. 

Checking for understanding 
1. Students create cue cards of the following: CPU, Motherboard, RAM, Storage, Display, 

Keyboard, Mouse, and Power Supply. They are provided the following scenarios and asked to 

recreate it with their cue cards on a large board. 

a. Student presses the letter “K” on the keyboard 

b. A student wants to play a song on the computer 

2. Students will use electronic store ads and cut-out the computers in the ads and organize them 

by type by poster board. 

3. Students will compile a list of the number of computers they currently own and classify them by 

type and operating system. 
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Chapter 2: Getting Started with Microsoft Windows 
Now that you understand the foundations of computer operations, it is time to begin exploring the user 

interface and navigation features of Microsoft Windows. Make sure you have connected all the 

necessary components (keyboard, monitor, mouse, power supply) to your computer case, and press the 

power button   on your computer and/or monitor to get started. Windows will boot up into the lock 

screen. 

Logging in 

The lock screen displays the current date, time, and usually and image background. You will learn how to 

change this later. The lock screen is displayed when the computer first boots or starts up and if you 

leave your computer unattended for a while. Windows 10 can also be set up to allow multiple users to 

have their own profile and files on the PC and utilize the lock screen to switch to their account. 

To begin the login process, press the Spacebar on the keyboard to continue the login process. If the 

computer requires a username and/or password, you will be prompted to enter it here. You will learn 

how to create a password for your account later in Chapter 6 Windows Security. Depending on your 

computer hardware, windows may permit login passwords based upon a username and password, 

personal identification numbers (PIN) biometrics like your facial features or fingerprint, or some other 

password identification (such as a personal password) When you have completed entering your 

password, please click on the right arrow to complete the login into Windows. 

This Photo by Unknown Author is licensed under CC BY-SA 
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Windows Desktop 

The Windows 10 desktop is the first workspace 

available to you after logging in to your computer. When logging in to a computer for the first time, you 

may see files (information that applications on your computer use to allow you to complete computing 

tasks), shortcuts, (icons that will send you to the actual file or application) folders, a place to consolidate 

files or the recycle bin (a folder that contains items you wish to delete). Some users prefer to keep their 

desktop uncluttered with none or only a few files that they are currently working on to appear, and 

others place many files in an unorganized fashion on their desktops. You will develop your own 

organizational systems as you become more comfortable with windows. There is also a keyboard 

shortcut to allow you to access the Desktop at any time when the computer is powered on. To perform 

this keyboard shortcut, simply press the Windows Key  and the letter “D” on your keyboard at the 

same time. At the bottom left of the computer, the display is the Windows Start Menu, and the bottom 

of the computer display is the taskbar which will be discussed next. 

This Photo by Unknown Author is licensed under CC BY-SA-NC 
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Windows Start Menu 

Please move your mouse cursor over to the bottom 

left of the computer display and click on the Start button . After clicking on the start button, the start 

menu will display. The start menu consists of a list of shortcuts to applications that allow the user to run 

applications on the computer. When the start menu launches, your user account name and optional 

picture appear at the top. The menu shows a list of often-used programs and other controls on the left, 

and variously-sized shaded rectangles called tiles on the right. Each tile represents an app, short for an 

application program. Some titles show updated content using a feature called a live tile the updates the 

application with relevant information to share with the user. You may categorize these shortcuts by 

dragging them into different areas and changing the file folder names to suit your preferences. Apps 

may also be resized if you right-click on the shortcut and select “resize”. You may also “pin” applications 

you use often to start menu shortcuts area on the right by dragging and dropping them to the start 

menu shortcuts menu. or by right-clicking, selecting “more” and then “pin to taskbar 

You can click on “All Apps” to display and scroll through all applications on your computer using the 

slider. Take some time to navigate and explore the start menu. You will find folders and subfolders and 

applications on this menu along with helpful shortcuts to several applications and navigation menus on 

your computer to increase your productivity. 

You may also “pin” applications in the start menu to the taskbar, the bar on the lower part of the screen. 

To do so, right-click on the start menu icon, select “more” and “pin to taskbar” The application will now 

be always displayed on the Windows Taskbar. 

Windows Taskbar (Tutorialspoint.com, n.d.) 
The Windows 10 taskbar sits at the bottom of the screen giving the user access to the Start Menu, as 

well as the icons of frequently used applications. On the right side, the Taskbar features the Notification 

Area which informs the user of different things like the state of the Internet connection or the charge of 

the laptop battery. 

This Photo by Unknown Author is licensed under CC BY-SA 
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Notification Area 
The Notification Area is located on the right side of the Taskbar. It displays different types of 

notifications that are pertinent and useful to the user, like the Internet connection status or the volume 

level. 

The default display of the notification area is to list only a few icons. By clicking the upward arrow on its 

left-side the display will expand to see all other icons. Picture of Windows Notification Area

 

This Photo by Unknown Author is licensed under CC BY-SA 

This Photo by Unknown Author is licensed under CC BY-SA 
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Windows 10 Task View 

Windows 10 Task View allows you to quickly move within your open windows and applications and 

multiple desktops.  Users often use Task view to create efficient workspaces to perform groups of tasks. 

You can access Task View the “Task View” button from the Taskbar. You can also access it by 

pressing and holding the Windows key, and then press Tab to achieve the same result. 

  

This Photo by Unknown Author is licensed under CC BY-SA 
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Checking for understanding 
1. Demonstrate Pinning five (5) applications from the start menu to the start menu shortcuts area 

and taskbar. Then unpin the same applications. 

2. Demonstrate resizing applications on the Windows Start shortcuts menu and moving them 

around the shortcut’s menu. 

3. Demonstrate moving shortcuts on the Windows Taskbar. 

4. Demonstrate the Windows 10 Task View- create multiple desktops and place applications on 

that desktop. 

5. Demonstrate adjusting the volume control in the Windows notification area. 

6. Demonstrate accessing notifications in the Windows notification area. 
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Chapter 3: File Management 
Windows File Explorer 

File Explorer is an application built into Windows 10 to help the user find, browse, and select 

folders and files. The main way to access the File Explorer is by clicking the folder icon in the Taskbar. 

After clicking the icon, the File Explorer window will open. 

 

The initial File Explorer window is comprised of the File Explorer Ribbon, the Navigation Pane, Frequent 

Folders, and Recent Files. 

Ribbon 

In Windows 10, the File Explorer features a new ribbon toolbar, like the one featured in the recent 

versions of Microsoft Office. This ribbon contains buttons and commands for the most common tasks. 

 

Home Tab of Windows 10 Ribbon 

The 

Ribbon features four tabs, each with different commands. Among the tasks, you can perform from the 

Home tab is (Tutorialspoint.com, n.d.) − 

This Photo by Unknown Author is licensed under CC BY-SA 
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• Copying and pasting files and folders from one place to another. 

• Moving files and folders to another location. 

• Copying files and folders to another location. 

• Deleting a file or folder permanently or sending it to the Recycle Bin. 

• Renaming a file or folder. 

• Creating a new folder or other new items. 

• Verifying or modifying the Properties of a document or folder. 

• Opening a file or folder. 

• Different options to select one or various files and folders. 

 

Share Tab of the Windows 10 Ribbon 

 

The Share ribbon gives you different options to share your files and folders. For example: 

(Tutorialspoint.com, n.d.) 

• E-mailing or messaging a file. 

• Compressing (“Zip”) a folder to take less space. 

• Printing or faxing documents. 

• Sharing with other users or networks.  
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View Tab of the Windows 10 Ribbon 

 

The View ribbon allows you to change the way Windows displays your files and folders. Some of the 

changes you can make here are (Tutorialspoint.com, n.d.) − 

• Adding additional panes to show a preview or details of your files. 

• Changing the layout of the files and folders from icons to list, and others. 

• Sorting and arranging the contents of your folder. 

• Hiding selected folders or files. 

File Tab of the Windows 10 Ribbon 

 

The File tab opens a menu with different options like  

• Opening a new File Explorer window. 

• Open command prompt (DOS)  advanced users. 

• Providing more options to change or configure file explorer.  

• Frequent places that will link users to specific file folders that are often used. 
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Organizing Files & Folders 

 

A common method to organize your files is to place them in folders, which can contain files and other 

folders. Folders can be stored on multiple locations on your PC. The specific location or address allows 

your computer to keep track of where each file is located. You may also create a Windows File Explorer 

window for each folder you are working in. Files and Folders may be moved between folders by clicking 

on the file/folder and dragging the file/folder to the new location. 

Cut/Copy/Paste 

One of the most common operations for users is cut, copy, or pasting 

files & folders. Pasting a file inserts the new file into the new location. Selecting “Cut” to a file will 

remove it from its current location and paste the file to its new location. The “Copy” command creates a 

replica of an original file and pastes the file in the selected location. To copy a file, select the file you 

want to copy and click Copy under the Home tab. In addition, you can copy or move a file without 

leaving your current location. Under the Home tab within the Organize group, click ‘Copy to’ or ‘Move 

to’ button, and choose the location if it’s listed, or click the Choose Location button and select the 

location. 

  

This Photo by Unknown Author is licensed under CC BY-SA 
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Checking for understanding 
1. Demonstrate the creation of a new folder. Place a folder in that folder. Create another folder in 

that folder. Rename the Original Folder. 

2. Perform the following: create a folder in your “Documents” folder. Drag the new folder into the 

“Downloads Folder” 

3. Cut a newly created folder in the “Downloads folder” and paste it into the “Pictures” folder. 
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Chapter 4: Managing Windows Applications 
Using Applications 

Applications are tools built by software developers to use the computing power of the computer to aid 

the user to accomplish tasks. Millions of distinct applications run on Windows every day. Windows 10 

comes with a default set of apps, such as Mail, Photos, and WordPad, all developed by Microsoft. 

Millions of other applications are available to run on your computer by installing them via physical 

media like CDs/DVDs, downloading from the internet, or Microsoft store, or creating your own. 

Windows 10 permits applications to have a variety of permissions to run on the computer, so each 

application varies in its complexity, visual appearance, navigation, and control of the computer. It is 

important to understand and know what type of application you are installing on your computer as 

some applications (known as viruses) install software that is harmful to the computer or the user. More 

will be discussed in Chapter 6; Security. To improve security, Microsoft has created the Windows Store, 

which allows the user to view and download applications that have been reviewed and deemed safe for 

the end-user.  

This Photo by Unknown Author is licensed under CC BY-SA 
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Windows Store 

You can purchase and install applications from 

the Microsoft Windows Store, which is an application that is pre-installed in Windows 10. You can find 

applications to download in the Windows store by viewing applications by category or searching for the 

application of your choice. You may need to create/use a Microsoft Account and link your credit card 

information to your Microsoft Account to download applications. In the Windows Store, there are a 

variety of free and paid applications to download. Purchased applications can be downloaded on up to 

10 other computers if the user is signed in with the same user account. Users can automatically update 

applications that have updates available in the Windows store.   

Uninstalling Applications  
When you install an app, including the ones that come by default in Windows 10, it takes up storage 

space on your computer or mobile device. If space becomes limited or you just don’t use an app 

anymore, you can uninstall it to free up storage space.  

You can uninstall Windows Store Applications from the Start menu by navigating to the application, 

right-clicking on the application, and selecting uninstall. After uninstallation is complete, Windows will 

notify you.  

This Photo by Unknown Author is licensed under CC BY-SA 
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Other older programs may be uninstalled by visiting the Control Panel, clicking on “Programs” and 

“Uninstall Program”. Follow the directions on the screen to complete this process. 

 

Window Management 

Windows 10 has several features 

that make it easier to multi-task and work with multiple windows at the same time.  

Windows Display options 
Windows organizes every running application into its namesake- windows. Windows may overlap each 

other. Windows 10 provides many ways to size your windows accordingly. The top right corner of every 

running window provides display options of minimizing the window, resize window/maximize the 

This Photo by Unknown Author is licensed under 

CC BY-SA 
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window, and close window/. Minimizing a window removes the window from view. It can be returned to 

its current view by selecting the running application in the taskbar. Maximizing a Window makes it 

Fullscreen. The resize feature returns it to an open running window. Closing a window removes the 

program from active memory.  

Windows Snap 
Windows Snap allows you to resize windows quickly and display two windows side by side. To perform 

Windows Snap, click and drag the desired window to the left or right until the cursor reaches the edge of 

the screen, then release the mouse. The window will snap into place. To unsnap a window, simply click 

and drag the window down If you have more than one window open when snapping, you'll be able to 

choose a window to snap to the other side of the screen automatically. 

Windows Flip 

Windows Flip can be used to switch between open 

windows. To do this, press and hold the Alt key on your keyboard, then press the Tab key. Continue 

pressing the Tab key until the desired window is selected.  

Displaying the Windows 10 Desktop 
Sometimes, a user can have so many windows open at once, they have trouble finding their desktop! To 

quickly see your desktop, click the bottom-right corner of the taskbar to minimize all open windows. You 

can do click the bottom right corner again to restore your windows (which were minimized) to their 

current location. In addition, there is a keyboard shortcut to do this. Simply press the Windows key  

and the letter “D” on the keyboard to toggle between your open applications and the Windows Desktop. 

Application Settings 
Because windows allow software developers so much flexibility in application design, developers have 

the flexibility to determine how they allow users to customize their applications. There are three main 

This Photo by Unknown Author is licensed under CC BY-

SA 

https://en.wikipedia.org/wiki/Windows_Aero
https://creativecommons.org/licenses/by-sa/3.0/
https://creativecommons.org/licenses/by-sa/3.0/


Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

41 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

strategies developers use to allow users to navigate their application and customize application-specific 

settings: 

1. The Ribbon/Control Menu: Located at the top of the screen with various settings organized into 

groups.  

2. The settings “gear”  icon in the active window. Which brings you to the settings menu. 

3. The “more settings” dots   will display more settings related to the application.  
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Checking for understanding 
1. Download a free application from the Windows Store. Now delete the application you 

successfully installed. 

2. Launch two (2) applications. Place them in the Windows Snap view. 

3. Launch four (4) applications. Practice minimizing them all at once to display the desktop. 

4. Launch three (3) applications. Tab between them using Windows Flip 

5. Enter the settings menu of the Microsoft News application. Practice Minimizing, Maximizing and 

Closing the application. 
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Chapter 5: Web browsers & the Internet. 
A web browser is a type of software that allows you to find and view websites on the Internet. There are 

many different web browsers, but some of the most common ones include Google Chrome, Internet 

Explorer, Safari, Microsoft Edge, and Mozilla Firefox. 

Web Browser Interface 
Every web browser contains a different interface, however, there are some common attributes of all of 

them.  

URLs and the address bar: 
Each website has a unique address, called a URL (short for Uniform Resource Locator). URL’s are street 

addresses for computers, letting your computer know where to connect to on the internet. URLs are 

entered on the browser’s address bar. The address bar is usually located at the top of the website 

window. Sometimes, address bars also have built-in search features, to search for the address if you do 

not know the exact website address. Website addresses usually contain HTTP:// or https:// which 

stands for Hypertext Transfer Protocol or Hypertext Transfer Protocol Secure. https:// addresses are 

more secure. The next letters are usually www which stands for World Wide Web. After www, the 

website address is displayed. Usually, website addresses end in .com (commercial), .org (organization), 

or .edu (educational institution) depending on their classification. In the address bar, please type or 

www.clcmn.edu to take you to the CLC website. 

Hyperlinks: 
The website www.clcmn.edu displayed above that is underlined in blue is an example of a hyperlink, 

which provides the user with a direct address to a location on the web. Usually, the mouse pointer icon 

will switch to a indicating the text is a hyperlink. 

Navigation buttons: 

The Back and Forward arrow buttons allow you to move backward and forward through websites 

you've recently viewed. You can also click and hold either button to see your recent history. The Refresh 

button will load the current website you are viewing a second time. Often a user will click on the 

refresh button when a website stops working to correct the error or to view new information because 

the website was updated while the user was viewing the information. 

Browser Tabs: 

Many browsers allow you to open links in a 

new tab. Each tab is a new instance of the browser to help you manage your applications more 

http://www.clcmn.edu/
http://www.clcmn.edu/
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efficiently. The more browser tabs that you open, the more system resources you consume. To open a 

link in a new tab, right-click the link and select Open link in a new tab (the exact wording may vary from 

browser to browser). You can close a tab by clicking the “X” on the particular tab, and open a new tab by 

clicking the “+” button on the particular tab.  

Downloading Files 

Links don't always go to 

another website. In some cases, they point to a file that can be downloaded, or saved, to your 

computer. If you click a link to a file, it may download automatically, but sometimes it just opens within 

your browser instead of downloading. To prevent it from opening in the browser, you can right-click the 

link and select Save link as (different browsers may use slightly different wording, like Save target as). 

Files downloaded from the internet are often downloaded to your download folder, which is a quick 

access folder accessible on the left navigation pane of windows explorer. Sometimes you may want to 

save an image from a website to your computer. To do this, right-click the image and select Save image 

as (or Save picture as). Make sure you trust the file that you downloaded to your computer, as 

downloading any file or program to your computer contains security risks to your computer (links).  

Internet Security 
The internet provides many opportunities for the user to learn, collaborate with others, participate in 

eCommerce, and improve the quality of their work. However, with all these benefits, there are risks 

associated with Internet use as well. It is important that users understand those risks and take measures 

to practice safe internet use and maintain their PC to prevent against Internet threats. 

This Photo by Unknown Author is licensed under CC BY-SA 

https://stackoverflow.com/questions/28443635/how-to-enable-download-progress-bar-in-a-web-browser-during-file-download-in-php
https://creativecommons.org/licenses/by-sa/3.0/
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Internet Cookies: 

When you browse the Internet, you can 

access and gather information from websites, but websites can also gather information about you 

without your knowledge. You can set Internet privacy options to protect your personal identity from 

unauthorized access. When you visit a website, the site creates a cookie file, known as a first-party 

cookie, which stores information on your computers, such as your website preferences or personally 

identifiable information, including your name and email address. The next time you visit that site, it can 

access the cookie to collect this information. Not all cookies are harmful, many first-party cookies save 

you time re-entering information on a return visit to a website. However, there are also third-party 

cookies, which are created by advertisers and can track your web browsing, even from sites you are not 

currently viewing. Once a cookie is saved on your computer, only the website that created it can read it. 

You can change how cookies are handled in your web browser and block pop up messages in the 

website settings menu. It is good practice to delete your cookies and internet history on a weekly basis 

and review your internet security settings in your web browser regularly. Many web browsers support 

custom security modes that delete all internet cookies and history upon exiting a browser (also called 

incognito mode) and other functions to eliminate exposures on websites. Many web browsers also 

display a lock  on the address bar indicating the website is secure.  

Practicing Internet Security 
In addition, it is important for the user to be careful about disclosing personal information (Name, 

Birthdate, Social Security Number, banking information, location, etc.) online unless they are sure of the 

authenticity of the website. A sophisticated cyber scam, known as “phishing” attempts to convince the 

internet user of the authenticity of a fake website to attempt to trick the user into disclosing personal 

financial information online. A good security technique is to view the website address in the browser 

This Photo by Unknown Author is licensed under CC BY-NC 

https://elearn.lifelearners.ng/cookies-what-are-they/
https://creativecommons.org/licenses/by-nc/3.0/
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address bar and search the web for information about the website to ensure it is reputable. When in 

doubt, you can usually call the company to ensure it is a real operation. 

Cyberbullying  
Cyberbullying can be defined as writing mean or inappropriate things online. Examples of cyberbullying 

include sending unwelcome emails or text messages, making threats, sexual harassment, hate speech, 

posting lies, rumors, or encouraging others to share this misinformation that may harm another. 

Instances of cyberbullying have increased significantly as more users spend more time online. 

Cyberbullying should be handled in a similar way to traditional bullying-if you are being bullied, ask for 

help! No one deserves to be bullied. Cyberbullying is easy to prosecute as it is very difficult to delete the 

evidence. 

Bookmarks & Internet History 

If you find a website you want to 

access later, it can be difficult to remember all of the websites you want to visit.   Bookmarks or 

favorites allow your computer to remember your favorite website URLs so you do not have to.  To 

create a bookmark, select the Star icon to bookmark the current website. In addition to bookmarks, your 

browser will also keep track of every website you visit through your internet history. To view your 

history, open your browser settings—usually by clicking the icon in the upper-right corner—and 

select History.  

  

This Photo by Unknown Author is licensed under CC BY-NC-ND 

http://techrena.net/feed-subscriptions-windows-7-feed-headlines-sidebar-gadget/
https://creativecommons.org/licenses/by-nc-nd/3.0/
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Checking for understanding 
1. Demonstrate how to download and retrieve a file. 

2. Save a picture from the web to your computer. 

3. Please demonstrate how to clear browser history and internet cookies. 

4. Navigate to the website www.clcmn.edu. Create a bookmark. 

5. List methods to prevent yourself from online. 

6. Identify Cyberbullying and share strategies to get help if you are being cyberbullied.  

http://www.clcmn.edu/
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Chapter 6: Customizing Windows Appearance 
Windows is a highly customizable operating system that allows users to change the desktop background, 

change the color accent, customize the Lock screen, apply a theme, and many other features. 

Customizing Windows 10 allows the user to personalize the look and feel of their computing experience 

and tailor the system to meet their own workflow needs while using the computer. 

Changing the desktop background 

To change 

your desktop background, use these steps (Windows IT Central, n.d.): 

1. Open Settings. 

2. Click on Personalization. 

3. Click on Background. 

4. Using the "Background" drop-down menu, select the Picture option. 

5. Click the Browse button to select the image you want to use. 

6. Using the "Choose a fit" drop-down menu, select the option that best suits the image, including fill, 

stretch, center, span, etc.  

Create a desktop background with a picture slideshow 
If you wish to display a collection of pictures on the desktop, perform the same previously mentioned 

steps, but instead of selecting “Picture” in the Background drop-down menu, select the Slideshow 

option. After selecting slideshow, select the following (Windows IT Central, n.d.):  

1. Click the Browse button to select the folder with the images. 

2. Use the "Change picture every" drop-down menu to select how often the image will rotate. 

3. If the order of the images is not important, turn on the Shuffle toggle switch. 
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4. Using the "Choose a fit" drop-down menu, select the option that best suits the images, including 

fill, stretch, center, span, etc. 

Changing the color accent in Windows 10 
The color accent in windows 10 changes the color of the start menu, the taskbar, and the color of 

application windows. To change the default windows color, perform the following: (Windows Central, 

n.d.) 

1. Open Settings. 

2. Click on Personalization. 

3. Click on Colors. 

4. Select the color accent you want to use through the experience. 

 

Adjusting between Light and Dark Themes 
Windows 10 includes two personalization modes- light mode is the default mode and works well during 

daytime, and dark mode uses a dark color scheme in backgrounds and another part of the OS and 

supported apps, and it's an option more suited for a low-light environment. (Windows Central, n.d.) 

You can switch between the light and dark mode using these steps: 

1. Open Settings. 

2. Click on Personalization. 

3. Click on Colors. 

4. Under "More Options," select the Light (default) or Dark using the "Choose your 

default app mode" option. 
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Customizing Windows 10 Lock Screen  

The windows lock 

screen may display a variety of pictures. Like the desktop, you may set up a static picture for the lock 

screen or a slideshow.  

To personalize the Lock screen using a custom image, do the following: (Windows Central, n.d.) 
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1. Open Settings. 

2. Click on Personalization.  

3. Click on the Lock screen. 

4. Use the "Background" drop-down menu and select the Picture option or slideshow option 

depending on your preference.  

 

Applying a theme to Windows 10 

 

Although Windows 10 includes many ways to personalize your experience, the quickest way to change 

the look and feel is to use a theme. A theme is just a package that can contain one or more background 

images, color accents, and sounds, and they're quickly acquirable from the Microsoft Store.  

To get and apply a new theme on Windows 10, do the following: (Windows Central, n.d.) 

1. Open Settings. 

2. Click on Personalization. 

3. Click on Themes. 

4. Click the Get more themes in the Store link. 

 

5. In the Microsoft Store, pick the theme you want, and click the “Get” button. 

6. Click the Launch button to go back to the Themes settings. 
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7. Click the newly added theme to apply it.  

 
Windows Settings 
Windows 10 settings can be adjusted in two ways, the Settings App and the Control Panel. The settings 

can app can change any setting on your computers, like your printer options to how windows looks and 

sounds. To open the app, click the Start menu, then select Settings. You can also use the Control Panel 

to adjust your settings, just like in earlier versions of Windows. There are a wide variety of settings to 

change in Windows 10. It is important that users spend some time reviewing settings for their computer 

and adjust as needed. If you do not understand the specific settings you are changing, it is best to 

research it before making changes. Windows 10 settings can change how your PC operates, and also 

make it more accessible to the end-user￼ 
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Accessibility Settings 
Accessibility options are built into Windows to help users who may have trouble using their computers 

normally get a little more functionality out of their favorite OS. Though Windows 10 does innovate on 

many features we’ve come to expect from older versions of the operating system, for the most part, 

Microsoft has opted to keep much of the core functionality of its accessibility features the same to make 

it easier both on users and developers to adapt without much trouble in between the old system and 

the new. Even so, here’s how to manage all the accessibility options available in the latest update of 

Windows 10. (How to geek, n.d.) 

Narrator 
For the blind or those with acute sight limitations, a Narrator is a vital tool that will read off the contents 

of any page, window, or application. Windows 10 has the capability to read the characters you type as 

you type them, playing audio cues when you click into new pages or applications, and reading off hints 

for controls and buttons which will assist sight challenged. At the bottom of the Narrator settings, users 

have the option to hear Microsoft David or Zira as the Narrator. (Howtogeek.com, n.d.)

 

This Photo by Unknown Author is licensed under CC BY-SA-NC 

http://www.digitalcitizen.life/how-start-and-configure-narrator-through-pc-settings-windows-81
https://creativecommons.org/licenses/by-nc-sa/3.0/
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Magnifier 

Magnifier is another of the Windows Ease of Access features designed to assist anyone who either has 

trouble reading their screen. 
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High Contrast 

Sticking with the concept of “making things easier”, Microsoft has opted to group all its visual 

accessibility features into the top three choices in the Ease of Access panel. 

High contrast will drastically alter the overall color scheme so that text, images, application windows, 

and icons become easier to read for anyone who might have colorblindness.  
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Closed Captions 

The closed captions section can be used to customize how any closed captions in your local media 

players will appear during the playback of movies or TV shows. For those who have difficulties making 

out the white text against moving backgrounds, this allows you to choose between any color you’d like 

on the Windows color palette. 

You can opt to change the font, the color of the text, or both at the same time if you have specific needs 

depending on your own vision requirements.  
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Keyboard 

The keyboard options in Ease of Access offers up a wide range of customization that will help anyone 

with disabilities or special needs have exactly the PC experience they want every time they boot up and 

log in. 

An On-Screen Keyboard is a great tool for anyone who’s using Windows 10 on a touch screen device or 

doesn’t want to use a keyboard. Sticky Keys will change your keyboard to treat any strikes of the ctrl, 

shift, or alt keys as a hold command, rather than a tap as it usually would. This is perfect for anyone who 

has issues maintaining finger dexterity for long periods of time (arthritis patients come to mind), or just 

users who are too lazy to manage to hold down more than a few keys at once. (Howtogeek.com, n.d.) 

Mouse 
You may increase and decrease the size of the mouse cursor to make it more helpful to see your cursor.   
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Notification Center 

As stated 

previously, Windows 10 has created a Notification Center to view and respond to alerts and notifications 

from your PC. Users may customize their notification center in the settings menu. Notification settings 

may be changed by opening Windows 10 settings, and navigating to the System area of settings, and 

then to “Notifications and Actions”. The options at the top of this screen allow you to change “Quick 

Actions”. Quick Actions are the first settings a user can view in the Notification Center. If you click the 

link “Select which icons appear on the taskbar” you’ll be able to decide how crowded or sparse the 

system tray is, or you can just turn them all “Off”.  Scrolling down in this area, you may also change 

global settings for notifications that affect all of Windows 10 notifications- deciding whether to view tips 

about windows, application notifications, notifications on the lock screen, alarms, reminders and calls, 

and notifications during presentations. There are also options to turn off notifications from specific 

apps. So, if you don’t want to disable app notifications wholesale, but still don’t want to see them from 

certain ones, you can selectively disable them.  

  

This Photo by Unknown Author is licensed under CC BY-SA 

https://medium.com/@egee_irl/5-reasons-why-i-dont-use-windows-49cc7ccbfeae
https://creativecommons.org/licenses/by-sa/3.0/
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Checking for understanding 
1. Change the desktop background color. 

2. Setup the desktop background to display a photo slideshow. 

3. Change the Windows 10 theme. 

4. Access the Windows 10 settings & control panel 

5. Enable text to speech options and high contrast mode 

6. Turn on and off notifications on an application basis.  
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Chapter 7: Windows Security 
Protecting your PC and your personal information while using your computer is very important. Every 

year, thousands of individuals have their personal and financial information compromised and suffer 

tragic consequences. Ensuring your computer is updated to the latest version and is protected is a vital 

part of using a computer. Three common attacks on computers include computer viruses, malware, and 

phishing.  

Computer Viruses:  
A computer virus, much like a flu virus, is designed to spread from host to host and can replicate itself. 

In more technical terms, a computer virus is a type of malicious code or program written to alter the 

way a computer operates and is designed to spread from one computer to another. A virus operates by 

inserting or attaching itself to a legitimate program or document that supports macros in order to 

execute its code. In the process, a virus has the potential to cause unexpected or damaging effects, such 

as harming the system software by corrupting or destroying data (Norton.com, n.d.). 

How does a computer virus attack? 
Once a virus has successfully attached to a program, file, or document, the virus will lie dormant until 

circumstances cause the computer or device to execute its code. For a virus to infect your computer, 

you must run the infected program, which in turn causes the virus code to be executed. This means that 

a virus can remain dormant on your computer, without showing major signs or symptoms. However, 

once the virus infects your computer, the virus can infect other computers on the same network. 

Stealing passwords or data, logging keystrokes, corrupting files, spamming your email contacts, and 

even taking over your machine are just some of the devastating and irritating things a virus can do. 

While some viruses can be playful in intent and effect, others can have profound and damaging effects. 

This includes erasing data or causing permanent damage to your hard disk. Worse yet, some viruses are 

designed with financial gains in mind. (Norton.com, n.d.) 

How do computer viruses spread? 
In a constantly connected world, you can contract a computer virus in many ways, some more obvious 

than others. Viruses can be spread through email and text message attachments, Internet file 

downloads, and social media scam links. Your mobile devices and smartphones can become infected 

with mobile viruses through shady App downloads. Viruses can hide disguised as attachments of socially 

shareable content such as funny images, greeting cards, or audio and video files. To avoid contact with a 

virus, it’s important to exercise caution when surfing the web, downloading files, and opening links or 

attachments. To help stay safe, never download text or email attachments that you’re not expecting, or 

files from websites you don’t trust. (Norton.com, n.d.) 

What are the signs of a computer virus? 
A computer virus attack can produce a variety of symptoms. Here are some of them: (Norton.com, n.d.) 
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• Frequent pop-up windows. Pop-ups might encourage you to visit unusual sites. Or they might 

prod you to download antivirus or other software programs. 

• Changes to your homepage. Your usual homepage may change to another website, for instance. 

Plus, you may be unable to reset it. 

• Mass emails being sent from your email account. A criminal may take control of your account or 

send emails in your name from another infected computer. 

• Frequent crashes. A virus can inflict major damage on your hard drive. This may cause your 

device to freeze or crash. It may also prevent your device from coming back on. 

• Unusually slow computer performance. A sudden change in processing speed could signal that 

your computer has a virus. 

• Unknown programs that startup when you turn on your computer. You may become aware of 

the unfamiliar program when you start your computer. Or you might notice it by checking your 

computer’s list of active applications. 

• Unusual activities like password changes. This could prevent you from logging into your 

computer. 

Computer Malware 
Malware is an abbreviated form of “malicious software.” This is software that is specifically designed to 

gain access to or damage a computer, usually without the knowledge of the owner. There are various 

types of malware, including spyware, ransomware, viruses, worms, Trojan horses, adware, or any type 

of malicious code that infiltrates a computer. Generally, the software is considered malware based on 

the intent of the creator rather than its actual features. Malware creation is on the rise due to money 

that can be made through organized Internet crime. Originally malware was created for experiments 

and pranks, but eventually, it was used for vandalism and destruction of targeted machines. Today, 

much of malware is created to make a profit from forced advertising (adware), stealing sensitive 

information (spyware), spreading email spam or child pornography (zombie computers), or extorting 

money (ransomware). Various factors can make computers more vulnerable to malware attacks, 

including defects in the operating system (OS) design, all the computers on a network running the same 

OS, giving users too many permissions, or just because a computer runs on a particular operating 

system, such as Windows, for example. The best protection from malware — whether ransomware, 

bots, browser hijackers, or other malicious software — continues to be the usual, preventive advice: be 

careful about what email attachments you open, be cautious when surfing by staying away from 

suspicious websites, and install and maintain an updated, quality antivirus program. (Norton.com, n.d.) 

Phishing 
Phishing is a cyber-attack that uses disguised email as a weapon. The goal is to trick the email recipient 

into believing that the message is something they want or need — a request from their bank, for 

instance, or a note from someone in their company — and to click a link or download an attachment. 

What really distinguishes phishing is the form the message takes: the attackers masquerade as a trusted 

entity of some kind, often a real or plausibly real person, or a company the victim might do business 

with. It's one of the oldest types of cyberattacks, dating back to the 1990s, and it's still one of the most 
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widespread and pernicious, with phishing messages and techniques becoming increasingly 

sophisticated. (Norton.com, n.d.) 

While there are several paid-for and free applications that protect against viruses and malware, 

Windows has built-in applications to monitor the health of your PC and protect it against hostile threats. 

Windows Defender Security Center  

Windows 10 Defender Security Center is built into Windows 10. It combines the most common security 

features of Windows into an easy-to-use app allowing technical and non-technical users to view and 

protect their devices and data against many types of malware, including viruses and ransomware, 

hacker attacks, security threats, and more. Windows Defender Security Center is an application that 

provides a unified experience to view status and control security features, such as firewall, antivirus, 

performance monitor, and other products. Windows Defender Antivirus is the default anti-malware 

engine of Windows 10 that offers real-time protection against viruses and security threats. Installing a 

third-party antivirus will disable the Windows Defender Antivirus automatically, but it'll not affect the 

functionality of the Windows Defender Security Center. In the same way, disabling Windows Defender 

Antivirus or Windows Defender Firewall will not disable Security Center. 

Launching Windows Defender Security Center 
To get started, you can launch the app from the Start menu, or you can double-click the shield icon from 

the notification area in the taskbar. Although "Home" doesn't include any setting that you can manage, 

This Photo by Unknown Author is licensed under CC BY-SA 

https://serverfault.com/questions/886357/error-0x80070005-access-denied-when-first-start-hyper-v-in-windows-10-pro
https://creativecommons.org/licenses/by-sa/3.0/
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it's a good place to get started, as it provides an overview of the protection of your device. On this page, 

you can view the status of all the security features and alerts of any action that needs to be taken to 

keep your computer secure. Also, at the top of the page, you'll be able to find antivirus information, 

such as when the last scan was performed and when the last definition was installed. The shield icon in 

the notification area is also capable of alerting you when an action needs to be taken. If there is more 

than one alert, only the most severe warning will be displayed (Windows Central, n.d.).  

Windows Defender Security Center includes five areas of protection that you can manage and monitor. 

• Virus & threat protection: includes the Windows Defender Antivirus settings, and it allows you 

to monitor the malware protection, scan your device for threats, and set up its advanced anti-

ransomware feature. 

• Device performance & health: allows you to check the health and performance of your 

computer and provides a mechanism to clean up your device to fix errors and slowdown 

problems. 

• Firewall & network protection: lets you monitor the status of network connections, and you can 

configure various Windows Defender Firewall settings. 

• App and browser control: help you to protect your device and data from malicious code hidden 

on apps, files, and websites. 

• Family options: offers easy access to manage your devices and kids' online experience using a 

Microsoft account. 

Using Windows Defender Scan 
To scan your PC for viruses and malware using Windows Defender Antivirus, complete either a quick 

scan or full scan.  

To perform a Quick Scan, complete the following: 

1. Open Windows Defender Security Center. 

2. Click on Virus & threat protection. 

3. Click the Quick scan button. 

To perform a Full Scan or Custom Scan, complete the following. 

1. Open Windows Defender Security Center. 

2. Click on Virus & threat protection. 

3. Click the link of the Advanced scan. 

4. Select the Full Scan or Custom Scan option and select the appropriate folders to scan. 

Sometimes if you're dealing with a tough virus or another type of malware, the antivirus may not be 

able to remove it while Windows 10 is running. If this is the case, save your work, close any running 

application, and run an offline scan using the following steps: 

1. Open Windows Defender Security Center. 

https://www.windowscentral.com/how-enable-controlled-folder-access-windows-10-fall-creators-update
https://www.windowscentral.com/how-enable-controlled-folder-access-windows-10-fall-creators-update
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2. Click on Virus & threat protection. 

3. Click the link of the Advanced scan. 

4. Select the Windows Defender Offline scan option. 

5. Click the Scan now button. 

6. Click the Scan button to continue. 

When you start an offline scan, your device will restart and boot using the Windows Defender Antivirus 

environment. The latest definition update will be installed (if an internet connection is available), a scan 

will be performed, and if malicious software is detected, it'll be removed or quarantined automatically. 

Viewing the health/performance of your PC 

 

Windows Defender Security Center also includes an area that surfaces information about the health and 

performance of your computer. 

To view your PC health and performance report, do the following: 

1. Open Windows Defender Security Center. 

2. Click on Device performance & health. 

The report includes a status for Windows Update, storage, device driver, and battery. If action needs to 

be taken, you'll see an alert with a recommendation on how to remedy the issue (Windows Central, 

n.d.).  
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Fresh start 

 

If your PC is having performance problems, such as issues with memory, shutting down, or everything is 

working very slow, you can click the Additional info link under "Fresh start" to re-install Windows 10 

with the latest updates. 

 

To perform a Fresh Start, perform the following: 

1. Click the Get started button 

2. Click the Next button. 

3. Review the apps that will be removed. 

4. Click the Next button. 

5. Click the Start button to begin the process. 

This process won't delete your files, it'll keep some Windows settings, but it'll remove everything else to 

help fix performance issues with your device (Windows Central, n.d.).  

How to manage network security with Windows Defender Firewall 
The experience also includes an area to monitor and manage Windows Defender Firewall settings, which 

you can access with the following steps: 

1. Open Windows Defender Security Center. 

2. Click on Firewall & network protection. 
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3. On the page, you can view at a glance in which network profile the firewall is currently enabled and 

protecting you from unauthorized access. The one marked as "active" is the network 

profile currently in use. 

You can also click any of the networks to disable the firewall and block all incoming network connections 

for a profile (Windows Central, n.d.). 

 

How to protect your PC against malicious code 
The "App & browser control" page is the place to configure the Windows Defender SmartScreen settings 

that can help you to protect your computer against sites, apps, and files that may contain malicious 

code. The default settings are the recommended configuration you should be using. Of course, that is 

unless you have a specific reason to change them. 

1. To change the default SmartScreen settings, do the following: 

2. Open Windows Defender Security Center. 

3. Click on App & browser control. 

4. Select the level of protection you want for apps and files, Microsoft Edge, and Microsoft Store 

apps. 

You'll also notice Exploit protection at the bottom of the page. This is an advanced feature that can help 

to mitigate malware and vulnerabilities without having to wait for a malware or system update. 

https://www.windowscentral.com/how-configure-network-discovery-windows-10-0
https://www.windowscentral.com/how-configure-network-discovery-windows-10-0
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User Account Control 

The Windows User Account Control is a tool that warns you when someone or something attempts to 

change your computer system settings. When this happens, the screen will alert you until an 

Administrator can confirm the change. This helps protect your computer against accidental changes or 

malicious software altering your settings. Initially, this User Account Control is set at a moderate to a 

high level, which means it will notify you only when an application tries to make changes to your 

computer. However, you can change this setting to your desired level by following these steps − 

(Tutorialspoint.com, n.d.) 

1. Open the Control Panel by searching for it in the search bar. 

2. After the Control Panel is open, choose User Accounts. 

3. After choosing User Accounts, click on “Change User Account Control settings”. 

4. In the User Account Control Settings, you can move the slider to the desired position. Windows 

10 will give you a summary of how your system will behave under that level.  

Automatic Updates 
By default, Windows 10 is set up to automatically download the latest updates for the Windows 

Operating system as soon as they are available. It is important to allow those updates, as often crucial 

errors or “bugs” that may make your computer susceptible to a computer virus or malware are fixed or 

“patched” by updates. When updates are installing, it is important to not turn off your computer until 

they are completed. 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

69 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

 

Internet & Computer Safety Tips 

The following article was retrieved from usa.kapersky.com (Kapersky.com, n.d.) 

A 19-year-old running for public office in New Hampshire found out about the importance of following 

Internet safety rules the hard way. As Seacoast Online reports, his opponents found images in his social 

media posts that were sexually suggestive and referenced past drug use. Just like that, his political 

career crashed and burned upon takeoff. But, unfortunately, he isn't the only one, as careless Internet 

habits have left others exposed to scams, identity theft and physical harm at the hands of people they 

met online. With more users accessing the Internet through mobile devices, these risks are changing and 

growing quickly. Even though apps loom larger in most people's daily online interactions than traditional 

websites do, that does not mean that the basic Internet safety rules have changed. Hackers are still on 

the lookout for personal information they can use to access your credit card and bank information. 

Unsafe surfing can also lead to other threats—from embarrassing personal comments or images that, 

once online, are nearly impossible to erase, to getting mixed up with people you'd rather have had 

nothing to do with. 

Here are the Top 10 Internet safety rules to help you avoid getting into trouble online (and offline).  

1. Keep Personal Information Professional and Limited: Potential employers or customers don't 

need to know your personal relationship status or your home address. They do need to know 

about your expertise and professional background, and how to get in touch with you. You 

wouldn't hand purely personal information out to strangers individually—don't hand it out to 

millions of people online. 

2. Keep Your Privacy Settings On: Marketers love to know all about you, and so do hackers. Both 

can learn a lot from your browsing and social media usage. But you can take charge of your 

information. As noted by Lifehacker, both web browsers and mobile operating systems have 

settings available to protect your privacy online. Major websites like Facebook also have privacy-

enhancing settings available. These settings are sometimes (deliberately) hard to find because 

companies want your personal information for its marketing value. Make sure you have enabled 

these privacy safeguards and keep them enabled. 

This Photo by Unknown 

Author is licensed under CC 

BY-NC 

https://usa.kaspersky.com/resource-center/preemptive-safety/top-10-internet-safety-rules-and-what-not-to-do-online
http://www.seacoastonline.com/article/20150630/NEWS/150639991
http://lifehacker.com/which-browser-is-better-for-privacy-1525895782
https://www.facebook.com/help/325807937506242/
https://techboomers.com/t/dangers-of-the-internet
https://creativecommons.org/licenses/by-nc/3.0/
https://creativecommons.org/licenses/by-nc/3.0/
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3. Practice Safe Browsing: You wouldn't choose to walk through a dangerous neighborhood—don't 

visit dangerous neighborhoods online. Cybercriminals use lurid content as bait. They know 

people are sometimes tempted by dubious content and may let their guard down when 

searching for it. The Internet's demimonde is filled with hard-to-see pitfalls, where one careless 

click could expose personal data or infect your device with malware. By resisting the urge, you 

don't even give the hackers a chance. 

4. Make Sure Your Internet Connection is Secure. Make sure your device is secure, and when in 

doubt, wait for a better time (i.e., until you're able to connect to a secure Wi-Fi network) before 

providing information such as your bank account number.  

5. Be Careful What You Download: A top goal of cybercriminals is to trick you into downloading 

malware—programs or apps that carry malware or try to steal information. This malware can be 

disguised as an app: anything from a popular game to something that checks traffic or the 

weather. Don’t download apps that look suspicious or come from a site you don't trust. 

6. Choose Strong Passwords: Passwords are one of the biggest weak spots in the whole Internet 

security structure, but there's currently no way around them. And the problem with passwords 

is that people tend to choose easy ones to remember (such as "password" and "123456"), which 

are also easy for cyber thieves to guess. Select strong passwords that are harder for 

cybercriminals to demystify. Password manager software can help you to manage multiple 

passwords so that you don't forget them. A strong password is one that is unique and 

complex—at least 15 characters long, mixing letters, numbers and special characters. 

7. Make Online Purchases from Secure Sites: Any time you make a purchase online, you need to 

provide credit card or bank account information—just what cybercriminals are most eager to 

get their hands on. Only supply this information to sites that provide secure, encrypted 

connections. As Boston University notes, you can identify secure sites by looking for an address 

that starts with https: (the S stands for secure) rather than simply Http: They may also be 

marked by a padlock icon next to the address bar. 

8. Be Careful What You Post: The Internet does not have a delete key, as that young candidate in 

New Hampshire found out. Any comment or image you post online may stay online forever 

because removing the original (say, from Twitter) does not remove any copies that other people 

made. There is no way for you to "take back" a remark you wish you hadn't made or get rid of 

that embarrassing selfie you took at a party. Don't put anything online that you wouldn't want 

your mom or a prospective employer to see. 

9. Be Careful Who You Meet Online: People you meet online are not always who they claim to be. 

Indeed, they may not even be real. Be as cautious and sensible in your online social life as you 

are in your in-person social life. 

10. Keep Your Antivirus Program Up to Date: Internet security software cannot protect against 

every threat, but it will detect and remove most malware—though you should make sure it's to 

date. Be sure to stay current with your operating system's updates and updates to the 

applications you use. They provide a vital layer of security.  

http://www.bu.edu/infosec/howtos/how-to-identify-and-protect-yourself-from-an-unsafe-website/
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Keep these 10 basic Internet safety rules in mind and you'll avoid many of the nasty surprises that lurk 

online for the careless. 
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Checking for understanding 
1. Students will list 7 out of 10 internet safety rules. 

2. Students will adjust Windows 10 User Account Control Settings 

3. Students will perform a Windows Defender Security Scan 

4. Students will find the location in Windows 10 settings to perform a Fresh Start 
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Chapter 8: Media Creation in Windows 
Windows 10 allows for thousands of applications that can be utilized by the user to create, edit, and 

share Media. Professionals invest hundreds of thousands of dollars on computer hardware and software 

to assist them in their jobs. From editing a document, preparing a presentation, or creating a video with 

sound, Windows 10 is used daily to make clear and stimulating media creations. 

Types of Media Files 
To a certain extent, every type of file on your PC could be considered a media file. However, most users 

associate audio, picture, and video files as Media Files. Every media file has an extension, that the 

computer uses to associate with a program. Extensions are listed after the file name (for example this 

textbook has the file name “Computer Fundamentals for Technical Students Textbook” and the file 

extension is.” pdf” for portable document format. Depending on your Windows View settings, 

extensions may be hidden by default as changing a file extension could create errors in your computer. 

You can change viewing properties by launching a Windows Explorer Window, clicking on the “View” 

tab, and making sure “File Names and Extensions” is checked. In addition, users may also right-click on 

the file, then navigate to file properties, and view the type of file. Users may also change the program 
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associated with that extension by clicking on the “Change” button next to the “Opens with” section of 

the screen.  
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Extensions for Picture Files 
• JPEG files (.jpg and .jpeg) 

• GIF files (.gif) 

• Bitmap files (.bmp) 

• PNG files (.png) 

• TIFF files (.tif and .tiff) 

• Extensions for Video Files 

• Audio Video Interleaved files (.avi) 

• Motion JPEG files (.avi and .mov) 

• Windows Media files (.wm, .wmv, and .asf) 

• Matroska multimedia files (.mkv) 

• Apple QuickTime files (.mov and. qt) 

• MPEG Movie files (.mp4, .mov, .m4v, .mpeg, .mpg, .mpe, .m1v, .mp2, .mpv2, .mod, .vob, and 

.m1v) 

Extensions for Music Files  
• Windows audio files (.wav) 

• MP3 audio files (.mp3 and .m3u) 

• Windows Media Audio files (asx, .wm, .wma, and .wmx) 

• Free Lossless Audio Codec files (.flac) 

• AAC files (.aac) 

Other types of popular files: 
• Application files (.exe): Executable files that can run with a double-click 

• Text documents (.txt): Simple text documents without any kind of formatting 

• Compressed (.zip): Archives of other files and folders 

• Portable Document Format files (.pdf): A very popular type of file generally used for sharing 

non-editable documents that need to look the same on all devices, no matter what operating 

system you use 

• OpenOffice and LibreOffice documents (.odt, .ott, .oth, and .odm): Documents created using 

free open-source productivity applications, such as OpenOffice and LibreOffice 

• Microsoft Word (.doc and .docx) 

• Microsoft PowerPoint (.ppt and .pptx) 

• Microsoft Excel (.xls and .xlsx) 

• Microsoft Publisher (.pub and .pubx) 

• Microsoft OneNote (.one) 
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Using Windows Photos 
Starting up the Photos app is simple: for most new machines and fresh installations of Windows 10, it’s 

already in the Start menu as a big tile. Even if it’s not, just press “Start” and then begin typing “photos” 

to bring it up quickly via search. (Using Windows 10 Built in Photo Editor, n.d.) 

Browsing Photos 
(Howtogeek.com, n.d.)

The Photos app offers three different interfaces when looking for photos: Collection, Album, and 

Folders. You can choose any of the three at any time by clicking the relevant tab, above the main 

interface and below the “Photos” application label. 

Collections 
“Collections” is a view of your most recent photos and screenshots, displayed in reverse order by date. 

Within the main viewer of “Collection,” and in the nested album or photo viewers of the other tabs, a 

series of controls appear on the upper-right portion of the interface. These allow you to select multiple 

items for a specific action like copying, printing or adding to a specific album, or to start a slideshow, 

refresh the current file view, or import from a camera or mobile device. Contextual items in the Album 

view allow you to edit the name of the album or change the cover photo. To navigate backward through 

the Photos interface, click the left-pointing arrow in very top upper-left of the window, or press the Esc 

or Backspace keys at any time. (Using Windows 10 Built in Photo Editor, n.d.) 

Album 
“Albums” is a series of automatically-created photo albums, organized according to the Photo app’s 

internal logic, though you can add your own and remove or add photos to existing albums. “Folders” is 

merely a tab for all of the photos on your machine in specific folders—your OneDrive photo folder and 

your assigned “Pictures” folder in Windows, by default. To add folders to this view, click “Choose where 

to look” to go to the Photos Settings page, then click “Add a folder” to manually select one in Windows 

Explorer. (Using Windows 10 Built in Photo Editor, n.d.) 

Using the Photo Viewer Interface 
When you finally get down to an individual photo, the interface goes completely black and dedicates the 

maximum length or width of the window. If you’re using mouse navigation, scrolling up or down will 

advance or retreat in the current collection, album, or folder. Hold down the “Ctrl” button on your 

keyboard to turn the mouse wheel into zoom or retract controls. (How to Geek, n.d.) On the 

bottom of the interface, manual arrow controls to go forward or back in the album are on either side of 
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an “add to album” button and a Delete button. You can use the keyboard for both actions: Ctrl+D to add 

it to a specific album via a pop-up menu, or simply press the Delete button. If you press “Delete” again, 

the image will be removed both from the album/collection/folder in the Photos app, and the file itself 

will be deleted in Windows Explorer and sent to the Recycling Bin. (Using Windows 10 Built in Photo 

Editor, n.d.) 

The top controls are labeled, and self-explanatory. The “Share” button will open Windows 10’s share 

menu, allowing the user to send the file via email, copy it via Windows’ standard copy and paste 

function, or open and share it directly in any compatible Windows Store app. Zoom opens a manual 

slider to zoom in and out—remember that you can do this much faster by holding the Ctrl button and 

using the mouse wheel. “Slideshow” will begin a full-screen slideshow of the current album, collection, 

or folder. 

Draw command 
(How to geek, n.d.)The “Draw” command allows you to write on the image, with a selection of pen 

and eraser tools that appear contextually. It’s mainly intended for pen-enabled devices like the 

Microsoft Surface. You can double-click on any of the tools in the upper bar to select color and width. 

Note that the drawings can be erased with the Eraser tool, but after you click “save” (the floppy disk 

icon) and see the “Letting your Ink Dry,” the original file for this photo is saved over. Don’t click “save” 

on a photo unless you have it backed up somewhere, or you’re willing to lose the original. 

Edit command 
“Edit” opens the photo editor, which we’ll cover in the next section. “Rotate” will rotate the image 

clockwise; if you hit it by accident, just click it again three more times to return the photo to its original 

orientation. 

Using the Built-In Photo Editor 
The editor in Photos isn’t exactly incredible, but it can handle some light cropping and adjusting if 

nothing else is available. On the main interface, using the + and – buttons will zoom in and out, which 

can also be done with the mouse wheel (no Ctrl button necessary). Click and drag any part of the image 

to move it around or click the “Actual size” button (the box with corners in the lower-right) to see the 

whole photo maximized horizontally or vertically. 

The Crop and Rotate Tool 
The “Crop and rotate” button is the most prominent tool, as it’s visible always. Click it to open a 

dedicated cropping UI. You can click and drag the circles on the corner to manually select a cropping box 

or click the “Aspect ratio” button to choose a standard size. This is quite useful if you want your image to 

be viewed on semi-standardized devices, like a smartphone or TV (16:9), iPad (4:3), or a corporate 

projector (usually 4:3 as well). The “Flip” button will flip the image horizontally, but not vertically, and 

the “Rotate” button will spin it clockwise by 90 degrees. To get a non-square rotation, click the circle 

beside the right-hand menu and slide it up or down. When you’re finished, click “Done” to return to the 

full Edit interface. (How to geek, n.d.) 
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The Enhance Tab 
Right below the Crop button is two tabs, “Enhance” and “Adjust.” Let’s look at Enhance first. The 

“Enhance your photo” tool is an all-in-one slider: click and drag the slider from left to right to apply 

automatically-selected filters to “enhance” the image, according to the Photo app. You can stop it at any 

point along the axis. Generally, this tool brightens up an image, smooths out shadows and highlights, 

makes a more ideal contrast, and just generally makes things look clearer. The rest of the “filters” on the 

Enhance tab work the same way: click one of the filters, then click the slider beneath “Enhance your 

photo” to apply the effect, with a left-to-right strength of 0 to 100. You can apply multiple effects by 

clicking on a new one and then adjusting the slider—rinse and repeat. When you’re done, click the 

“Adjust” tab. (How to Geek, n.d.) 

The Adjust Tab 
The controls for this page are similar, but you can adjust multiple factors at once. The “Light” sliders 

adjust the contrast, exposure, highlights, and shadows of the image, with the master “Light” slider being 

a combination of all four. The “Color” slider handles saturation, with 0 reducing the image to greyscale 

and 100 making it overly vibrant. More fine controls can be applied with the Tint and Warmth sliders. 

The separate “Clarity” slider will outline specific edges with darkened shadows or blend them into the 

background, and the “Vignette” slider will add a white (left) or black (right) vignette effect to the photo. 

Finally, the Red Eye tool will let you click on a subject’s eyes to remove the red glare from a camera 

flash, and the “Spot Fix” tool will let you click and drag around a specific area to obscure fine details. It’s 

good removing acne and other blemishes. (How to geek, n.d.) 

Saving Your Edits 
When you’ve edited your image to your liking, you have two options: “Save” will overwrite the original 

image file (not recommended), or “Save a copy” will let you save the edited version to a folder in 

Windows Explorer. The second is obviously better unless you’re sure you don’t want the original. At any 

time during editing, you can click “Undo all” to return to the original image and start over. (How to 

geek, n.d.) 

Editing Video Files  
To edit a video file, open it in the Photos app. You can do this right from File Explorer by right-clicking 

the video file, and then selecting Open With > Photos. The video will open and play in the Photos app. 

To edit the video, click “Edit & Create” on the toolbar. You’ll see a variety of video editing tools you can 

use. Click a tool to use it. For example, to cut a section out of a video, click “Trim” in the menu. To use 

the Trim tool, simply drag the two handles on the playback bar to select the portion of the video you 

want to keep. You can drag the blue pin icon to view what appears at that section in the video or click 

the play button to playback the selected section of the video. When you’re done, click “Save a Copy” to 

save a copy of the trimmed section of the video. To stop editing without saving your changes, click 

“Cancel” instead. The Photos app places the edited video in the same folder as the original with a similar 

filename. For example, we edited a video named Wildlife.mp4 and received a video file named 

WildlifeTrim.mp4.  (How to Geek, n.d.) 
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Draw Tool 
The “Draw” tool provides tools for drawing on a video. You can use a ballpoint pen, pencil, calligraphy 

pen, and eraser tools, and pick your favorite colors. Anything you draw appears smoothly on the screen 

during the video—as if you were drawing it—and then fades out and vanishes after a few seconds. (How 

to Geek, n.d.) 

How to Combine Videos, Add Text, and Apply 3D Effects 
To start creating a video project, you can click the “Create a Video with Text” or “Add 3D Effects” tool. 

You can also click the “Add to a Creation” button at the top left corner with a video open, and then click 

“New Video with Music.” You can also get started with a custom video project by launching the Photos 

app from your Start menu, and then clicking Create > Custom Video with Music on the app’s home page. 

The “Automatic video with music” option also lets you select your own photos or videos. The Photos app 

automatically combines them into a custom video for you. You’ll be prompted to add at least one video 

or photo to create a custom video. You can add photos to get a slideshow or combine photos with a 

video if you like. However, you can also just add one video to edit it, or more than one video to combine 

them. Whichever way you create a custom video project, you’ll end up on a screen with a project library, 

video preview, and storyboard pane. To add one or more videos (or photos) to your project, drag them 

from the project library to the storyboard. Click the “Add photos and videos” option under the Project 

library to add more videos to the library. You can then drag them to the storyboard. (How to Geek, n.d.) 

StoryBoard Pane 
Add a video and you’ll see some editing tools in the Storyboard pane. In addition to the standard Trim 

tool, you can resize a video with Resize, add visual filters with Filters, insert text with Text, apply motion 

effects with Motion, and insert 3D effects with 3D Effects. Even if you just want to edit a single video, 

you can add just that video to your project, use the various editing tools, and then export the video to a 

new file. Or, if you want to combine videos, you can insert them into the storyboard and edit them 

together. (How to Geek, n.d.) 

Editing Tools 
The editing tools are self-explanatory. The Trim tool works similarly to the Trim tool you see when 

editing an individual video. The Resize tool can remove black bars from a video, which is important if 

you’re combining multiple videos with different aspect ratios into a single project. The Filters tool offers 

a variety of filters—everything from Sepia to Pixel. The Text tool provides different styles and layouts of 

animated text that you can place at different locations in the video. The Motion tool lets you choose 

different styles of camera motion for the video or photo. (How to Geek, n.d.) 

3d Effects 
(How to Geek, n.d.)The 3D Effects tool provides a library of 3D effects you can apply to the video: 

everything from autumn leaves and winter snowflakes to explosions, fires, and lightning bolts. You can 

apply one or more 3D effects, and each one has different options you can use to customize it. Some 3D 

effects must be placed somewhere in the scene, while others apply to the entire scene. In the 
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Storyboard pane, you can click the speaker icon to select a volume level for each individual video. This is 

useful if you’re combining multiple videos and one is louder than the others. Rather than customizing 

each individual option yourself, the “Themes” option on the top bar of the window lets you choose 

different themes. This will choose filters, music, and text styles that work together—complete with 

preview videos that show you how they will look. (How to Geek, n.d.) 

Applying Music 
To apply music to a video, click the “Music” button on the top bar. The Photos app includes a few music 

options you can choose from. You can also select “Your Music” to insert a custom music file. (How to 

Geek, n.d.) 

Aspect Ratio 
There’s also an “Aspect Ratio” button on the toolbar. You can use it to switch between different 

landscape and portrait orientations for your video. (How to Geek, n.d.) 

Exporting/Sharing Video Files 
When you’re done, click “Export or Share” to export your video project to a file. You can also click the 

“Add to Cloud” button if you want to upload your video project to Microsoft’s cloud. You can then 

resume editing it on the Photos app on another PC you’ve signed in to with the same Microsoft account. 

Your video projects will appear under “Video Projects” when you launch the Photos app. The Photos app 

exports the video and tells you where it’s saved on your PC. The Photos app placed the video in the 

Pictures\Exported Videos folder on our PC. While this isn’t the most powerful video editor you can get 

on Windows, it’s surprisingly capable, included on all Windows 10 PCs, and can do a lot of the basics 

with a simple interface. (How to Geek, n.d.) 
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Checking for understanding 
1. Describe four (4) different file extensions and their associated programs. 

2. Launch Windows 10 Photos App to browse for pictures 

3. Crop and enhance a photo downloaded from the website. 

4. Used the Built-in Video Editor to create a slide show/Image of your ideal job.  
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Chapter 9: Office Overview & Office 365 
This Chapter provides an overview of the entire Office Suite of Products. Each product has a different 

purpose but shares many of the same navigation and organization. Once a user understands one Office 

Application, it is easier to transition to another Office Application because of the common structures 

associated with each application. 

Understanding the Office Suite  
Microsoft Office is a suite of desktop productivity applications that are designed specifically to be used 

for office or business use. It is a proprietary product of Microsoft Corporation and was first released in 

1990. Office applications consist of Word, Excel, PowerPoint, Access, OneNote, Outlook and Publisher 

applications. Each office application has a specific purpose and integrates with the entire office suite. 

Applications are also built to work together and share features (such as a shared Office Clipboard for 

copy/paste features.) The general purpose of each Office Application is listed below. 

• Microsoft Word Helps users in creating text documents. 

• Microsoft Excel: Creates simple to complex data/numerical spreadsheets. 

• Microsoft PowerPoint: Stand-alone application for creating professional multimedia 

presentations. 

• Microsoft Access: Database management application. 

• Microsoft Publisher: Introductory application for creating and publishing marketing materials. 

• Microsoft OneNote: Alternate to a paper notebook, it enables a user to neatly organize their 

notes. 

Besides desktop applications, Microsoft Office is available to use on tablets and mobile devices and 

online. All Office documents integrate with cloud-based storage (One Drive) allowing users to store, edit, 

and share files in the Cloud and work collaboratively with other users. Microsoft Office Applications are 

sold in bundles. The most recent release is the Office 2019 suite. In addition, Microsoft Office 

Applications are sold as part of a subscription bundle, Office 365 which provides the user with updated 

applications, online file storage, and web-based email for a monthly subscription fee.  

Starting an Office App  
Let's begin by starting an Office App: Microsoft Word. To Launch Word, click on the Start Button  on 

the Windows taskbar and locate Microsoft Word. You can quickly navigate to the application by pressing 

the “W” button. on the keyboard. 
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Microsoft Word will launch and display its first screen: backstage view. The backstage view presents the 

user with options to start a new document from a template or as a blank document. A blank document 

contains no pre-existing organization or formatting while a template provides the user with a document 

model that has already been formatted and organized for a specific purpose (such as a calendar.). For 

the purposes of this activity, click on the “Blank document”. 
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Common Office Interface: 

Each Office document contains common interface elements to help the user navigate the Application. 

Quick Access Toolbar: 
The Quick Access Tool Bar is in the upper left-hand corner of the screen. By default, save, undo, and 

redo are on the toolbar. More options can be obtained by selecting the downward arrow  to access 

other commands 

Office Ribbon 
Like the Windows 10 Ribbon, the Office Ribbon Contains controls and menus that allow the user to 

manipulate the document they are working with. Each Office Application contains the ribbon, but the 

specific features of the Ribbon vary by application. Each office app contains the Home tab. The Ribbon 

can be customized using the command, located in the top right corner of the window. 

Title Bar 
The Office Title Bar lists the name of the file and the Office Application that is being used. To establish a 

title for the file you are working on, save the file and create a specific name for the file. After saving, the 

file name will show on the Title Bar. 

This Photo by Unknown Author is licensed under CC BY-SA 

http://adod.idrc.ocad.ca/word2007
https://creativecommons.org/licenses/by-sa/3.0/
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Window Controls 
Like Windows 10, Office Window Controls allow the user to minimize, maximize, and close the specific 

program. Minimizing a window removes the window from view. It can be returned to its current view by 

selecting the running application in the taskbar. Maximizing a Window makes it Fullscreen. The resize 

feature returns it to an open running window. Closing a window removes the program from active 

memory.  

Vertical Scroll Bar 
Office documents can often be multiple pages or have information that cannot be displayed on one 

screen. The Vertical Scroll Bar allows the user to scroll-move up or move down throughout the 

document. 

Zoom Tools 
Zoom Tools are in the lower right-hand corner of the screen. They allow the user to zoom in or magnify 

or zoom out to see a bigger picture of their document. Document zooming can be completed by the 

slider, or via the “+” or “- “buttons on the document. The zoom percentage is also displayed. 

Document information 
Document information relevant to the Office Application is displayed in the lower-left and corner. In 

Microsoft Word, this information usually contains the number of changes and words. Excel displays 

mathematical results, and PowerPoint displays slide numbers. 

Rulers 
All office documents can display vertical and horizontal rulers. These rulers can be hidden if a view 

setting is enabled. Rulers allow the user to see with fine precision their actual location in the document. 

Cursor 
Like Windows, Office uses a cursor that looks like an arrow to select commands. Areas, where text can 

be entered, is shown with a straight cursor instead of an arrow. The straight line is known as the text 

insertion point. 

Work Area 
Finally, the most important part- in the center of each Office Application is the work area, where the 

actual work and input is completed. This work area varies in appearance depending on the Office 

Application. 

Creating & Saving File in Word  
In addition to common user interface elements, all Office Documents allow the user to open existing 

files, save files, and create new files in the File Tab. In addition to manual saves, Office has an 

autosave/recovery function that can automatically save your work in the event of a computer 

malfunction or “crash” To save a file in Microsoft Office, complete the following actions 

1. Click the File tab on the Ribbon in the Upper left-hand corner. 
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2. A new screen (Backstage view) launches. On the left-hand side of the screen, choose 

“Save” or “Save As”. If the document has been previously saved, you won't have to 

select a save destination (e.g., desktop) or a file name--the existing file will simply be 

updated. Under "Save As", decide on your save location. Typical locations include "This 

PC" and OneDrive, but you can also click "Browse" to select a specific location. 

3. Double-click your save location. This will take you to the file name screen. 

4. In the file name screen, enter your desired file name. 

5. Click “Save” to save your file. 

6. Verify that your file was saved before closing the document. Office Applications will 

prompt you to save your file if it was not saved before closing as well. 

Viewing & Printing your work  
Microsoft Office Applications all present common user interfaces to change the view of an application 

and print an application. While each office application has specific views, there are three common views 

in each Microsoft Office Product. 

Read Mode 
Read mode is the default view when a document is set to read-only-this means that the viewer cannot 

edit the file. Read mode is also a helpful mode if the user wants to read the file in full screen without 

other interface elements of the office on screen. 

Print Layout Mode 
Print layout mode allows the user to view the document is it would be displayed printed out on an 

81/2X11 standard printer paper. It allows the most realistic view of the document’s appearance if printed. 

Web Layout Mode 
Web Layout mode displays the document to read like it would read if it was on a website. This is helpful 

if the destination of the document is on the internet to be accessed with a web browser. If the 

document is being created to display online, the user will want to make sure the layout will be 

compatible with this format. 

 

Getting Help, 
All Microsoft Office Product has a robust help menu. Usually, its location is the furthest right ribbon tab. 

There are a lightbulb and textbox you can enter text  

that allows the user to type in what they want to do or know about. Using artificial intelligence, the 

Office can locate and often perform the command requested. When you do not know how to perform a 

command in Office, use the help box. 

In addition, by hovering your mouse cursor over different screen elements, such as the ribbon, a 

ScreenTip will often display; explaining the specific feature or purchase for the element. 
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Sharing 
Document sharing and collaboration is a central feature in the Office Suites. By clicking on the 

Share Command in the upper right-hand corner of the screen, you can share your document 

electronically with others. By sharing the document, you can choose whether to allow others to 

collaborate with you on the document-collaboration allows multiple users to work on the document 

simultaneously, increasing efficiency and creativity. A difference between sharing the document and 

sending the document in an email or via disk is that the most current version of the document is always 

accessible to the user. This means that if you shared the document with another colleague, and the next 

day discovered a typo that needed correction, you could simply correct the typo and that change would 

be reflected when your colleague viewed the document. In addition, sharing is more secure because you 

can always remove permissions to view the file whereas an emailed file can never be recovered. Sharing 

a document provides more control and security for the user. 

Office 365 Web Versions 
An Office 365 subscription includes web-based versions of Outlook, Word, Excel, PowerPoint. In 

addition, online access to OneDrive provides online storage saves these files in the cloud so these files 

may be accessed anywhere. In addition, online outlook, word, excel, & PowerPoint by default only 

access files from the cloud unless a file is manually uploaded or attached to the web application. 

Getting Started 
To login to Office 365 web applications, visit www.office.com. Click the “Sign in”  button. You will 

be sent to the Office Login Screen. Log in with your username and credentials or create an account.  

Enter your password. Keep in mind the Office 365 passwords are case sensitive. 

 

After successfully logging in, an Office start screen is displayed. This start screen provides shortcuts to all 

your Office applications that have web versions. In addition, files in One Drive which had been recently 

http://www.office.com/
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accessed are automatically displayed. This screen provides much functionality, so we will define all the 

screen elements below. 

Office 365 Application picker allows the user to specify which web application they would like to 

use.  

 Search Bar: Allows the user to search for any file saved to 

OneDrive. 

Notification Center: Allows the user to view any notifications they may have received- for example, 

receiving a shared document, another colleague editing your document, etc. 

 

 Settings Menu: Allows you to change the visual appearance of Office, customize your notifications 

and change your passwords. 

 Help Menu: Search the Office 365 Knowledge Base for Help. 

 Install Office button allows individuals with an Office 365 subscription may click on this icon 

to download a free Windows 10 Office Application. 

 Start new allows the user to create a new Office Document on the web. 
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 Outlook Email, Calendar, and Contacts Application. More information will be provided about this 

web application in the next section. 

 OneDrive in the cloud allows a user to view and share all their uploaded files. More information 

about one drive will be provided later in the text.  

 Microsoft Word online is a word processing tool. More information will be provided about 

Microsoft Word in later chapters. 

 Microsoft Excel online is a spreadsheet and calculation tool. More information will be provided 

about Microsoft Excel in later chapters. 

 Microsoft PowerPoint online is a presentation tool. More information will be provided about 

Microsoft PowerPoint in later chapters. 

 Microsoft OneNote is a notetaking and list building application. This text does not provide 

instruction for Microsoft OneNote, but it does have a similar interface to Microsoft Word but has limited 

functionality. 

 Microsoft SharePoint online is used in the organization as a hub to share information and files. It 

allows departments to privately collaborate on documents and communicate with each other. This text 

does not provide instruction for Microsoft SharePoint. 

 Class Notebook is a shared note-taking web application that is available to educational institutions 

and students using Office365. This textbook does not provide instruction for the Class Notebook. 

 Microsoft Teams online is a collaborative application that allows groups of individuals working on a 

project to chat, schedule meetings, share and work collaboratively on documents, and communicate in 

private groups. This textbook does not provide instruction for Microsoft Teams. 

 Microsoft Sway is a new application from Microsoft Office that makes it easy to create and share 

interactive reports, personal stories, presentations, and more. This textbook does not provide 

instruction for Microsoft Sway. 

 Microsoft Forms allows users to create secure web forms that can be used inside or outside an 

organization to obtain information from others. This textbook does not provide instruction for Microsoft 

Forms. 

 Click here to access all other less frequently used Microsoft Online Applications that are available as 

part of the Office 365 subscription. 
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Microsoft Outlook Online 

The Outlook online application is divided into a three-column view. The column on the left 

consists of different mailbox folders. You can use mailbox folders to better sort your messages, so they 

are easy to find.  You can create a new folder at any time by clicking on the “New Folder” link. 

Clicking on the  icon hides the left column. Above the left column is the  New message link which 

allows the user to create a new email message.  

The center column is where you organize your messages that you receive. There are three default views 

above your messages that allow you to sort your messages: “Focused” or “Other”. . 

The “checkbox” icon selects all your messages. The “Focused” icon only shows you messages that 

Outlook’s artificial intelligence filters as important to you. The “Other” icon usually displays items 

Outlook believes are junk mail or email that is not important. The “Filter” icon allows multiple ways to 

sort your messages as described in Figure 2.  

The right column displays the content of a selected email. To select the email, you may click on the 

message you wish to view. The message will display with the name of the person and picture of them (if 

this information is entered your contacts, and some message options: .  Sends a 

response to the sender that you “liked” the message. Replies to the message. Replies to everyone 

who was sent the message if you were part of a group email. forward the message that was written 

to you to someone else.  Contains less frequently used settings for the message like to mark it as 

unread, to delete it, to mark as junk, print, show message details, Flag, or block the sender. If you 

choose an action to reply or forward the message, you will enter the message authoring text box. 

The message authoring text box will appear in a separate box above the email you are referencing. In 

addition to being able to type your message, it has a few options to change the text size, font, 

formatting, and text effects of the email through a toolbar at the bottom of the screen. 

 Students are 

encouraged to experiment with the text functions. These functions are also available in Microsoft Word 

which will be discussed in a later chapter. At the top of the textbook authoring window are options to 

send the completed message, discard or delete the message, attach a file to the message, insert an 

image or an emoji.  When writing an email, please use professional 

language and write in alignment with proper web etiquette- this means no writing in caps or using slang 

or acronyms like “lol”. 

At the bottom left corner of the outlook window are additional features; . The mailbox is the 

email application that was previously described. Clicking on the other icons will allow the user to view 

their calendar, contacts list, and tasks list. 
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Outlook Calendar 
The Outlook Calendar retains the same three-column navigational design as the email application. The 

left column provides the user with multiple calendars of specific events and sub-calendars. The center 

column allows the user to select certain calendar views. The right column displays specific event details. 

 

Clicking on “New Event”  Will allow you to create a new calendar event. When creating a new 

event, you are permitted to create a title for the event, invite other attendees (which will send a 

calendar invitation to their email address and display if they accept the invitation on their calendar), 

choose the time and date and location, as well as make it a one-time meeting or a repeating meeting, 

such as a weekly staff meeting. You can also view your calendar to find available times that do not 

conflict with other meetings, schedule a time to be reminded, and add a description of the meeting or 

attach documents, such as a meeting agenda to the appointment. Clicking on the menu at the top of the 

window allows other useful features: . “Save” 

allows for the invitation to be saved and sent to others if invited. “Discard deletes the calendar 

appointment. “Scheduling Assistant” allows you to search for an open day and time on every person 

whom you have invited if everyone is using Office 365 as their email client. Scheduling assistant will not 

show details of the other schedules but will show busy and free time. “Busy” settings allow you to 

customize the type of appointment, for example, you could create a calendar appointment to complete 

paperwork at the office desk at a certain time but still want to be open for meeting if needed, so you 

could create an appointment “Work at my desk” and mark it as “Free” instead of busy. “Categorize” 

allows you to classify meetings by color if you choose to do so. Finally, “Response options” allow you to 
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specify what options recipients of a calendar invitation would have available to them. 

 

Contacts 
You may also want to review your contact list in Outlook as well. Contacts are useful to maintain for 

individuals whom you may need to work with have to be able to reach. You may maintain any contact 

information you find helpful in Outlook Contacts including your contact’s name, email, company, title, 

phone number, address, birthday, picture, etc. The Contacts Application continues the three-column 

view with the left view being a place to sort your contacts into groups, the middle list containing all your 

contacts in a group, and the right column providing the details of a selected contact on the right. At the 

top of both columns in your menu bar. .
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New Contact allows the data entry of a new contact. A variety of contact information is available. If you 

do not see the information you wish to enter click Add more at the bottom right of the screen.  

Add to favorites allows you to select a contact to favorites. You would perform this action is you wished 

to reference this contact information frequently. 

Edit allows you to edit a contact’s information. 

Delete allows you to delete a contact form your list. 

Add to list adds a selected contact to a specific folder of your choosing to better organize your contacts 

Microsoft OneDrive 
Microsoft OneDrive contains all your applications stored in the OneDrive cloud. Files in OneDrive may be 

accessed anywhere you have an internet connection. The user interface of Microsoft OneDrive 

maintains a two-column setup. The left column is the navigation bar that helps the user navigate the 

directory of OneDrive to find the specific location of their files or folders. The Center column displays the 

actual files. Clicking on a file will display the file in the appropriate web application in a new browser 

window. Files can be uploaded to OneDrive by selecting Upload from the top menu 

 and selecting the proper file. You may also create a new file to 

save to OneDrive by selecting New. 

The left navigation pane displays different file views in OneDrive. Files view 

allows the user to search the folder directory that they have established, like using Windows Explorer in 

Windows 10. Recents allows the user to view files they have more recently accessed or edited. Shared 

displays files that were shared by or shared with the account user. Discover allows the user to view files 

that were recently edited by others that may relate to the user. OneDrive uses artificial intelligence to 

determine which files to view. Finally, the Recycle bin provides the user with files that were most 

recently deleted. Files are purged from the Recycle bin after 90 days. The user may also manually delete 

these files permanently by clicking on the Empty recycle bin icon . 
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The right navigation pane displays your files. Hovering the mouse cursor over a 

specific file will highlight specific commands to the user-Share and More Options.  Share allows a 

user to share online access to the file to another user to view or edit. This is helpful when working 

collaboratively. As previously discussed, sharing is also more secure and convenient, because the 

recipient will always be able to view the most recent changes made to the document, and the person 

who shared the document always has control over who can and cannot always view or edit the 

document. More options bring up a menu to perform a variety of functions on the document. 

Summary 
Office 365 Web Applications provide the user with the most frequently used controls in a similar user 

interface to the Office 365 Windows 10 Applications. The convenience of working on the web allows for 

any computer anywhere with an internet connection to access the power of Microsoft Office. Now that 

you have a familiarity with Microsoft Office, it is time to explore the features of the Windows 10 

applications, beginning with Microsoft Word. 

Checking for understanding 
1. Students will describe the types of commonly used Office Applications and what they are used 

for. 

2. Students will send an email with an attachment in Outlook web. 

3. Students will create a calendar event and invite a classmate to the event in Outlook web. 

4. The student will create a contact in Outlook web. 

5. The student will upload a file to OneDrive and share it with another classmate. 
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Chapter 10: Introduction to Microsoft Word 
Microsoft Word provides users with a balanced approach to usability- the application is easy to use so 

the user can begin working on a document immediately, or sophisticated enough to write complex 

textbooks, professional business reports, and novels using its features. This chapter provides an 

overview of using the basic features of Microsoft Word to construct a document. 

Introduction to Word processing software 
A word processing program is a software program that includes tools for entering, editing, and 

formatting text and graphics. The electronic files you create using Word are called documents. One of 

the benefits of using Word is that document files can be stored in a variety of places on your computer, 

or in the cloud using one drive, and easily shared with others via disks, emails, or online file storage. 

Microsoft Word allows users to accomplish the following tasks. 

• Type and edit text. 

• Copy and move text from one location to another in the document, or to other documents. 

• Format text and paragraphs with fonts, colors, pictures, tables, and many other tools. 

• Design pages for specific purposes- from personal letters to sophisticated memos and reports. 

• Enhance documents for readability with pictures, charts, graphics, etc. 

• Use mail merge features to quickly and easily send customized communications to customers. 

• Share documents securely to others. 

• Communicate clearly and professionally with others by using the built-in tools of Word. 

Now that you are aware of some of the uses for Microsoft Word, let's get started by creating a new 

document. Launch Microsoft Word and click on “Blank Document”. 

 

Take some time to explore the user interface. A few notable features of Word include: 
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• Title bar: displays the name of the document and the name of the program. Until you give a new 

document a different name, its temporary name is Document 1. The left side of the title bar 

contains the Quick Access toolbar, which includes buttons for saving a document and undoing, 

redoing, and repeating a change. The right side of the title bar contains the Ribbon Display 

Options button, which you use to hide or show the Ribbon and tabs, the resizing buttons, and 

the program Close button. 

• The File Tab provides access to Backstage view where you manage files and the information 

about them. 

• The Ribbon contains the Word tabs. Each tab on the Ribbon includes buttons for commands 

related to editing and formatting documents. The commands are organized in groups. For 

example, the Home tab includes the Clipboard, Font, Paragraph, Styles, and Editing Groups. The 

Ribbon also contains the “Tell me what you want to do” box, which you can use to find a 

command or access help. The ribbon also contains the share command, which you can use to 

easily share documents. 

• The document window displays the current document. This is the space you are working inside. 

• The rulers only appear in the Print Layout view. The horizontal ruler displays left and right 

document margins as well as the tab settings and paragraph indents, if any, for the paragraph. 

The vertical ruler displays the top and bottom button margins. 

• The vertical and horizontal scroll bars are used to navigate inside your document. They contain 

arrows to help you navigate the document. 

• The status bar displays the page number of the current page and the total number of pages and 

words in the document. It also displays spelling and grammar checking. 

• The view buttons on the status bar allow you to adjust the view, toggling between print layout, 

read mode, or web layout view. The Zoom slider allows you to zoom in and out of the 

document. 

In the document window, you should see a blinking cursor. This is known as your “insertion point”. Your 

insertion point is where text or objects we are placed in the document. You can change the insertion 

point using your arrow keys or mouse. 
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Starting a document 
Before beginning to use Microsoft Word, your first step should be to take some time to plan your 

document. Better document planning will save you time and ensure your document is written to the 

correct audience with the right message and visual appearance. Some aspects to consider before writing 

a document include: 

• Purpose of the message- why are you sending the message? 

• Who is your audience? What type of writing or visual style will appeal to them? 

• What type of communication will you send? Will it be a newsletter, professional letter? 

• Will you need outside information like graphics or charts? 

• Is there any research you need to conduct before beginning to write? 

Now that you have a plan, let's write a document. 

Saving a document 
Once you have successfully entered text into your document, you should get into the habit of saving 

work. Saving your work often is a good idea in the event of a computer error or power outage that could 

cause you to lose your progress. While Word does have an Autosave feature that can be helpful to 

recover most of your document, saving your work regularly is the sure-fire way to make sure your work 

is not lost. 

To save your work in word, you can do one of the following: 

• Keyboard Shortcut: “Control + “S” 

• Quick Access Toolbar:  Use the Disk/icon in the upper left-hand corner of the screen. 

• Backstage View: Click on “File” in the Ribbon and navigate to “Save” on the left side of the 

backstage view. 

Difference between “Save” and “Save As”. 
Microsoft Word has two different Save commands: “Save-As” allows you to name the file and save it in a 

location of your choosing. “Save” keeps the same file name and location. If you have never saved a file 

before, pressing “Save” will take the user to the “Save-As” menu of options. When completing the “Save 

As” command, Word will also allow you to save the document as another file type, like a portable 

document format (pdf) file, or other types. 
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1EXAMPLE OF THE "SAVE-AS" DIALOG BOX. 

 

Selecting Text 
Microsoft Word allows the user to manipulate text by “left-clicking” on the insertion point and 

continuing to hold the left click and moving the mouse around the document to the selected text. When 

text is highlighted, you can perform multiple actions with the selected text using the ribbon & mini-

toolbar by “right-clicking” on the selected text. When text is selected, a blue highlight will be displayed 

over the text. 

 

Formatting Text using the mini-toolbar & Ribbon 
Selected text can be manipulated by using the mini-toolbar or ribbon.  

The mini-toolbar is displayed when you “right-click” on the selected text. “Right-clicking” in Microsoft 

Word provides the user with quick actions like “Copy”, “Cut”, “Paste”, Changing the Font, Paragraph 

Settings, Synonym Tools, and many other quick actions. 

The most common and powerful methods available to users is the Ribbon in Microsoft Word. 
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The Ribbon in Microsoft Word provides the user with organizational groupings of many different 

commands and controls to change and manipulate text. The various groupings are below: 

Home Tab: 
The Home Tab contains the most commonly used document controls; actions in the Home Tab can 

change the font and size of the text, paragraph, and line spacing, copy and paste, change the 

organizational structure of the document. 

Insert Tab: 
The insert tab allows the user to insert any number of items that were not originally included in the 

Word document and that cannot be entered by keyboard entry. Examples include page breaks, 

pictures/shapes/icons, charts, links, bookmarks, comments, headers and footers, page numbers, Word 

Art, Drop Caps, Equations, Symbols, Signatures, Dates, and Other Objects (like other office documents). 

Design Tab 
The Design Tab has features that allow the user to change the overall appearance and structure of the 

document with Themes. Creating customized colors, fonts, and paragraph spacing is also on this tab. 

Finally, this tab allows the user to create Watermarks, adjust the Page Color and Page Borders. 

Layout Tab 
The Layout tab provides the user with edit controls to the physical characteristics of the document when 

it is printed. Examples of tools available on the Layout Tab include margin adjustment, orientation 

(Portrait or Landscape), changing the size of the page to accommodate other paper sizes, inserting 

columns or line numbers, changing indentation or position of text, and aligning text with other 

graphics/figures. 

References Tab 
The References Tab is utilized especially for research papers and long word documents. The Reference 

tab allows the user to build tables of contents, inserting citations, managing a bibliography, inserting 

captions, or creating indexes. Research papers often require sources to be cited in a specific way, and 

the Reference Tab in Word makes this easy. 

Mailings Tab 
The mailings tab is used to make it easy for the user to send out customized documents to individuals 

via mail. The tab has a wealth of features for this activity, like a mail merge feature, custom text blocks 

that can be changed depending on the database they are pulled from. It is possible to use Word in 

conjunction with an address list in excel to create customized documents with individual characteristics 

(like the person’s name, title, address, etc.” that are printed. 

Review Tab 
The Review Tab provides essential features to use in Word after a first draft has been created. The 

Review Tab contains Spelling and Grammar Review, Thesaurus, Word Count, Text to Speech, 
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accessibility checker, translation functions, document comment and review features, and comparing 

versions. Finally, the Review Tab may also be used to “Ink” the page by drawing on it and restricting 

editing to the document. 

View Tab 
The View Tab allows the user to change how they may view the document. In addition, they can choose 

what type of features are viewable in Microsoft Word. Users can change the view mode between 

reading Mode, Print Layout Mode, Web Layout, Draft and Outline views. In addition, they can choose 

whether to display one page or multiple pages at a time and adjust how large or small documents are. 

Finally, they can create Macros, which are user-programmed shortcuts that can be used in specific 

documents in the View Tab. 

Help Tab 
Couldn’t find what you were looking for? If nothing else works, clicking on the Help Tab will allow the 

user to show training and search for the related topics. 

Using a document template 
While many users prefer to begin their work with a blank web page, word has many templates or 

preformatted documents that make it easy to create a Résumé or a Flyer. To create a template, click on 

the File tab of the Ribbon, and then “New”.  
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Word will then showcase all the available templates. Users may also search online for templates in 

different styles or formats. There are so many templates available, the most important aspect for the 

user is to find one that meets their needs. 

Checking for Understanding 
1. Describe the main features and purposes of Microsoft Word 

2. Create a New Blank Document, Format text in the document, and Save the document as 

a .pdf 

3. Create a document from Template and Save the document as a new file. 

4. Describe three (features) of each organizational tab in Microsoft Word. 
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Chapter 11: Exploring the Home & View Tab of Microsoft Word. 
The Home Tab contains the most commonly used document controls; actions in the Home Tab can 

change the font and size of the text, paragraph, and line spacing, copy and paste, change the 

organizational structure of the document. 

 

The Home Tab is grouped into four distinct areas: Clipboard, Font, Paragraph, and Styles. 

Clipboard 
The main function of Clipboard is the Cut, Copy, and Paste feature. All Office Applications share a 

Universal Clipboard. This means that items that are copied in Windows 10 can be shared between Office 

Applications. You can view the Universal Clipboard by clicking on the clipboard box with an arrow facing 

down and to the right in Word. A new navigation pane will open on the left 

side of the screen. It will display all the items that you have cut or copied in Windows 10 recently. This 

allows you to work with multiple items you have pasted 

 . 

In addition to the Clipboard Navigation pane, users can also utilize Format Painter . Format 

Painter allows the user to copy the text size, fonts, and any other formatting, to another selected body 

of the text. To use the format painter functionality, users should select the text they would like to copy, 

and then click on “Format Painter”. Then select the text they wish to change. Users may also double-

click on “Format Painter” and change as many text selections as they would like. When they have 

completed changing the text selections, they can click on “Format Painter” to stop. While Format 

Painter is a useful tool to change selected text, the Font groupings of the Home Tab have many more 

features. 

Font Group 
The Font group provides unlimited customization of text. It allows users to change the font or style of 

the text, the size of the text, provide text emphasis, and even change the colors. 
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Beginning in the upper left-hand corner, the Font Selection Box and Text Size boxes allow 

customizations of hundreds of font designs and text sizes. The capital “A” button on the right  allows 

the user to gradually increase the text size with the smaller capital “A” button next to it on the right  

decreases the text size. The capital “Aa” button to the right changes the case of the text. Using this 

feature, selected text can be made into lower case, UPPER CASE, Capitalize Each Word, tOGGLE eACH 

cASE, and regular Sentence case. Finally, in the button to the right that appears to have an “A” with an 

eraser  removes all the formatting’s from the Font menu. The lower row of the Font group contains 

Bold , Italics , and Underline  (without underline options for line thickness). Next to these 

commonly used emphasis tools are strikethrough  (which places a line in the text), subscript  (which 

types small letters under the text), and superscript  (which types small letters above the text). Next to subscript and superscript is 

an outlined letter “A” which allows the adjustments of text effects and typography to create 

shadows for other text effects. To the right is an icon with the letter’s “ab” with a pen . This is the 

highlighter option which allows the student to choose between multiple colors to highlight the selected 

text. Finally, to the right of the highlighter menu is an icon of the letter “A” with a line underneath . 

This control allows the user to change the color of any selected text with an almost infinite number of 

color options. By clicking on the arrow pointing down and to the right in the Font group, an expanded 

menu with even more options will launch, allowing the user with many more text customization options, 

as well as the option to set default text options and effects. 
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Paragraph Group 
The Paragraph Group focuses on arranging text in a paragraph. Users may create lists, adjust the 

indentation, sort items, show paragraph formatting, correctly, align text in a paragraph, adjust line 

spacing, add fill color in shapes, and create borders. 

 

Bullet Lists 
Starting in the upper left corner are bullet lists . Bullet lists should be used when creating a list of 

similar items that do not require any order. Clicking on the drop-down arrow allows for customization of 

the appearance of bullet lists. Pressing “Tab” on the keyboard will indent a list item and create a sub 

bulleted item. 

Numbered Lists 
To the right of Bullet, Lists are numbered lists . Numbered lists are like bullet lists, but they should be 

used when listing out a sequence of events that must be followed in order. Clicking on the drop-down 

arrow will allow for customization of the numbered list. Pressing “Tab” on the keyboard will indent a list 

item and create a sub numeral. 

Multi-Level Lists 

To the left of Numbered Lists are Multi-Level Lists . Multi-Level Lists provide more customization of 

lists and sub-lists to the user. 

Increase/Decrease Indent 

Next on the right, the increase/decrease indent icons allow the user to move the selected text to 

the right or left five spaces, or to the next tab setting. Increase/Decrease indent also changes the 

hierarchy of the list. Increasing an indent to the right will make an item a sub-bullet or sub-number of 

the item above it and decreasing indent to the left will do the opposite. 

Sort 

After an increase/decrease indent is the Sort icon allows the user to arrange a current selection of 

text in alphabetical or numerical order. It is usually used when working with tables in Microsoft Word. 

Show/Hide Paragraph Formatting 

Finally, in the top right corner of the paragraph group is the Show/Hide Paragraph Formatting icon  

allows the user to view all the hidden formatting options that are currently attributed to the document. 
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This is useful if the formatting seems incorrect in a document and the user is trying to investigate it. Any 

formatting displayed is not printed. 

Paragraph Alignment 
The bottom row of the paragraph group begins with Paragraph Alignment settings . The 

settings align the selected text to the left side of the screen (which is standard formatting), centered 

(which is common for titles), right-aligned, and justified, which distributes text evenly between the 

margins. Most word documents are written with left alignment, so that is the default settings. 

Line & Paragraph Spacing 

To the right of the paragraph alignment icons is Line & Paragraph Spacing . These settings allow the 

user to choose how much space exists between lines and between paragraphs. This is helpful to 

enhance the readability of paragraphs by creating enough space between sentences and paragraphs. 

For more customization, users can click on “Line Spacing Options” in the drop-down menu for even 

greater controls. 

Shading 

The Shading function  to the right of Line & Paragraph Spacing allows the user to change the color 

behind a paragraph, table, or selected text. It can be used in flyers and more creative word documents. 

Borders 

The Page Borders icon  allows the user to create borders around selected text and/or paragraphs 

and define the type of borders from the drop-down menu. There is every type of border imaginable for 

the user. Borders are usually created to create distance or space between separate ideas or paragraphs. 

More settings 
Users who desire more control in paragraph formatting can click on the arrow icon facing down and to 

the right. . This will launch a more settings menu that will provide customization of the line & 

paragraph spacing and page breaks. 
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Styles Group & editing Tab. 

The Styles Group is used to format specific blocks of text into different styles. Styles change the 

appearance and formatting of text. Users often use Heading Styles in Microsoft Word to organize the 

document into sections, which can later be used in a table of contents. Selecting text and then clicking 

on the appropriate style will change that selected text to a style. Specific styles can also be helpful to 

create standard document appearances and formatting. Right-clicking on a specific Style will allow you 

to edit a style to change the sizing, font, spacing options, other types of formatting, as well as updating 

all text with that style to your selected options. Clicking on the More Options arrow will allow you to 

create styles and select from an even greater number of styles options. 

Find/Replace/Selection Pane 

The Find/Replace/Selection Pane allows you to search for any text in Microsoft Word and 

replace the text with another text entry. Clicking on the “Find”  menu will display a side 

navigation bar allowing the user to find any word or phrase in the document. Clicking on the Replace 

icon  will launch a Find and Replace Dialogue box which will allow the user to replace specific 

text with different text. For example, I wrote a five-page paper on arc-welding, and discovered that arc-
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welding should be changed to the word “robotic arc welding”, I could use find and replace to 

automatically replace every phrase “arc welding” with “robotic arc welding”. 

 

Finally, the Select icon  allows the user with more options in selecting text and or objects in the 

document. 

View Tab 

 

Microsoft Word provides a variety of options to view their document for the user to customize their 

workspace. Read Mode allows the document to be viewed without any editing tools available in 

Fullscreen mode. Print Layout simulates what the document would look like if the document were 

printed. It is the default view mode in Microsoft Word. Web Layout simulates the view of the document 

if it were on a web. Outline mode is for a way to quickly insert ideas on the page, while Draft allows the 

user to just see the text in the document.  

Learning Tools allows the document viewer to customize the way the document is presented and read 

to them. It allows the user how text and pictures are displayed. Users can also determine whether to 

display the Ruler on the top and left sides of the workspace, gridlines on the document to make it 

appear like graph paper, and the navigation pane on the left-hand side of the document. The user can 

also Zoom in or out, and have the document automatically be adjusted to the display size of one page or 

multiple pages. Users can even open a new window of the document to work in two different places at 

the same time, or split the document at the insertion point to work in multiple sections at the same time 

in the document. Finally, Word users can click on the Switch Windows icon on the screen to switch 

between open word documents, and Record Macros, which allow the user to create their shortcuts by 

recording actions on the screen and creating a shortcut to perform everything they previously did. When 

they need to replicate that task, they can enter shortcut and the Macro would be initiated. Macros are 

for advanced users and not covered in detail in this text. 
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Checking for Understanding 
1. Create a flyer that provides a visual example of every feature on the home tab. 

2. Create an instruction manual to operate a large truck using four headings and two (2) 

bulleted lists. 

3. Copy a news article from the New York Times. Paste it into word. Use Replace to change 

every word “The” to “Green” 

4. Create a “For Sale” add selling equipment from your employer. Make sure to adjust 

paragraph spacing to two (2). Make sure to view Gridlines, the Ruler, and Navigation 

Pane in your document. 
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Chapter 12: Using the Insert Tab in Microsoft Word:  
Introduction to the Insert Tab 

The Insert Tab allows the user to insert a variety of items into their document. In contrast to the Home 

Tab which provides controls for the user to manipulate and adjust their entered text, the Insert tab 

allows the users to add items to the document such as new pages, tables, graphics, document items, 

Microsoft Word add-ins, video, comments, header/footer, text boxes, and Symbols. Just like the Home 

Tab, all functions of the Insert Tab are placed into groups that are described below. 

Pages Group 

The Pages Group contains features to insert a Cover Page, Blank Page, or a Page Break to 

your document. Clicking on Cover Page will launch a drop-down menu allowing the user to choose from 

a variety of cover page templates to place as the first page or cover page of the text. After the templates 

are selected, the user must enter text into the appropriate fields. The Blank Page command inserts two-

page breaks, one above and one below the cursor’s current position. The user selects to insert a Blank 

Page break when they want to ensure one entire page of space between paragraphs.  Finally, the Page 

Break command inserts a Page Break just after the insertion point. A Keyboard shortcut for a Page Break 

is Ctrl + Enter. The Page Break command is used to ensure the next text after the insertion point is on a 

new page. 

 

Tables Group 

The Tables Group has one icon with many features. Clicking on the Table icon will launch an 

additional commands dialog box below. Users will have the option to insert a table by selecting how 

many row and column cells the table contains as the first option. Cells are the individual “boxes” that 

make up a table. Rows are groupings of cells that move left to right. Columns are groupings of cells that 

move up to down. A table can allow information to be shared with the reader in an easy to understand 

way. As an example, see the table below for a detailed example of all the table command options 

available to the user. 
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Table 
Command 

Function 

Insert Table 
Command 

The Insert Table Command will allow the user to customize the 
number of columns and rows and determine whether they would like to size the 
table themselves with a fixed column with or allow Word to autofit the table to the 
specific text or window area. Word users may always resize the table by moving 
their cursor between the table cells until their insertion point cursor changes to a 
cursor with arrows pointing left and right. Clicking on the mouse at this point will 
allow the user to adjust the size of tables columns and/or rows. 

Draw Table Selecting the Draw Table command will change the cursor’s image from the insertion 
point to a pen. When the user selects a location with the pen and clicks the mouse, 
they can insert a table cell. 

Convert Text 
to Table 

Users can apply this command after selecting words they wish to place into a table. 
With the command entered, Word will attempt to place the text into the cells which 
it thinks is correct. It may still require the user to manipulate the table. 

Excel 
Spreadsheet 

Selecting an Excel Spreadsheet will allow the user to place a mini excel worksheet in 
their document at the insertion point. The excel document not only can appear as a 
table but can also be used to perform several calculations. 

Quick Tables Selecting Quick Tables will launch a variety of table templates from Microsoft Word, 
allowing the user to select from already created tables that have been formatted 
and choose the best one for their project. 

After the Table has been created it is easy to add additional rows/columns, resize the table, or add 

additional features and formatting. By using the primary mouse button (usually left-clicking) inside the 

table will add two additional modules to the Word Ribbon: Design & Layout. . In 

addition, using the secondary mouse button (usually right-clicking) brings up other shortcuts for the 

table that are found in the Design and Layout Tab. 
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Design Tab 

 

The Design Tab allows for manipulation of the appearance of the Table. In the Design, Tab is Table Style 

Options, Table Styles, and Borders Groups. 

Table Style Options 
Table Style Options allow the user to allow to Program Word to understand the type of table that was 

created. Selecting Header Row will change the formatting of the top row to differentiate the shading 

and the font of the header row. Total Row will change the formatting and shading of the bottom row. 

This is usually selected if the table is displaying a total (such as the total cost of supplies in a table about 

supply costs. Banded Rows are always selected by default. Banded Rows indicates that every that the 

shading in every row will be alternated to provide better visual clarity of the table. First Column 

indicates that the First Column on the left of being shaded differently to provide visual separation from 

the table information. This can also be selected for the last column. Finally, Banded Columns are the 

exact same as Banded Rows, except that they apply to columns. Depending on the table created and the 

information in the table, there are many options to make the information in the table stand out to the 

reader. 

Table Styles 
The Table Styles Group has two main options: to change the appearance and shading of the table and to 

manipulate the color options. Selecting the downward-facing arrow will launch a dialog box to provide 

the user with additional Table Styles with variations on color, spacing, and line thickness. Users can even 

create their own Table Style or edit a Table Style template. Finally, selecting the shading paint can 

button  will allow the user to change the color of the cell. 

Table Borders 
Table Borders allows the user to adjust the line thickness, color, and pattern of the table borders. 

Clicking on the downward arrows will provide even more options about Border styles, font size (default 

is ½ pt.) and Pen color. In addition, users can add or remove cell lines by selecting the Borders icon 

Finally, the Border Painter icon  will change the cursor to a paintbrush. Word users may add page 

borders by directing the cursor to the border of a table to add a line or increase the darkness of the line. 
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Layout Tab 

 

In contrast to the design tab, the layout tab allows for manipulation of the table itself. The Layout Tab 

consists of the Table Group, the Draw Group, the Rows & Columns group, the Merge Group, Cell Size, 

Alignment, and Data Groups. 

Table Group 
The Select button relates to the specific location of the insertion point in a specific cell in a table. 

Clicking on the Select icon will display Select Cell, Select Row, Select Column, and Select Table. Select 

Cells will highlight the specific cell. Select Row will highlight the entire row with the insertion point 

contained in it. Select Column will select the entire column. Finally, a select table will highlight the entire 

table. View Gridlines shows are hiding the gridlines of a table. By default, the gridlines are displayed in a 

table. Sometimes, the user wishes to not display these lines for cosmetic reasons. Finally, Table 

Properties allow for the manipulation of table formatting, row and column information, and allows the 

user to enter Alt Text, which allows users with screen readers to view information about the content in 

the table. Users can also adjust borders and shading and text wrapping in the table, along with preferred 

with of cells.  

Draw Group 
The Draw Table group has two options, Draw Table and Eraser. Draw Table allows the user to use the 

mouse to draw custom table boundaries, including diagonal lines. The Eraser icon allows the user to 

remove table boundaries and lines to merge cells in order to customize a table. 

Rows & Columns Group 
The Rows & Columns Group allows the user to insert cell rows or columns above, below, left, or right of 

the insertion point. Often when designing a table, new information requires a new row or column. Users 

can also do this by right-clicking on the table, but this can be a solution with more options. 
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Merge Group 
The merge group consists of Merge Cells, Split Cells, and Split Table. If a user highlights information in 

two adjacent cells, it will merge the information together in one cell that takes up the same area of 

space. Split Cells does the opposite, it separates one cell into multiple cells. Finally, Split Table allows a 

new table to be created beginning at the row that is currently the insertion point. 

Cell Size 
Cell Size determines the length and width of each cell in a table. The first option is the Autofit command. 

Autofit allows the user to resize the entire table. It provides three options, Autofit Content, Autofit 

Window, and Fixed Column Width. Autofit Content allows Microsoft Word to automatically size the 

table to take up as little space on the page as possible. Autofit Window resizes the table based upon the 

size of the window. Finally, Fixed Column Width allows the user to manually resize the table with the 

measurements to the right. Distribute Rows & Columns allow for an equal distribution of rows/columns 

in the table. 

Table Alignment 

Table Alignment allows the user to orientate the text within each table cell top left 

centered, centered, top right centered, middle left alignment, middle center, middle right alignment, 

lower left alignment, lower-middle centered, and lower middle right alignment. The text direction allows 

the user to change the direction text is displayed. Text can be displayed by default as left to right, but it 

can also be up to down, right to left, and up to down. Finally, Cell Margins 

allows the user to set up margins between cells, and left, right, upper, or lower indentation for text. 

Table Data 

Table Data allows the user to use some features of Excel in a Microsoft Word 

table. Information can be sorted. If a table occupies more than one page, selecting Repeat Header Row 

will display the table header on the next page so the viewer can see the headings. Convert to Text 

removes all table formatting and automatically places each table row into paragraphs. Users may need 

to additionally adjust the table to ensure the data displays the way they would like it to after selecting 
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this command. Finally, the formula allows for some features of excel to be used in their table to perform 

calculations. 

 

Illustrations Group 

 
The Illustrations group allows the user to insert pictures or shapes within a document.  

Inserting Pictures 
The first options are for pictures. Users can insert Pictures that are saved on their computer (or an 

external drive), millions of online pictures on the internet using Bing Search. While it is possible for users 

to find a picture on the web, save it to their computer, and place it in the document, using the Insert 

Online Pictures option is the best method because Microsoft Word provides the citation of the picture, 

so the picture is properly sourced. 

Inserting Shapes, Icons, & 3d Models 

Clicking on the Shapes Icon  will launch a drop-down menu of an assortment of shapes, lines, and 

symbols for the user. If the user needs a shape/symbol that is not available, there is even an option to 

design their own shape. The Icons Icon launches an online database of thousands of graphics and 

emojis to search from.  The 3d Models Menu launches a drop-down box with similar search options for 

3d Images compared with the Icons launcher. Users can search the web for a 3d image or upload their 

own. 

SmartArt 

 The Smart Art Icon allows the user to insert SmartArt to visually communicate information with 

diagrams or flow charts. Upon clicking on the Smart Art icon, a multitude of SmartArt Graphical 
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templates launch. 

 

Chart 

The Chart Icon will allow the user to create a chart using numbers in Microsoft Word. While 

more attention will be given to charts in the Excel Chapters, users are encouraged to practice the many 

different chart patterns on their own in Word. Upon clicking on the Chart icon, a new window will 

launch showcasing all the different chart creation templates available. When the chart loads on the 

Word Document, an Excel spreadsheet will also load embedded in Microsoft Word’s Chart. Changing the 

numbers will change the appearance of the chart or graph. The Excel Spreadsheet is not visible if 

printed. 

Screenshot 

The Screenshot icon  is the last of the illustrations group. The command allows Microsoft Word 

to take a screenshot of other open/running programs or Windows Explorer windows to place directly 

inside the document. Unfortunately, the screenshot tool does not allow the screenshot to be taken 

inside Microsoft Word. Once the icon is selected, a drop-down box indicating other open arrows can be 

displayed as eligible to take a screenshot. The portion of the screen to be captured should be 

highlighted prior to taking the screenshot. Using a screenshot can be incredibly helpful when 

communicating with others if you are trying to ensure they understand what is occurring on your 

computer. 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

116 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

Document Item Group 
Image a scenario if you were creating a document that provided a quote for a job to a prospective 

employer and then soon after completing this quote, another prospective employer asked you for a 

similar quote. Instead of creating the second quote all over again, it might be nice to re-use some of the 

other quotes you completed to save you time. Document Item  of the insert tab allows the user to 

do just that. Clicking on Document Item will launch a right navigation bar allowing the user to access 

parts of a document; text, pictures, charts, tables, etc. in other documents saved to their computer or in 

Microsoft One Drive or SharePoint. Other Office documents, such as Excel or PowerPoint may also be 

accessed. 

Add-ins Group 

The Add-ins group in Microsoft Word is a place where various plugins or optional 

programs that run inside of Microsoft Word can be installed and run. Depending on your Office license, 

you may or may not be able to access Microsoft Add-ins. The default add-in installed is Wikipedia, which 

allows Wikipedia to be searched and text/photos/objects selected to be inserted into the Word 

Document. 

Media Group 

The Media group contains one function: Online Video. Users can insert video into their 

documents that can be played by the user. In this way, Microsoft Word takes on characteristics of a 

webpage by allowing rich levels of interactive media to be displayed in a Word Document. When 

selected, two sources for videos are displayed. Option 1 is to search for and insert a video via Youtube. 

The second option is to insert a video from a website if you have the hyperlink. 
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Links Group 

Link allows the user to create a hyperlink to a website, email address, or a specific 

location (via a bookmark) in the document. It is expected that any website that is written in a document 

be hyperlinked. A document appears to be correctly hyperlinked if its color is blue and it is underlined. 

Users can also allow for bookmarks to be placed in the document. When a bookmark is created, another 

text must be hyperlinked and connected to the bookmark. When this occurs, a connection is 

established, and anytime that a user clicks on the hyperlinked item, they are transported in the 

document to that specific bookmark. To set up a bookmark, first, the user must highlight the text to be 

marked, and navigate on the Insert Tab to Bookmark. Next, to link to the bookmark from another place, 

the user must create a hyperlink. When an email address is hyperlinked, the email application of the 

computer will automatically be launched, and a compose email window will appear with the specified 

email address as the receiver. Finally, Cross Reference is like a bookmark, except that it displays the 

specific name of the text that is bookmarked in the word document. 

Comments Group 

The comments group is useful when the user wants to place a note in the document for 

themselves or another user that they do not want to be printed. To enter a comment, click on the 

Comment button after highlighting the text that pertains to the comment. When the Comment button is 

selected, a new right-side panel of Microsoft Word screen will be created, and the name of the user will 

be displayed, allowing them to enter in as much text about that specific text. Users can reply to 

comments, delete comments, and create as many comments in the document as needed. 

Header & Footer Group 

The header and footer group control the text that is displayed at the top and bottom of 

every page of a document. The top of every page is the Header Row. The bottom of the page is the 

Footer Row. Text that is inserted into the header row is displayed on every page of the specific section 

(most documents only have one section, but you can change the header by creating a section break). 

Often, the header contains the title of the document and the author, and the footer contains the date 

the document was created or page number. Clicking on the drop-down arrows for header and footer 

creates standardized options for a header and footer, but the user can customize the rows to their 

liking. The Page Number command provides options for how to insert page numbers throughout the 

document. The benefits of Microsoft Word inserting page numbers or doing it manually is that Microsoft 

Word automatically adds page numbers if pages are modified. 
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Text Group 

 

The text group options allow for the insertion of a variety of 

text options. Text Box allows the user to insert a textbox in a specific space in Microsoft Word. Once 

inserted, Word treats the text box as a picture in that the text can be resized, moved around, and 

reshaped in relation to other text on the screen. There are several textbox options to use in word as 

templates. Quick parts allow the user to create shortcuts in Microsoft Word. For example, a user could 

create a Quick Part command so that every time they typed “CLC”, Word would convert those letters to 

“Central Lakes College”. Users often create Quick Type commands so that when they enter their initials, 

Microsoft Word automatically inserts their entire name. the Word Art command box allows the user to 

create colorful and artistic text/phrases in their document with a greater degree of flexibility than simply 

changing the font size.  

 drop cap creates a large first letter at the beginning of a sentence. Drop caps are often used in 

novels and creative writing. Clicking on the drop cap icon will allow several different options to 

display the drop cap. The Signature Line command creates a custom field in Microsoft Word 

where another user must sign. This command allows for e-Signature, or just a preformatted 

professional-looking field for the signee to return after the signature. Date & Time provides the 

user with multiple options to display the current date and time in a variety of languages. 

 Users are encouraged to insert the date here rather than 

entering it on the keyboard because Microsoft Word will automatically update the date on the 

document unless the “update automatically” command box is left unchecked. 

Finally, Inserting an Object allows for other Microsoft Office files to be inserted inside of the document, 

along with options for specific functionality of that file’s application. Users may select this command if 

they wish to insert an excel document. 

A 

This is an example of a textbox. 
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Symbols Group 

The final insert group, the Symbols group, allows the user to insert an equation or 

symbol. The Equation option will allow the user to insert a mathematical equation into the document, 

which is helpful when trying to display complex math problems inside Word. Using the Insert Symbol 

command allows for Word to provide options for thousands of symbols and characters to be added to 

the document or text group. 

 

Checking for understanding 
1. Create a document titled “Monthly Sales” for items sold in your respective industry. Insert a 

Cover page to this document. 

2. In this monthly sales document, create a table with 13 Rows, and 2 columns. The Header row 

should state “Month” and “Number of Sales” Enter the months of the year in the first column 

under “Month” 

3. Using Microsoft Word, create a Totals field to total the number of sales for the year. 

4. Insert a Chart to visualize this table and 2 online pictures. Add a comment, and create a header 

& footer with your name, the document name, and the page number. 

5. Create a title with some word art and insert the date and time. 

6. Write one paragraph explaining the charts and use a drop cap. 
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Chapter 13: Design, Layout, References, Mailings, & Review Tabs 
in Microsoft Word 
If the Home Tab allowed the user to manipulate the text in the document and the Insert Tab allowed the 

user to insert items into the document, the Design and Layout Tabs are more “big picture” tabs that 

allow various organizational structures to apply to a document section or the entire document. 

Design Tab: 

 
The Design tab allows the user to adjust the organization and visual structure, of the document. The first 

option to change in the upper left-hand corner of the tab is a Design Theme. Clicking on the Themes 

icon will launch a drop-down box with a large variety of templates for document themes. A 

document theme is a uniform set of organizational and stylistic structures that provide differentiation 

between headings and subheadings and provide easy navigation and comprehension for the reader. Just 

as you could imagine that PowerPoint has a variety of specific themes to choose from to display your 

slide show, so to can Microsoft Word provide themes. In addition to themes, Microsoft Word has many 

document style formats that ensure uniform line spacing and document & font organization to the 

entire document. The colors and fonts buttons/button allow you to apply different colors to the 

different document styles options, and the Fonts menu applies a unique font to the entire document. 

Paragraph Spacing, Effects, and Set as Default options  allow the user to set the default 

Paragraph Spacing, and default text effects to apply to the entire document and to Microsoft Word 

when the document is launched. 

Finally, the Page Background Group   Allow the user to create a document Watermark, 

which is a light color that covers the document (examples include the words Draft, Confidential, or 

Private. You can also use the drop-down menu that launches when the Watermark icon is selected to 

customize your Watermark. Page Color changes the background color of the document page (the 

default background color is white. Finally, Page Borders launches the Border menu for Borders and 

Shading and this menu has been described previously in detail. In summary, the Borders and shading 

group determine the shading effect for a page border and the thickness and style of the border. The 
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border settings can apply to a paragraph or the entire document.

 

Layout Tab 

 
The Document Layout Tab allows the user to create some spacing and margin controls for specific 

objects, pictures, paragraphs, sections, or the entire document. 

Margins, allows the user to customize how much white space, or upper, lower, left, and right page 

boundaries. Page Margins are often utilized to ensure a document expands to become a full page or is 

condensed to be one page. Document. The orientation button allows the user to change the page layout 

from the default portrait landscape, where the page is taller than it is wider, to landscape, where the 

page is wider than taller.  

The Size button changes the size of the page Word is preparing to print. By default, most printer paper is 

8.5X11 inches. However, there are other larger and smaller paper sizes. Changing the Size option will 

increase or decrease the amount of room each page.  

The Columns button allows the user to insert multiple columns on a word document. This is useful if the 

user is creating a flyer or newsletter. Columns are a lot like tables, however, they fill from left to right, 

and after one column is full, the text will move to the next column instead of being self-contained in a 

cell. 
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The Breaks button allows the user to place in a variety of breaks, which are text stoppers which prevent 

text from being added below the break until the next page, column, section, etc. Clicking on columns will 

launch a drop-down menu allowing the user to set up page breaks or sections breaks. As specified 

earlier, section breaks allow for not only a break in the text but they also allow for different layout 

options and page orientation settings, whereas page breaks, being in the same section, keep all the 

same formatting. 

Line numbers are not activated by default but can be activated with this button selected. Line numbers 

number each line of a page, section, or entire document (depending on which is selected). They are also 

helpful in technical and reference documents when the user is would like to help another locate a 

specific sentence or word. For example, in a Vehicle Service manual, a technician could be told to go to 

line 4320, instead of “the third sentence in the sixth paragraph). 

Finally, the Hyphenation command changes whether Word will require a word to be on only one line or 

joined in two lines with a hyphen. For example, if the word “Mississippi” was being entered close to the 

right margin, the default setting would be to place the word in the next line below. This setting can be 

changed to have word hyphenate the word. 

References Tab 

 

The References Tab is used to provide a hub to use citations, footnotes, endnotes, tables of contents. 

bibliographies, and any other type of references in a document. Often users will use the references tab 

when writing a research paper or a long document with many chapters. 

Table of Contents Group 

The Table of Contents Group requires the use of Headings, which were previously described. 

Using the headings, a Table of Contents is created and automatically connects the headings and 

subheadings with the appropriate page number. Every time the document is substantial, the user should 

click on the “Update Table” button, which will allow the user to choose between updating the entire 

table (to include new headings & subheadings), or simply to update the page number. When clicking on 

the Table of Contents icon, there are a variety of different styles to choose from. 

Footnotes Group 

Footnotes are additional information that the writer may place at the bottom of the 

specific page. Usually, footnotes are not required information for the reader to understand but allow for 

a “deeper dive” into the material if desired. Footnotes are numbered. The first footnote is given a 1 at 
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after a specific word, the next footnote on the page is given a 2. Compared to a footnote, an endnote is 

placed at the end of a document section, or end of the document if the document has only one 

sentence. The Next Footnote command allows the user to quickly move around in their document 

between footnotes or endnotes. The Show Notes icon displays to the user where the Footnotes or 

endnotes are located. Finally, there is a more settings box  Which allows for additional customization 

of footnotes and endnotes. When selected, a new window will launch allowing customization of where 

footnotes and endnotes appear, and the numbering and location of footnotes and endnotes on a page 

along with how they are displayed and referenced.  

Research Group 

The Research Group was added in 2016 to Microsoft Word. The Smart Lookup icon 

allows a word used in the document to be searched online for definitions, web-related information, and 
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phonetical spelling. For example, highlighting the word “phonetical” and selecting Smart Lookup 

provides the user with this information: using the lookup feature.  

The Researcher icon allows the user to quickly search the web for accurate sources of information and 

insert them into the document and include them inside the bibliography. This is particularly helpful to a 

student writing a research paper as scholarly journals are made easily available for searching and 

citations can be quickly added to the document. 

Citations & Bibliography Group 

Citations tell the reader where a document was retrieved and how it was 

used. Selecting the Insert Citation field launches a drop-down dialogue box allowing the user to add a 

new source, add a new placeholder (if you want to insert the source later), and insert a citation you have 

already used. Manage Sources launches a new Source Manager window to allow the user to edit existing 
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sources to make changes to the Citation or remove citations not needed in the document. 

 

Users can also change the citation style between APA (default) to other citation standards as required, 

and finally, inserting a bibliography with the theme of their choice. Usually, Bibliographies should be 

placed at the end of the document. 

Captions 

Captions allow the user to mark text under a specific graphic to 

further explain the picture. Selecting the Insert Caption Icon, Users can customization their caption text, 

and its location in the document.  

 

Example of caption settings 

Inserting a Table of Figures is like a Table of Contents, except it is only for captions. Usually, a table of 

figures, if used, is placed at the end of the document. Finally, cross-references allow the user to quickly 

place links in a document to other information in the document. For example, if I wanted to remind the 

user what a Motherboard on a computer was, I could create a Cross-reference of the word 

“Motherboard:” and it would be hyperlinked to Chapter One, so when the user clicked on 
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“Motherboard”, they were immediately sent to Chapter 1. The cross-reference feature of Microsoft 

Word requires the use of headings, or other citations to be able to navigate the document. 

Index Group 
Have you ever looked at the end of a book and found an enormous index that contained everything in 

the book and wondered how it was that this was created? Microsoft Word creates an easy way to create 

an index if needed. First, to place a word or phrase in the index, highlight the word(s) and select Mark 

Entry. Users can then specify how they want that phrase to appear in the index. 

 

The Insert index creates an index at the insertion point from every item that was marked for entry into 

the index. Finally, the Update Index icon updates the index with any new entries entered after the initial 

index was created. 

Table of Authorities Group 

 

If a user wanted to write a legal brief that contained an index of cases, laws, court decisions, etc., they 

would use a Table of Authorities at the end of the document instead of a bibliography. Just like the 

Citations command, the Mark Citation in the Table of Authorities Group will create a citation in the 

proper format, and users can insert a Table Authorities at their desired insertion point and update the 

table as needed. 

Mailings Tab 
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Do you ever wonder how a business can send out thousands of letters with your first name in the letter 

and your address correctly printed on the envelope? It is likely they are performing a mail merge to 

quickly print customized documents with different information very quickly. Mail Merge features are 

found on the Mailings tab of Microsoft Word provides a variety of features to help the user quickly and 

with relative ease conduct a mail merge. 

Create  
The Create group allows the user to create customized envelopes or sheets of address & name labels 

with one address. The create group should be used for simple mail merges where only one address is 

needed. 

When the user selects Envelopes, an Envelopes and Labels dialog box will launch, and the 

user can insert the address for the specific envelope to be printed. When labels have selected the 

Envelopes and Labels dialog box will launch again and will allow the user to print out a single address in 

a specific label location on a page, or have the same address be added to every label. 

Start Mail Merge 

 

The Start Mail Merge Group icons are what allow the user to begin the mail merge process. The Start 

Mail Merge icon allows the user to select the type of document that is to be created with the mail 

merge process. Determine whether the mail merge is a letter, email message, envelopes, or labels. If 

Envelopes are selected, a new dialog box will launch allowing the user to customize the size of the 

envelopes being used. Finally, the user can launch the Step-by-Step Mail Merge wizard to help the user 

complete the mail merge. 

The Select Recipients icon allows the user to select a file that contains a list of recipients that was 

previously created in Microsoft Excel or Access (existing list). If the user selects to create a new list, they 

can begin to insert the list of addresses and names in customized fields using Microsoft Word and an 

embedded Access document. The user can also use their Outlook contacts to create a list. 

Finally, the Edit Recipient List icon allows the user to edit the list they had selected for a mail merge. 

Perhaps you had created a mail merge list to send out a newsletter to customers and just before 

printing, a new customer was added. You can add the customer using this command without changing 

the list in other locations. 
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Write & Insert Fields Group 

 

One of the best ways to create customer engagement is to treat each customer like they are a unique 

person. Using the Write & Insert Fields icons, you can do just that. You can create custom text fields in 

the document that receive mail merge information. You can do this with the Address Block, Greeting 

Line, and Insert Merge Field Command. The Address Block & Greeting Line allows the user to apply 

Word’s templates, where the Insert Merge Field icon allows the user to customize the fields that are 

inserted into Word. After inserting all the fields, the user can select Highlight Merge Fields to display all 

the mail merge fields in the documents. 

When conducting the mail merge, Word has many pre-populated field descriptions. The Match Fields 

command allows the user to match their own fields (in an excel document for example) to Word’s 

custom fields. Finally, the Rules icon allows the user to specify criteria for inserting special fields into a 

document, for example, they could create a message that says, “Happy Birthday!” if it was determined 

that the birthday of the recipient was the same date the letter was being printed. Finally, the Update 

Labels command will update the field information to all other merge fields in the document. 

Preview Results & Finish 

 

Once the Mail Merge has been created and customized fields have been created, the user can click on 

Preview Results which will cause Word to create customized letters determined by the number of fields 

in the excel document or database from which Word is using to create Mail merges. The mail merged 

letters will appear in alphabetical order, and the user can search by the recipient to find the individual 

they wish to find or navigate forward or backward their mail merge list. The user should also select 

Check for Errors to ensure there was no missing information in the mail merged fields. Finally, when 

everything appears correct, selecting Finish & Merge will create all the documents in this mail merge to 

be printed or emailed. The user can still edit the individual documents manually if needed. 

Review Tab 

 

The purpose of the Review Tab is for proofing your document and providing possibilities for seeking 

feedback on your final edits. The Review Tab is separated into multiple groups: Proofing, Speech, 

Accessibility, Language, Comments, Tracking, Changes, Compare, Ink, & Resume. 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

129 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

Proofing 

The Proofing Group allows the user to improve the words in their document. Users can 

click on Spelling & Grammar to launch Word’s built-in spelling and grammar checker to fix words and 

phrases that may be incorrect. When selected, the icon launches a navigation pane on the right side of 

the document, allowing the user to review spelling and grammar errors that the textbook does not find 

accurate, and make the changes, or ignore the recommendations. 

Speech & Accessibility 

Microsoft Office can read any text in the document by clicking on the Read Aloud icon in 

the Speech Group. Once the Read Aloud button is selected, Word will begin reading at the insertion 

point of the text. The Check Accessibility button launches the Accessibility Checker tool in Microsoft 

Word on a right-side panel of the page. The Accessibility Checker will review the entire document to find 

areas that would impair screen readers and other accessibility programs to aid those who have difficulty 

seeing or reading a document to still be able to understand the text in the document. 

Language 

The Language group allows the user to translate words in the document into a different 

language. Users will have the opportunity to translate a highlighted section or an entire document into 

another language. There are a variety of languages available for translation. In addition, the Language 

icon provides the user with the option to change which language Microsoft Word will use for use in the 

Spelling & Grammar checker. 

Comments 

Want to place a note in your document to review at a later time, or are you 

working collaboratively with someone else on the document? Using the Comments group is the easiest 

way to keep track of information about the document without changing characters in the actual 

document itself.  Comments are automatically “turned off” by default. They can be enabled by selecting 

the Show Comments icon. To enter a comment, highlight the text you wish to comment about or place 

your insertion point where you want the comment to be placed. Then, select New Comment. A new 

section of the Word Document will launch on the right-hand side of the page. This will not be able to be 

printed but will display to the user with a line connecting the comment to the insertion point of the 

comment. 
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Tracking & Changes 

When you are working with multiple individuals on a document it can 

become difficult to keep track of which changes each user has made. The Tracking & Changes group can 

help the user determine which text additions or deletions were entered and which user made the 

changes. Be default, the Track Changes icon is not enabled. To turn on tracking, click on the Track 

Changes icon. The user can also select the type of changes made in the document selecting Show 

Markup. A change in the document is entered in Red with an underline. Once a change has been 

entered, the author has the option to accept or reject the change in the Changes group. Users can 

navigate through the changes by clicking on Previous and Next. Once the user has accepted or rejected 

the change, the text will revert back to the standard text and fonts in the document. Users can also 

approve or deny all changes in the section or entire document. Remember, you can always stop tracking 

changes by clicking on the Track Changes icon. 

Compare, Protect, & Ink Groups 

Finally, users can place the finishing touches on the document by using 

Compare & Protect groups. Compare allows the user to compare their current version with previous 

versions of the document. Microsoft Word stores each version of the document when it is saved. The 

user can review each version of the document with the current version. This allows the user to revert 

the document back to a previous version if a catastrophic change is made to the document. The Protect 

group allows the author to stop certain authors from being able to edit or restrict others from making 

any changes to a document to make it read-only or restrict permission to change words in the 

document. 

Checking for understanding 
1. You are tasked with writing a paragraph that will be placed in a newsletter that will be 

emailed to your community. The paragraph will share what you do on a day-to-day basis 

in your current position. Please use the Design Tab of Microsoft Word to change the 

document theme with relaxed paragraph spacing and place a Watermark of “Draft” on 

the paragraph. 

2. Make the margins in your paragraph at .5” margins with a landscape orientation. 

3. Add a picture with a caption to your paragraph that describes your vocation. 

4. Launch Spelling & Grammar to ensure your document is written correctly and add a 

comment on your document. 
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Chapter 14: Getting Started with Excel  
Microsoft Excel is a spreadsheet program. Spreadsheets are used to create grids of texts, numbers, and 

formulas to complete calculations and display information in an organized manner. Microsoft Excel is 

frequently used for budgeting and accounting, as well as to create charts and visuals based upon 

numbers and other calculations. Excel is a powerful product that once the user can understand its 

navigation, can become incredibly useful and easy to use.   

Functions of a Spreadsheet:  
The purpose of a spreadsheet is to organize and calculate information. Spreadsheets are utilized by 

many different businesses and organizations to perform a variety of tasks. The most commons tasks 

performed by spreadsheet software include functions, computations, statistical analysis, and formatting. 

This text will focus on excel when discussing spreadsheets. 

Functions: Excel is a spreadsheet consisting of unlimited numbers of cells. Cells are where information 

is stored. Spreadsheets feature columns and rows to keep information legible and simple to understand. 

You can use spreadsheets to enter data, calculate equations and create charts and graphs. What's more, 

you can build upon previous work by using formulas and functions so that if the information is changed, 

your calculations adjust to the changes. 

Computations: Excel is able to compute a variety of mathematical functions, from simple equations like 

addition, subtraction, multiplication, and division to more complex financial calculations like Mortgage 

Amortizations, and Net Present Value (NPV). It can also create “what-if” scenarios and can create 

relational functions such as greater than, equal than and less than. 

Statistical Analysis: Excel is also able to allow the user to conduct statistical analysis, calculating mean, 

median, mode, averages, and standard deviation. Excel can be used to calculate percentiles and rank 

categories and items. 

Formatting: Excel provides maximum flexibility to customize the worksheet (the workspace of excel) 

and organize data. Excel allows cells, rows, and columns to expand, merge, be inserted and deleted. You 

can even place inside cells pictures, tables, hyperlinks, and text from other word documents. Data can 

be sorted in alpha and numerical order. 

Identifying Excel Windows Components:  
Like all Microsoft Office Documents, Microsoft Excel has a common window organizational structure. 

Each excel document is called a “workbook”. Inside each workbook can be multiple “worksheets” that 

contain data. Each point of data has a cell address. Each cell address has a letter and a number 

associated with it. For example, the cell address in the first row and column (top left corner) is “A1”. The 

cell to the right of “A1” is “B1”. The cell below “A1” is “A2”. This naming scheme continues for the entire 

document. 
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For a visual of Microsoft Excel, please launch the program in Microsoft Windows, and then launch a new 

worksheet by selecting the “File” Tab, then “New Worksheet”. The worksheet pictured below should be 

displayed on your computer. 

 

Key Excel Components:   
Common Excel components are listed below. 

Name Box: The name box displays the active cell address that is selected. The selected cell in the Name 

box is called the “active cell”. In the picture provided, the Name Box is “A1”.  

Formula Bar: The Formula Bar is to the right of Name Box. It allows you to enter information into the 

worksheet or make edits to data in the worksheet. 

Worksheet Window: The Worksheet Window consists of all of the cells in the worksheet. Cells are 

classified by lettered columns, and numbered rows. Every cell in the worksheet has a unique address.  

Sheet Tabs & Sheet Tab Scrolling buttons: As written previously, each workbook is composed of 

worksheets. Most Excel users place different, but related information in multiple worksheets in the 

same workbook. For example, you may maintain an Excel workbook that contains your department 

budgets, and each worksheet represents a different year. You can browse between worksheets by using 

the Sheet Tab Scrolling buttons. The active sheet appears visually to be at different depths on the 

document as other sheets. 
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Status Bar: The Status bar displays you various information about the cell or a calculation in place. It 

when selecting and highlighting multiple cells, it may provide information about the sum of the 

components, or an average, depending on the information inside the cells. 

Range: When selecting multiple cells with a mouse and dragging the cursor to another cell address, the 

selected cells are referred to a range. A range of cells is usually selected to perform a calculation. 

Understanding Formulas: 
Imagine that you are a manager of a construction company. You must maintain your staff budget to 

make sure you can afford to pay your employees and make a profit every year. You plan to pay the 

following employees accordingly: 

Name Rate of Pay Hours per week Weekly Salary Annual Salary

Michael Jordan 16.75$              40 670.00$               34,840.00$        

Lindsey Vonn 15.00$              40 600.00$               31,200.00$        

Kirby Pucket 13.25$              40 530.00$               27,560.00$         
SALARY INFORMATION CALCULATIONS 

 You use your calculator and finally finish adding up the total salary owed to each employee when your 

new state regulations require you to provide each employee a $.04 per hour raise. You are frustrated 

because you must now take extra time to recalculate your spending plan all over again. However, you 

are using Excel, and you discover you don’t have to. This is because you used formulas connected to the 

cell reference content instead of a number. As a result, you can just insert the updated rate of pay, and 

Excel will automatically recalculate the weekly and annual salary. The formula entered in the Name box 

below is “B2*C2”. Which Excel uses to calculate the weekly salary in Column D. 

 
UPDATED SALARY CALCULATIONS 

Quick Analysis Toolbar 
Excel provides many tools to help the user complete their work quickly and efficiently. Another helpful 

tool is the Quick Analysis Toolbar. When highlighting multiple cells at once, depending on the type of 

information in the cell, a quick analysis toolbar  may appear in the lower right-hand corner below the 

last cell highlighted. In addition, the status bar provides helpful calculations in reference to the 

information highlighted like Average, Count, and Sum. 
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Selecting the Quick Analysis button  allows for multiple options to format your information, or to 

create Charts of the data, calculate the data, create tables, or visual sparklines. More information about 

these items will be explored in future chapters. 
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In addition, in the lower right-hand corner of the highlighted cell, there may be a “+” button. This is an 

autofill button that will be explained in further detail, but a quick summary of the autofill button is that 

it can allow the user to copy text from the above cell to other cells by clicking on the “+” sign, and 

dragging the mouse and highlight the other cells. The autofill button can also copy formulas and are 

other references. 

Zoom, View, & Window Options 
Just like Microsoft Word, the bottom right-hand corner provides multiple views and zoom options. The 

three Zoom options from left to right are Normal, Page Layout, and Page Break Preview. 

. Normal is the standard view with just cell 

information in the worksheet available to the user. In this view, the user can focus on their work and is 

not able to determine how their sheet would appear if printed. Page Layout View provides a preview of 

what the document will look like when printed. Page Layout view is also the place where the user can 

add headers and footers to their worksheet. Finally, the page break view displays the normal view with 

dotted lines where the printer would print a new page. To the right of the various views is a zoom slider 

to allow the user to zoom in or out of their worksheet. 

Finally, just like Word, Microsoft Excel’s top of the document contains numerous window management 

and document management capabilities, including the Excel Ribbon. 

 

The Excel Ribbon consists of the File, Home, Insert, Page Layout, Formulas, Data, Review, View, and Help 

Tabs. 

The File Tab is responsible for saving your workbook, creating new workbooks, or opening other 

workbook files. It also has options for sharing the workbook and exporting it to other formats. Like 

Microsoft Word, it also contains options for other Excel Templates for a variety of functions. 
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In addition to Open, Saving, and sharing options, Excel contains multiple print options, allowing the user 

to customize their workbook. As Word, Excel users can choose their printers, the orientation of the 

printing, as well as what is printed. By default, only the active sheet – the document the user is currently 

working in, will be printed. Worksheets can also be scaled to fit the entire worksheet on one page, or 
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multiple pages, depending on the user settings. Finally, the user can specify the printing margins on the 

document in this window as well. 

 

TAB OPTIONS IN MICROSOFT EXCEL 
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The Home Tab allows various options to change the fonts, text size, cell properties, and insert, delete 

and modify cell contents and formulas. 

The Insert Tab allows for a variety of tables, charts, pictures, text and symbols to be used in Excel. 

The Page Layout Tab allows for customization of how the worksheet is oriented and appears during 

printing.  

The Formulas Tab allows for a vast amount of customization of Excel formulas and calculation options. 

The Data Tab allows the user to import and export data as well as manipulate data sets, to establish 

queries and connections and separate and sort data. 

The Review Tab allows for various worksheet protections and sharing settings along with help with spell 

and grammar check and accessibility checking. Similar to Microsoft Word, changes to the document can 

be recorded, and collaboration settings may be controlled. 

The View Tab allows for further worksheet customization to the user to display or hide document tools 

bars, freeze or expand cells, and Macro settings to complete multiple tasks at once. 

Finally, the Help Tab allows the user to receive help from frequently asked questions. Like Microsoft 

Word, users can enter their questions in plain text in the “Tell me what you want to do” field 

, and Excel will use artificial intelligence to retrieve a solution.  

Check for Understanding 
1. Enter the Excel Table information listed in this chapter to your own excel table. Practice 

creating simple formulas with Excel. Increase the wages by $1.22 per hour each and 

determine the new monthly and yearly salary of the employees. 

2. Describe the differences between a Cell, Row, Column, Worksheet, and Workbook. 

3. Describe the purpose of the three different views in Excel – which one allows the user to 

adjust the header/footer? 

4. To your document in #1, create a new worksheet titled “2030 salary projections” Copy 

your original worksheet to this worksheet and increase the wages by $40.00 per each 

employee. What are the totals? 
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Chapter 15: Home Tab & Working with Formulas and Functions 
in Excel 

 

The Home Tab contains many common formatting and simple functions tools to properly utilize Excel. 

Like Microsoft Word, the Home Tab is divided into multiple groups, Clipboard, Font, Alignment, Number, 

Styles, Cells, and Editing. 

Clipboard Group 

 

The main function of Clipboard is the Cut, Copy, and Paste feature. All Office Applications share a 

Universal Clipboard. This means that items that are copied in Windows 10 can be shared between Office 

Applications. You can view the Universal Clipboard by clicking on the clipboard box with an arrow facing 

down and to the right in Excel. A new navigation pane will open on the left side 

of the screen. It will display all the items that you have cut or copied in Windows 10 recently. This allows 

you to work with multiple items you have pasted. 

In addition to the Clipboard Navigation pane, users can also utilize Format Painter . Format 

Painter allows the user to copy the text size, fonts, and any other formatting, to another selected body 

of the text. To use the format painter functionality, users should select the text they would like to copy, 

and then click on “Format Painter”. Then select the text they wish to change. Users may also double-

click on “Format Painter” and change as many text selections as they would like. When they have 

completed changing the text selections, they can click on “Format Painter” to stop. While Format 

Painter is a useful tool to change selected text, the Font groupings of the Home Tab have many more 

features. 
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Font Group: 
The Font group provides unlimited customization of text. It allows users to change the font or style of 

the text, the size of the text, provide text emphasis, and even change the colors. 

 

Beginning in the upper left-hand corner, the Font Selection Box and Text Size boxes allow 

customizations of hundreds of font designs and text sizes. The capital “A” button on the right  allows 

the user to gradually increase the text size with the smaller capital “A” button next to it on the right  

decreases the text size. The lower row of the Font group contains Bold , Italics , and Underline  

(without underline options for line thickness). To the right of the Underline, the button is the border 

settings button . This button allows the user to control border lines around highlighted cells. Users 

can select top, left, right, bottom, or all borders to their selected cells. To the right of the border settings 

are the paint can icon . The painted icon allows the user to color a cell. Finally, to the right of the 

paint can menu is an icon of the letter “A” with a line underneath . This control allows the user to 

change the color of any selected text with an almost infinite number of color options. By clicking on the 

arrow pointing down and to the right in the Font group, an expanded menu with even more options 

will launch, allowing the user with many more text customization options, as well as the option to set 

default text options and effects. 
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Alignment Group 

 

The alignment group allows the user to control how text is displayed in cells. The first group in the upper 

left-hand corner that has horizontal lines/controls the vertical alignment of text or numbers in a cell. The 

first icon on the left is Top Alignment, which connects the text to the top of the cell. The next icon is 

Middle Alignment, which centers the text vertically between the top and bottom of the cell. The last 

vertical alignment is Bottom Alignment, which places the text near the bottom of the cell. The bottom 

Alignment is the default vertical alignment.  

The next alignment is Orientation which allows the user to rotate 

the text vertically or diagonally.  There is a drop-down box with more options to allow even more 

customization of how text is oriented in the cell to angle the text counterclockwise, clockwise, vertical, 

rotate text up and rotate text down. In addition, there are more options by clicking “Format Cell 

Alignment in the drop-down box in excel. In terms of text orientation, the cell is very flexible.  

Next to Orientation on the right is Wrap Text . The Wrap Text feature allows Excel to 

automatically adjust the vertical height of the cell to include all of the text in the cell by allowing the text 

to be placed on multiple lines. The default line format of excel is to display text on one line in a cell. If 

the cell is not long enough to accommodate the text, the text will be contained in the cell, but appear to 

be added to the next cell on the right. While each cell height and width can be adjusted with the mouse, 

the Wrap Text command allows for long text fields to be better displayed in the document. 

The bottom row of the Alignment group begins with Horizontal Alignment settings . The settings 

align the selected text to the left side of the cell (which is standard formatting), centered (which is 

common for titles), and right-aligned of the cell. 

Next on the right, the increase/decrease indent icons allow the user to move the cell closer or 

further away from the cell border depending on the horizontal alignment of the cell. 
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The last icon in the Alignment Group, Merge and Center  allows the user to allow 

information that is in one cell, to span multiple highlighted columns or rows and be treated as one cell. 

When two cells are merged together, the usual column or cell divider is removed, and the contents are 

displayed in both cells. . There are several options available to merge 

or unmerge cells in the drop-down dialog box to the right of Merge & Center with a downward arrow. 

When selecting multiple cells. Merge & Center performs what was previously 

described: allowing highlighted cell information that spans more than the current cell length to occupy 

multiple columns as one cell and centers the information.  Merge Across allows the user to take 

information that exists in multiple cells, and convert them into one cell that spans multiple columns. 

Merge Cell creates highlighted cells into one cell spanning multiple columns, and unmerge cells perform 

the opposite, it takes a merged cell that spans multiple columns and removes the cells that are merged 

into separate columns of cells. The information in the formerly merged cell is placed in the left cell. 

Number Group 

 

In addition to determining the way that information is displayed in a cell, the user can also determine 

the format a number is displayed inside a cell. The default display is “General” but selecting the drop-
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down box allows for many more options for the user to select depending on the cell conditions. 

 

Cell Format Function 

General Any text or number will display in the cell as written. 

Number This allows the user to only display numbers in this field and specifies the 
number of decimal places. 

Currency Similar to Number format, this displays numbers in the cell and the number of 
decimal places and the chosen currency symbol (depending on the currency) 
for the user. 

Accounting Similar to Currency, Accounting lines up the decimal points in a column so the 
amounts are displayed with the same alignment. 

Short Date Displays a set of numbers as the date, beginning from the year 1900. For 
example, the number “1” is 1/1/1900 

Long Date Displays a set of numbers as the date, beginning from the year 1900. For 
example, the number “1” is Sunday, January 1, 1900 
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Cell Format Function 

Time Displays a set of numbers as the time, beginning from the year 1900. For 
example, the number “1.1” is 2:24:00 AM. 

Percentage Displays decimals as a percentage. For example, .2 = 20% 

Fraction Displays decimals as a fraction. For example, .2 = 1/5. 

Scientific Displays a number as a scientific calculation, for example, .2 = 2.00E^-1 
Text Displays the cell information exactly as entered even if a number is displayed. 

 

In addition, students can select more formatting options by selecting the diagonal arrow  for more 

customization.  Below the formatting, the box is some quick shortcut icons  that allow the 

user to quickly format a cell with the Accounting ($), Percentage %, or to add a comma “,” to numbers 

that have the thousandths place. Finally, to the right of the shortcut icons are decrease indent and 

increase indent icons . These options allow the user to specify how much numerical detail to 

place in a cell. As an example, our cell currently contains the numbers 2.1345 as a repeating number 

which means the decimal will continue to infinity. The cell information goes to the fourth decimal 

because it was formatted this way by the user (the user can decide how many decimal places to display). 

By decreasing the indent to the left  the number rounds the last decimal up or down depending, and 

only displays the next decimal place. In the case of this example, 3 decimal places. Therefore, the new 

number is 2.135 because excel rounded the fourth decimal up. By decreasing the indent to the right, 

 more decimal places will be displayed, and the number becomes 2.13452. 

Styles Group 

 

The Styles Group allows the user to use some predetermined styles consisting of fonts and colors to 

determine the appearance of the cell. Conditional Formatting allows the user to program Excel to 

change the color of selected cells based upon the conditions in a cell. 

Selecting Conditional Formatting will launch a drop-down menu allowing the user to customize the 

specific conditional formatting. 

Conditional Formatting 
When preparing a large financial report, and excel user may want to make specific cell ranges more 

recognizable to focus the attention of their audience; perhaps they would like to highlight specific areas 
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indicating profits visually and also showcase areas of financial losses another. The user can use 

Conditional Formatting to have Excel automatically label or create graphics for cells based upon 

properties they specify. 

 

Selecting Highlight Cell Rules will apply the specific cell shading to selected cells with values either 

greater than, less than, between, equal to, the text contains, or a specific date, or duplicate values. Once 

the specific measure is selected, a new dialog box will launch allowing the user to input their specific 

value and the cell shading color that would be associated with it. 
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Highlight Cell Rules: Typically, an Excel user would utilize Highlight Cell Rules to program Excel to 

display certain cells to stand out to the user. For example, a CFO may use conditional formatting to 

program cells with negative balances to be colored red to stand out to their boss. 

Top/Bottom Rules: These selection options allow the user to highlight the Top 10 items in a list, the Top 

10%, Bottom 10 items, Bottom 10%, Above Average, and Below Average. In addition, any custom rules 

can be created as well. 

Data Bars: Once the user has set rules for Conditional Formatting, Excel allows for multiple ways to 

display the data. Using the Data Bars feature of Conditional Formatting, users can create a fill a cell with 

a chosen color that fills relative to the data in the cell. For example, for the purposes of simplicity, a user 

could have two data points in two different cells, 50 and 100. Using the Conditional Formatting with 

Data Bars, the user can create a visual that compares the two data points in the cells visually. The 

number “50” makes the cell appear half-filled, while “100” fills the entire cell.  Colors can be changed.

 

The user can always program the data bars to calculate differently by selecting the last option in the 

drop-down menu, More Rules. 

Color Scales: In addition to Data Bars, the user can determine multiple color gradients to appear in cells 

based upon the Conditional Formatting rules. The cell can be shaded completely, or outlined depending 
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on the user’s preferences. Like Data Bars, the user can always provide more detail as to what data is 

displayed in the Color Scales by selecting “More Rules”. Below the gradient options. 

 

Icon Sets: In addition to colors, Excel users can display specific images or symbols in cells based upon 

their parameters and the data in the cell.  There are a variety of arrows and shapes that can be 

associated with cells. 

 

Using the previous example of placing “50” in one cell and “100” in the one below it, using Icon Sets, the 

user can place pictures (such as arrows) in the cells to indicate their value with or without the shading 

properties from the data bars. In addition to the multiple graphic options, users can create custom rules 

by selecting the “More Rules” field in the Icon sets drop-down menus to determine how each cell 
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appears. Depending on the rules established, the arrows, shapes, indicators or ratings will change. 

 

Format as Table: 
While Excel is organized to present information in a grid-like table, the cells can be more precisely 

configured to be organized into a separate table format. To set up a table, select the cells that will 

compose the table and click the “Format as Table”  icon in the styles group. A drop-

down arrow will launch a variety of table shading styles to select in terms of color and gradient (Light, 

Medium, and Dark). Formatting the table will allow for each row to be shaded in alternating colors to 

best differentiate the rows, and a header row will be placed at the top of the table. The header row 

allows the user to label the data in each column and also perform a variety of data sorting activities. 

By clicking on the downward arrow  on the right of the header row cell, a drop-

down box will launch a variety of data manipulation options.  Users can sort the data in that row from 

smallest to largest, largest to smallest, sort by color (if using conditional formatting), filter by color, and 

create filters for numbers in a cell. Filters only display text that the user specifies. For example, in a table 

with multiple numbers ranging from 1 to 10, filtering numbers “1” and “3” will only display those 

numbers in the table. The rest of the numbers will disappear until the user removes the filter, which is 

also located in the drop-down menu. In addition, the user can select the specific numbers to filter.

 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

149 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

Cell Styles 

The last option in the Styles Group is the Cell Styles icon. . Like Microsoft Word, Excel 

provides a number of preset styles with different colors and fonts. Instead of styles relating to 

paragraphs or sentences, they relate to individual cells instead. Selecting Cell Styles will load a drop-

down menu that provides a variety of cell shading options, different font and heading styles, and style 

themes in addition to number formats. Using styles allows the user to create standard cell properties 

across their document by using the same cell styles. 

 

Cells Group 

The Excel Cells Group allows the user to add, delete, or change specific cells. The 

Cells group does not format the information inside the cells, but rather the cells themselves. Selecting 

the Insert icon will launch a drop-down dialog box allowing the user to insert cells, rows, columns, or 

entire sheets into the workbook. The insert command is particularly helpful in Excel if the user wishes to 

enter new cell information between existing cells of data. When a new cell, column, or row is inserted, 

the default action is to move the other data down, or to the right of the insertion point depending on 
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whether a row or column was inserted. Information that is moved is maintained in its form, and any 

formulas associated with it are moved to the new relative cell location so calculations are correct. 

 

The Delete function performs in the opposite way compared to the Insert Command. It allows the user 

to Delete selected cells, rows, columns, or entire sheets. Users chose to perform this function to quickly 

remove sets of data that are no longer needed. 

 

Finally, the Format icon of the Cells Group allows for multiple adjustments to be made to specific cell 

properties. Cells can be adjusted for Row Height and Column width manually, or via AutoFit, which 

automatically sizes the row or column to be just large enough to fit the selected cell height or width. 

Hide & Unhide settings allow the user to hide selected rows or columns so that they do not display to 

the user. The data in the cells are still there but must be unhidden using this icon to display the data 

again. The Hide command is often used when presenting a spreadsheet and the workbook creator does 

not want to show the viewer all of the Excel calculations in order to keep the spreadsheet simple. When 

rows or columns are hidden, there will be a break in the alphabetical or numerical order of the column 

or row to show that there is hidden information. The organize sheets command lets a user quickly 
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rename, copy, move, or change the tab color of sheets in a workbook.

 

Protect Sheet & Lock Cell 
Imagine that you are distributing a budget with detailed figures on employee salaries to your 

management team. You are concerned that someone may decide to change the information in the 

budget and send it out to others. To prevent this from happening, you may decide to select the Protect 

Sheet icon. Using the Protect Sheet command, workbook creators can create a password to protect the 

sheet against unauthorized changes and prevent the user from making any number of changes to 

specific contents of a worksheet. Because this command is restricted to specific sheets, the user can 
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protect one sheet, and not others if they choose to. Once 

Protect Sheet is enabled with a password and specific actions are allowed or prevented, users can select 

the “Lock Cells” command beneath the “Protect Sheet” command to require a password before a user 

can make any changes to the cells that the user selected prior to clicking “Lock Cells”. If a user would like 

to unprotect the sheet and allow editing without a password, they can enter the password again in the 

“Protect Sheet” dialog box to unprotect the sheet. 

Editing Group 

 

The Editing Group allows the user to manipulate data inside each cell using the AutoSum, Fill, and Clear 

Commands as will as sort & filter and Find & Select. We will first review AutoSum. 

Autosum 
Let's go back to an example in a previous chapter. You are the owner of a construction company hiring 

three individuals to perform work for you. You have already used excel to calculate their weekly salary, 

but now you need more information; you need to know the total salary you expect to spend, the 

average salary, and the maximum and minimum salaries.  
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Now, using the AutoSum Icon and corresponding drop-down commands options, 

the user can allow excel to automatically calculate this information. 

Sum calculates the total numbers added together in a specified range.  Average calculates the value of 

the cells added together in a specified range divided by the number of cells in the range. Count Numbers 

provides the number of cells selected in a range. Maximum provides the highest number in a selected 

range, and Minimum provides the lowest number in a range. While these numbers automatically 

include the cells above them, the user can specify in the Excel Formula Bar the correct ranges if needed. 
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Fill Command: 
In addition to using AutoSum, the Fill Command allows the user to continue a pattern of cell number, or 

copy the contents of one cell to the next cell in any direction. This could help when the user is creating a 

numbered list or needs to enter the same data points in many cells. The 

Down, Right, Up, and Left Fill commands copy data from one cell to the next cell. Selecting the Series 

menu allows the user to select multiple methods for a cell to increase in value. Users can specify how 

much the cell increases and by what value, and whether the information increases in rows or columns. 

When the user is ready to fill cells, they should highlight the first cell (which has the starting number) 

and select the “Fill” icon on the menu, and select “Series”, and place the step value and the stop value 

(when the series should end) and click “Ok”. Their highlighted cells will then display the series in the cell. 
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This feature is especially helpful when creating numbered lists. 

 

Clear Command 

The Clear Command removes formatting and cell contents from selected cells.  Once the 

Clear command is selected, a drop-down menu of options emerges with Clear All, Clear Formats, Clear 

Contents, Clear Comments, Clear Hyperlinks, and Remove Hyperlinks (if Hyperlinks are present). 

 The Clear All will remove all of the contents and formatting of the selected 

cells. This allows the user an easy way to delete information without accidentally moving other data into 

other columns or rows. Clear Formats removes any formatting (like Bold or Italics) applied to any of the 

select cells. Clear contents only clear the information inside the cell, not the formatting or cell settings. 

Clear Comments removes Comments from other users but not the Cell Contents, Clear Hyperlinks 

remove the hyperlinks from the Cell, but keeps the text, and Remove Hyperlinks removes all text and 

link from the applicable Cell. 

Sort & Filter 
One of the powerful features of Excel is to be able to analyze data. One way to analyze data is to sort it 

by specific fields. The Sort & Filter/feature in Excel allows the user to perform this action. To use the Sort 

& Filter process, select a cell, and then click on the Sort & Filter menu. A drop-down menu of options will 

emerge, allowing the user to Sort from Smallest to Largest, Largest to Smallest, Custom Sort, Filter, Clear 
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a previous Sort & Filter, and Reapply a Cleared filter. . Smallest to largest 

moves all other columns in Excel to be in order with the smallest number in the selected column to be 

displayed first. Sort Largest to Smallest is the opposite, Custom Sort allows the user to apply multiple 

sort levels to the document. 

 

Find & Select 
Finally, the Find & Select Menu of Excel allows the user to find or replace text, numbers, formulas, 

comments, or other data in any cell. Selecting the Find & Select Icon   will launch a drop-down 

menu which allows the user to find items, or replace one word or number with another in the entire 

worksheet. In addition, special search parameters (formulas, comments, conditional formatting, 

constants, and data validation are also parameters that can be used. 
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Checking for Understanding 
1. You have been asked to track department spending for your unit for the month. Please create a 

budget with the following headings:   

Item Category Number 
Purchased 

Cost per item Total Cost Percent of 
Total spent 

Now, also calculate the totals, maximum and minimum spend amounts using the AutoSum feature.  All 

amounts are only in dollars, not cents. 

2. Once your budget has been created, use conditional formatting to highlight any number under 

$500 in Red. 

3. On your next sheet, please create a spending tracking report with the A column cells being 

numbers from 1-100 using autofill. In addition, change the name of Sheet2 to “Spending” and 

change the color of the tab to blue. 
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Chapter 16 Using Insert Tab 
Similarly to Microsoft Word, the Insert Tab of Excel allows the user to place multiple objects and 

information into their worksheet.  

 

The Insert Tab Consists of grouped functions: Tables, Illustrations, Add-Ins, Charts, Tours, Sparklines, 

Filters, Links, Text, and Symbols. 

Tables Group: 

As previously described, Tables are used in excel to easily select and 

sort information. Excel allows the user to use tables (which allow for basic functions) and pivot tables, 

which are used to create the summary reports of large data sets with the built-in calculation, and we 

have the option to make our own calculation. Tables make it easy to sort, filter and format the data 

within a sheet. Excel even has a Recommended PivotTables option to automatically create Pivot Tables 

based upon the data provided in the highlighted cells.   

To create a Pivot Table, select a cell within the table of data you wish to use. Then select Pivot Table. 

You may also use Recommended Pivot Tables for some predetermined templates. Regardless of which 

option you choose, the Pivot Table Wizard will launch and automatically select the data associated with 

your table that will be available in the Pivot Table. In addition, the user can select to add the Pivot Table 

in their current worksheet or a new worksheet. Once you have selected specific properties associated 

with your Pivot Table or selected the default options, click “ok” to create the Pivot Table. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-316.png
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By default, the PivotTable Fields will be displayed in the upper left-hand corner. The user can select the 

appropriate column and determine whether it should be listed in a column, row, or values view. This 

flexibility allows the user to explore interrelationships between multiple data sets. While performing 

complex PivotTable calculations is outside the scope of this course, it is important to understand the 

purpose of Pivot Tables. 
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Illustrations Group 

We use this option to insert the Pictures, Online Pictures, Shapes, 

SmartArt and Screenshot. It means if we want to insert any image, we can use Illustration feature. 

Selecting the Pictures icon  will allow the user to import their own picture file into Excel. Selecting 

Online Pictures  will launch an Excel Online Bing Search tool to search for any picture using Bing that 

has a Creative Commons license that permits its free use in a document. 

 

Once a picture is inserted into excel, it will be displayed on top of the cell and cover any contents in a 

cell. The picture can be manipulated with the same Picture Format tools when selected as Microsoft 

Word. For more information on adjusting picture properties in Microsoft Office, please visit  Inserting 

Pictures in Chapter 12. The picture size can also be adjusted by selecting the edges of the picture and 

dragging resizing them to the preferred size. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-415.png
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Add-ins 

 

Like Microsoft Word, Excel provides the user the option to insert Add-In Applications that operate inside 

of Excel to expand the functionality to the user. The default options automatically added are Bing Maps 

and People Graph. Depending on your Office 365 subscription or Excel license, your use of Add-ins may 

be limited. Users can download more add-ins by selecting the Get Add-ins icon. 

  

Charts 

Charts are one of the key uses of excel when there is a need 

to display numerical information graphically. In Excel, users can insert a variety of charts: Column, Bar, 

Radar, Line, Area, Combo, Pie and Bubbles chart. If the user doesn’t know what kind of chart to use, the 

can select “Recommended Charts” and Excel will automatically insert a chart from the data selected.  To 

create a chart, select the range of cells to be included in the chart. You may include the header columns 

and rows if desired. Once the data is selected, simply select the preferred chart type and Excel will 

automatically create a chart. 

https://www.exceltip.com/wp-content/uploads/2015/07/image-66.png
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Types of Charts 
Excel contains a variety of charts for users to utilize to display data visually to others. Each Chart has a 

specific utility depending on the types of data. All charts can be customized by selecting the chart and 

using the Design and Format tabs which will be described later.  

Pie Chart: A Pie Chart can only display one series of data. A data series is a row or column of 

numbers used for charting. Excel uses the series identifier (column or row heading) as the chart title and 

displays the values for that series as proportional slices of a pie. If we had selected multiple series of 

data, Excel would ignore all but the first series. There are sub-types of the Pie Chart available. The 

second chart below is the Pie Chart in 3-D and the third chart is an Exploded Pie Chart; an Exploded Pie 

in 3-D is also available. 

Column Chart: The Column & Bar Charts  shows the comparison of one or more series of data 

points. But the Clustered Column Chart is especially useful in comparing multiple data series. In a 

Column Chart, the vertical axis (Y-axis) always displays numeric values, and the horizontal axis (X-axis) 

displays the time or another category. And by default, Excel will always plot the category (row or column 

heading) that contains the most entries on the horizontal axis (X-axis). One variation of this chart type is 

the Stacked Column Chart. In a Stacked Column Chart, the data points for each time period are 

"stacked" instead of "clustered." This chart type lets us see the percentage of the total for each data 

point in the series. Also available is the 100% Stacked Column Chart, where each value in a series is 

shown as a portion of 100%. An example of a 100% Stacked Chart is shown in the section on Bar Charts. 

All the Column Charts have a version in which the columns display in three-dimension - as illustrated by 
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the 3-D Stacked Column Chart above. But one chart, the "3-D Column Chart," is special because the 

chart itself is three-dimensional - displaying multiple series on the X-axis, Y-axis, and Z-axis. The first 

chart below is a 3-D Column Chart of our data series. 

The Bar Chart: The Bar Chart is like a Column Chart lying on its side. The horizontal axis of a Bar Chart 

contains the numeric values. The first chart below is the Bar Chart for our single series, Flowers. When 

to use a Bar Chart versus a Column Chart depends on the type of data and user preference. Sometimes 

it is worth the time to create both charts and compare the results. However, Bar Charts do tend to 

display and compare a large number of series better than the other chart types.  

Line Chart & Area Charts: The Line Chart  is especially effective in displaying trends. In a Line Chart, 

the vertical axis (Y-axis) always displays numeric values and the horizontal axis (X-axis) displays the time 

or another category. You may choose each Line Chart type with or without markers. Markers are circles, 

squares, triangles, or other shapes that mark the data points. Excel displays a unique marker - different 

shape and/or color - for each data series. Besides the Line Chart, we have the Stacked Line Chart and the 

100% Stacked Line Chart - with or without markers.  

Area Chart: The Area Chart is very similar to a Line Chart with the addition that underneath the trend 

line is solid. Area Charts are used primarily to show trends over time. There are three charts available: 

the Area Chart, the Stacked Area Chart, and the 100% Stacked Area Chart. Each of these charts come in 

2-D format and in true 3-D format with X, Y, and Z axes.  

The Scatter Chart: The purpose of a Scatter Chart  is to observe how the values of two series 

compare overtime or another category.  Scatterplots are similar to line graphs in that they use 

horizontal and vertical axes to plot data points. However, they have a very specific purpose. Scatter 

plots show how much one variable is affected by another. The relationship between two variables is 

called their correlation." 

 

The series pair has a Positive Correlation if they increase similarly, and a Negative Correlation if they 

both decrease in like manner. Otherwise, they have No Correlation. The Scatter Chart comes in several 

different formats: markers can indicate the data points, and the points can be unconnected or 

connected with smooth or straight lines. Finally, there are many other types of Charts Excel provides for 

the user that are not described in detail in this book. The user can click on the More options arrow  in 

the Chart Group to view all of the Chart options available to the user. 
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Chart Design 

 

 Once you have inserted a Chart, there are many options available to customize it. Users can select 

Design Tab (it only appears when you have first selected a chart) and have the option to choose from a 

variety of Chart Styles, to adjust the data or change the chart type, or add many already created quick 
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layout elements, such as field labels or specific text properties. Users can also change the colors of the 

chart, or move the chart location. The most comprehensive feature to chart design is the Add Chart 

Elements icon that launches a drop-down menu with common chart customization features depending 

on the chart selected. 

The Chart Data Group allows the user to toggle the row and column axis, and customize the data being 

reported by clicking on the Select Data icon. Once the Icon is clicked, a new dialog box will launch and 

allow the user to customize the data used. 

 

 The Chart Data Range is the first customizable field. You can use it to select the data included in the 

chart. You can do so by manually typing in the data, or selecting the data by clicking on the specific 

range of cells to be included. The user can also edit the specific columns of data to be included (or not 

included) in the chart by selecting the Legend Entries (Series) on the left-hand side and also adjust the 

Horizontal Category Axis Levels on the right. Users can explore these customization options. If they ever 

think that they made a mistake, they can always select the Cancel button to not save the changes. 

Selecting OK saves the changes to the chart. 

Chart Format 
The Chart Formatting Tab also is available when you select a chat that you have created. The Format tab 

allows the user to insert shapes and lines in a chart, change the outline styles, and change the size of the 

Chart. 
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The first grouping, Current Selection allows the user to adjust the Chart Border and fill settings. While 

the default settings to adjust is Chart Area, any number of aspects of the chart can be adjusted. Hape 

 

Next to the Current Selection Group is the Insert Shapes group. A wide variety of shapes, lines, boxes, 

and emojis can be inserted into the chart. Clicking the downward arrow in the menu of options will 

provide the user with even more options. In addition to shapes, new text boxes can also be inserted. 

’ 

To the right of the Insert Shapes Group is the Shape Styles group. Shapes styles allow you to adjust any 

color or visual effect of the chart. You can choose presets for background fill of your chart, or choose 

your own color with the paint can icon. You can also adjust the border for the chart with the Shape 

Outline icon, and any transparency effects with the Shape Effects icon. 

 

The next group, Word Art Styles focuses on text effects. 

The user can choose from a variety of Word Art styles, 
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or make their own with various Text Fill, Text Outline, and Text Effects. There is so much customization 

available to charts in Excel that it is possible that no two charts ever created are completely the same. 

Finally, the Arrange & Selection Groups allow the user to change the shape of the chart and select 

between multiple charts.  If 

eligible, a chart can be rotated, and also aligned to other charts or data on the excel spreadsheet. 

Sparklines 

 

Sparklines are very small graphs or charts that exist within a cell. They are usually entered as a quick 

visual reference or representation of numerical data. There are three types of Sparklines available: Line, 

Column/Loss. Line & Column Sparklines provide the same type of visual reference of information as 

charts. Win/Loss Sparklines show an upward-facing chart for positive values and a downward-facing 

chart for negative values. To add a sparkline to a cell, highlight the cells in which you want to use their 

data to create a sparkline. Then click on the icon corresponding to the type of Sparkline you would like 

to create. Once selecting the Sparkline, a Sparkline dialogue box will appear, allowing you to select or 

change the cells to be used to generate the Sparkline and a cell to select to insert the Sparkline. When 

all data is entered, click OK and the Sparkline  will be inserted in the appropriate cell.

 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

168 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

 

Sparkline Design Tools 
After a Sparkline is created, the user can adjust some of the design elements of the Sparkline by 

selecting the cell and then navigating to the Design Tab in the Excel Ribbon. 

 

Using the Design tools, users may edit the Sparkline Data, change the type of Sparkline, and select 

whether to display different points/stages of data in the sparkline. Users may also adjust the Sparkline 

color. 
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Filters 

 

The filter group contains controls for Slicer and Timeline Filters. These are associated with Pivot Tables. 

Inserting a Timeline or Slicer allows the user to place visual controls to be associated with a Pivot Table 

to change the data being displayed.  Since this book does not go into detail in Pivot Tables, this will be 

the extent of the information shared on this subject. 

 

Links: 

The link command allows the user to create a link in the document to another location, or 

another document, or a website to quickly access other content. Clicking on the Link icon will 

display a box to create a connection to another file or location. 

Text: 

 

The Text Group allows the user to insert a number of objects into an Excel document to make it more 

visually appealing and easier to understand. The Text Box command allows the user to insert a textbox 

anywhere on the document. The Header & Footer command allows for the user to place a document 

header (usually a title) on a worksheet and a footer (such as the date) on the bottom of the document. 

The Header and Footer views are visible on the Page Layout view.  Selecting Header & Footer launches 

the Header & Footer Design view, which allows for many customizations to the document. 
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In the Design Tab, both Header & Footer display a large number of drop-down menus to allow the user 

to choose a number of pre-populated fields pertaining to the document. In addition, users can insert 

page numbers, the number of pages, Current Date, Current Time, the File Path, File Name, Sheet Name, 

and Picture. In addition, users can specify what pages should relate to the Header & Footer and align the 

Header/Footer with the page that will be printed. 

 Symbols Group: 

We use this option to insert the symbols and equations. The equation is used to insert 

the common mathematical equations to your document and also we can add equation by using the 

mathematical symbols. We use Symbols to insert the symbols which are not on the keyboard and, to 

create the equation, we use the symbols from here. Once an equation is inserted, by clicking on the 

Equation that was inserted, the Design Tab of the Ribbon will launch. 

 

The Design view for equations allows for much more customization of an Equation, as well as inking and 

mathematical calculations. 

Checking for Understanding 
1. You are tracking monthly sales for your parts and equipment company in 2019 and 2020. Your 

monthly sales are as follows with 2019 displayed first followed by 2020: 

a. January: 2400, 2670 

b. February 3300, 3100 

c. March 2700, 1900 

d. April 1900, 1920 

e. May 2700, 2450 

f. June 2650, 3200 

g. July 3200,1700 

h. August 1700, 1650 

i. September 1560, 1649 

j. October 1890, 1919 

k. November 2100,2400 

l. December 3400, 3600 

Please create an excel document with the following Table Columns: 
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Month 2019 
Sales 

2020 
Sales 

Sparklines 

 

Format your information as a table, and insert a Bar Chart Displaying the monthly profits in dollars. In 

addition, create a totals row to add the total profits. 

2. Create a Pie Chart to measure each month of sales in relation to the whole. Add an Image 

pertaining to Sales next to the chart. 

3. Place a document header & footer on the worksheet. The Header should be “Monthly Parts 

Sales”. The Footer should be the Date. 
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Chapter 17: Page Layout, View & Review Tabs 
The Page Layout, View, & Review Tabs allow you to create views for your document to make your 

workbook easier to understand and navigate for the user. 

 

Page Layout Tab 
The Page Layout Tab allows the user to control the visual appearance of the worksheet when it is 

printed. The Page Layout Tab consists of five major groups: Themes, Page Setup, Scale to Fit, Sheet 

Options, and Arrange. 
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Themes Group: 

 

Microsoft Excel provides a variety of themes- fonts, colors, and backgrounds that go together to make 

Excel very customizable and visually appealing to the viewer. If none of the stock Excel themes interest 

the user, they can always make their own theme by customizing the Colors, Fonts, and Effect icons to 

the left of the Themes Icon .  

Page Setup Group 
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Users can select the Margins icon if they wish to print their worksheets. Margins allow the user to 

specify how close to the top, bottom, left, and right of the printed page cell information is placed. 

Narrower margins allow more information to be placed on a printed page, wider margins will contain 

less information. The Orientation icon allows the user to determine whether the worksheet is created in 

a portrait or landscape view. Portrait orientations are best suited when a worksheet contains many rows 

of data, as the orientation provides more vertical room. Landscape orientation is best when a document 

has more column views. The Size icon allows the user to set up their worksheet 

page height and width relative to the paper size they wish to print in Excel. For example, if the user 

selects Tabloid, Excel will allow more room in a worksheet to match the print area of the larger 

document (11” X17”). 

If a user would like to create a custom area on their excel document that they would like to print, for 

example- they have created charts that correspond to a table, but they only want to print the charts 

from a worksheet, they can select the cells they would like to print and then select the Print Area icon. 

They can also remove the print area by selecting the same icon and then clicking on Clear Print Area. 

Excel Users may also create custom page breaks and separate sections of their worksheet by selecting 

the Breaks icon. After selecting the cell where they wish to be the top right corner of the second page, 
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they should click on the Breaks icon  If a user wishes to remove the Page Breaks, they can select the 

Breaks icon again and click on Remove Page Break. A user may also insert a background image into their 

worksheet by selecting the Background Icon. When selected, Excel will allow a user to find an 

image online using Bing Search, search their OneDrive Account for a picture, or find a picture on their 

computer. 

 

Once an image is inserted, the icon changes to Delete Background , allowing the user to delete the 

image from their worksheet. Finally, Print Tiles provides the user with many options to best 

display your worksheet on a printed page. When selected, Print Tiles will launch the Excel Page Setup 

menu, which allows the user to select the Print Area, Rows to repeat at the top of each page, columns to 

repeat on each page on the left, and whether to print Gridlines, Comments, Row and Column Headings, 
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and the order or the worksheet will print. 

 

Using the Page Setup menu, users can also adjust the Header/Footer text, the Margins, and the Page 

Settings, which provide a number of formatting changes that have already been discussed. On the Page 

tab,  a few help options for printing are the  Fit to settings which allow the user to specify how many 
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total pages should be printed for their worksheet. A commons choice is to fit 1 page. 

 

Scale to Fit Group 

 

The Scale to Fit group provides similar controls to the Page Setup menu. Users may determine the page 

width and height to specify how many pages in a worksheet to print, depending on the settings selected 

for Width and Height, the Scale percentage box will adjust. Selecting the more options arrow,  will 

launch the Page Setup menu again. 
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Sheet Options Group 

The Sheet Options group allows the user to control whether they can view 

gridlines and headings in their worksheet on their computer screen and/or on the printed page.  The 

Arrange icon is used to manipulate images to allow them to be aligned with cells or appear on top of or 

behind other cell information. Objects can also be rotated and placed in groups. 

 

View Tab 
The View Tab controls how information is displayed to the user. It allows the user to customize their 

workflow and make the document easy to understand to the user. It also allows for the creation of 

Macros, which are recorded combinations of commands that allow the user to create “buttons” to 

perform complex commands and functions at once. The View Tab is divided into five groups: Workbook 

Views, Show, Zoom, Window, and Macros. 

 

Workbook Views Group 

 

The Workbook Views Group allows the user to toggle between common spreadsheet views in Microsoft 

Excel. The Normal view is the default view and provides information just the cell views in a spreadsheet. 
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The Page Break preview displays a visual of what the document looks like if printed. A visual of this view 

is provided below. You cannot edit your document in Page Break Preview.

 

Page Layout View allows the user to determine what their document would look like if printed as well, 

but with the opportunity to edit your document and insert page breaks. Finally, Custom Views allows 

the user to create specific views and save them. 
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Show Group 

 

The Show Group has just four setting toggles to control the visual appearance of the worksheet. The 

Ruler checkbox displays or hides the Ruler in the Page Layout View. A picture of the ruler is below.

 

Gridlines are the boxes around each cell. Unchecking this box will remove all lines from cells. The cells 

will remain. The Formula Bar  can be checked and 

displayed or hidden. Finally, unchecking the Headings box will remove the numbered rows and lettered 

columns from the sheet view. 

Zoom Group 

 

The Zoom Group allows the user to adjust how close each cell will appear in size on in the worksheet. 

The Zoom icon allows the user to customize the magnification of Zoom using presets or creating a 

custom preset. The Fit selection radio box allows to enlarge and center a selected range of cells.

The 100% icon allows the Zoom to be returned to the default view while 

Zoom to selection allows for the user to magnify the selected cell or range of cells. 
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Window Group 

 

The Window Group allows the user to customize their worksheet view to display the same worksheet in 

multiple ways to be as efficient as possible. The New Window icon allows the user to have multiple 

open windows for the same document so they can work in different areas of the Worksheet at the same 

time. For example, perhaps you want to work on a table of data at the top of the worksheet and charts 

based upon the data at the bottom of the worksheet. By creating a New Window, you can view multiple 

places in the same worksheet at the same time. By clicking on Arrange All, the user can display these 

worksheet views side by side and by selecting the icon Switch Windows, select between them.  

Freeze Panes can be a very helpful way to view data when working with a large dataset. As an example, 

imagine that you are working with a long list of sales data. When entering data in new rows, you are no 

longer able to see the top header rows.  To ensure that you are able to view the top header rows, the 

Freeze Panes icon allows the user to Freeze either the Top Row, the First Column (for worksheets with 

many columns, or freeze a specific cell location so that all cells above it is does not move when scrolling. 

 

The Split Icon allows very similar functionality to the New Window command, except that the Split 

Command allows the user to specify the location for the split. Any row above the Split line will be 

displayed above, and any row below the split will be displayed in the same worksheet below. Each area 
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receives its own scrollbar.  Notice in the picture below how row 4 is displayed in both split views.

 

The Hide command  allows the user to hide their workbook to not display to the user, while 

unhide allows the worksheet to become visible again.  To hide specific rows or columns, right-click on 

the row or column you wish to Hide and select the Hide command. You can determine which rows or 

columns are hidden because they are no longer presented in chronological order. 

. To unhide a column, click on both rows or columns and select Unhide. 

The last commands in the Windows Group View Side by Side, Synchronous 

Scrolling, and Reset Window Position are used when using the New Window command to display the 

same document in multiple views. These commands allow the document to be viewed next to each 

other, to sync the scrolling so each window moves at the same time, and bring the window position back 

to its default setting. 
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Macros 

An Excel Macro is a piece of programming code that runs in an Excel environment and helps 

automate routine tasks. A macro is an excel task recording and playback tool. You simply record your 

Excel steps and the macro will play it back.  Let's say you work as a cashier for a water utility company. 

Some of the customers pay through the bank and at the end of the day, you are required to download 

the data from the bank and format it in a format that meets your business requirements. You can import 

the data into Excel and format. The following day you will be required to perform the same ritual. It will 

soon become boring and tedious. Macros solve such problems by automating such routine tasks. Macros 

will be covered in a later chapter of this text for advanced users. 

Review Tab 

 

The Review Tab allows your document to be inspected to make sure it is as professional and accessible 

as possible. In addition, it contains many collaboration features that allow users to work together. The 

Review tab contains the Proofing, Accessibility, Insights, Comments, Changes, and Ink Groups to make 

your document the best it can be. 

Proofing Group 

 

The Proofing Tab allows the user to check heir worksheet for spelling errors, and research synonyms 

available for selected words and launches a Thesaurus toolbar on the right of the screen. The Proofing 

Tab checks the current active worksheet for errors. 
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Accessibility Group 

The Accessibility Tab holds one icon- Check Accessibility. Selecting this icon will cause Excel 

to review their active worksheet t determine if it is readable and accessible for individuals with sight 

impairment. It will also review any images inserted in the document to make sure that they contain Alt-

Text which screen readers use to describe the Image. The Accessibility Checker will launch a window on 

the right side of the screen to suggest strategies to make your document more accessible. 

Language Group 

Like the Accessibility Tab, the Language Tab contains one icon: Translate. Selecting this icon 

will launch the translator feature of Excel on the right side of the screen. Users can enter the text they 

wish to translate into another language. 
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Comments Group 

 

The Comments group allows for opportunities to collaborate with other users on the same document. 

Users can add comments about the document that is unavailable to view with Excel and are usually not 

printed when the worksheet is completed. Users can also use the controls in this area to delete 

comments, hide comments, move to the next comment and previous comment. 

Changes Group 

The Changes group allows the user to determine 

who may or may not make changes to the document. By default, only the user with the file may edit the 

workbook. However, the workbook or worksheet can be protected even if the file is shared with the 

Protect Sheet or Protect Workbook function. If the user decides that their worksheet or workbook must 

be protected they will select the applicable command, and an additional options window will launch. 

Users can specify whether others may view or edit various 
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aspects of their document and create a password to protect the sheet. Only by entering the password 

can the user receive full editing access to the document. 

In addition to protecting their work, users may elect to share their workbook with others who have a 

OneDrive account for realtime document collaboration- allowing multiple users to work on a document 

at the same time. The user can even decide which parts of the document they are able to edit by 

selecting the Allowing Users to Edit Ranges icon. Finally, users can Track the Changes made to the 

document and also review changes that have been made using the Track Changes icon, which will 

launch a dialog box with more options. Tracked Changes are helpful 

when working with others on a document and to be able to see the changes made (additions, deletions, 

formatting, etc) made by other users. 

Ink Group 

Finally, users can draw with their mouse onto their document with the Ink Group. Users 

can draw on charts and images, and Hide all of their inkings as well. Using Inking can be helpful when 

making a presentation. 

Check for Understanding 
1. You are tracking monthly sales for your parts and equipment company in 2019 and 2020. Your 

monthly sales are as follows with 2019 displayed first followed by 2020: 

a. January: 2400, 2670 

b. February 3300, 3100 

c. March 2700, 1900 

d. April 1900, 1920 

e. May 2700, 2450 

f. June 2650, 3200 

g. July 3200,1700 

h. August 1700, 1650 

i. September 1560, 1649 

j. October 1890, 1919 

k. November 2100,2400 

l. December 3400, 3600 

Please create an excel document with the following Table Columns: 
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Month 2019 
Sales 

2020 
Sales 

Total 
Sales 

2. Using the data you entered, perform the following: 

a. Add a Theme to the Chart 

b. Change the Margins to .5 inches 

c. Make the document Landscape 

d. Add a Background Image of a Tool of your choice to the worksheet. 

e. Make sure your document is printing gridlines 

f. Freeze the Header Rows 

g. Add a comment to your document 

h. Run Accessibility Tracker 

i. Protect your sheet with a password. 

 

Chapter 18: Formulas Tab 

 

Formulas are the heart and soul of excel. Formulas used in Excel provide users to perform many 

complicated and complex calculations and tasks to manipulate data as needed. While this text will not 

provide an exhaustive list of how to use each formula, by providing an overview of each of the functions, 

the user can begin to learn on their own how to specialize in the hundreds of formulas that Excel 

provides, or make their own. The Formulas Tab is divided into five groups: Insert Function, Function 

Library, Defined Names, Formula Audint, and Calculation. 

Insert Function (or Introduction to Formulas in Excel) 

Since Excel is an object-oriented program (meaning that calculations must be completed in a 

physical location, before inserting a function, the user must select the cell they would like to add a 

formula to. For the purposes of this illustration, I will select the cell “C2”. When I select the Insert 
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Function icon, an equals sign “=” is displayed in cell C2, and an Insert Function control panel is displayed. 

 

Using the Insert Function control panel, I can either navigate to the type of function I would like to use, 

or I can search for a function. For the purposes of this example, I would like to add the numbers “2” and 

“3” which are located in cell “A2” and “B2”. I search “add” because I want to add the two numbers 

together. Excel provides the “SUM” function as the option I think it wants. It also displays the formula 

that would be used  along with a description of what it does. I agree 

with Excel that this is what I want to do, and click “OK”. Now a Function Arguments dialog box launches 
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so I can correctly place the cells I would like to use in the equation. 

 

Because I had the cell selected (C2) where I wanted the sum of A2 and B2 to be, Excel automatically 

placed the cell range to be added together in the Number1 area. It also shares with me the numbers in 

those two fields and what the answer would be. If I was adding multiple cells in different areas together, 

I could use the Number2 and Number3 fields as well. When I begin to enter a cell in Number3, another 

field will be created (Number4). When I think my calculation and formula are correct, I press “OK”. 

 

Notice that the number “5” is correctly added in C2, and in the cell, the formula is shown in the formula 

bar.  If I know the formula, I can also enter it manually via the keyboard into the formula 

bar as well. Remember to place a “=” sign first, and then the formula command, followed by the cells 

selected in brackets (). While this is a simple example, regardless of the complexity, formulas work the 

same.  

Why not just add the numbers and not the cell locations? 
To extend this example, I could place the same numbers in A3 and B3. This time, however, instead of 

using the cell references to add together, I could manually, just add the numbers together in  C3 as 

displayed below. 
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. While this will get me the correct data, it is risky 

to do this, because if the data ever changes in any of the cells, the answer will no longer be correct. For 

example, let's pretend that the Number columns corresponded to cars sold in February at an automotive 

dealership. Recently, they discovered a recording error, they did not sell just 2 and 3 cars, they sold 20 

and 30! Updating the calculation table leads to the following results. 

Row 2 has the correct sales numbers, but 

row 3 does not because the user used numbers instead of cell references. It is always wise in Excel to 

use cell locations instead of numbers, even if it means creating extra rows and columns. That way, if any 

of your data changes, Excel immediately can recalculate the information. This is also helpful for autofill. 

Autofill using formulas 
Another benefit of using formulas is the ability to use autofill. Autofill can use a formula previously used 

in one cell, and copy that formula for use in the cells relative to the new cell. To perform this action, 

select the specific reference cell you would like to use to copy the formula to the adjacent cells with 

Autofill. In the lower right-hand corner of the cell will appear as a “+” marker to use the fill handle. 
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Click on the marker and drag cursor to select the 

adjacent cells you wish to copy the formula. When all of the cells are included, release the mouse button 

and all cells will be auto-filled with the same formula. 

 

Relative vs Absolute Cell References 
There are two types of cell references: relative and absolute. Relative and absolute references behave 

differently when copied and filled to other cells. Relative references change when a formula is copied to 

another cell. Absolute references remain the same no matter where they are copied. 

By default, all cell references are relative references. When copied across multiple cells, they change 

based on the relative position of rows and columns. For example, if you copy the formula =A1+B1 from 

row 1 to row 2, the formula will become =A2+B2. Relative references are especially convenient 

whenever you need to repeat the same calculation across multiple rows or columns. 

However, there may be a time when you don't want a cell reference to change when copied to other 

cells. Unlike relative references, absolute references do not change when copied or filled. You can use 

an absolute reference to keep a row and/or column constant. An absolute reference is designated in a 

formula by the addition of a dollar sign ($). It can precede the column reference, the row reference, or 

both. 
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In addition, Excel allows you to refer to any cell on any worksheet, which can be especially helpful if you 

want to reference a specific value from one worksheet to another. To do this, you'll simply need to 

begin the cell reference with the worksheet name followed by an exclamation point (!). For example, if 

you wanted to reference cell A1 on Sheet1, its cell reference would be Sheet1!A1. If you rename your 

worksheet, Excel will automatically adjust the cell references to the new worksheet name. 

Function Library Group 

 

The Function Library Group allows the user to utilize all of the formulas in Excel. The function is 

automatically inserted in the cell that is selected.  

Auto Sum 

The first icon on the left is AutoSum  Autosum adds multiple cells together. After selecting 

Autosum, Excel intelligently guesses the range for your calculation based upon the cells around the 

insertion point. The user can change the cell location in the address bar. 

If the user wants other frequently 

used commands for multiple cells, they can select the more options arrow next to Autosum. A list of 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

193 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

options will generate. Average calculates the sum of all the 

selected cells divided by the number of cells selected to find the average. Count Numbers allows the 

user to quickly calculate the number of cells included. Max determines the largest number in the group, 

and Min calculates the smallest number. More Functions launches the Functions Arguments box to 

allow for more options to search for a function in all categories of Excel. 
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Recently Used 

The recently used icon allows the user to select functions they have used 

most recently in Excel. This is especially helpful when performing similar calculations. 

Financial 

Financial functions are used to calculate business equations such as interest, 

depreciation, and valuation. Information about the following functions is provided via 

support.office.com (anonymous, 2020). 

Financial Function Description 

ACCRINT function 

Returns the accrued interest for a security that pays periodic 
interest 

ACCRINTM function 

Returns the accrued interest for a security that pays interest at 
maturity 

AMORDEGRC function 

Returns the depreciation for each accounting period by using a 
depreciation coefficient 

AMORLINC function 

Returns the depreciation for each accounting period 

COUPDAYBS function 

Returns the number of days from the beginning of the coupon 
period to the settlement date 

COUPDAYS function 

Returns the number of days in the coupon period that contains the 
settlement date 

COUPDAYSNC function 

Returns the number of days from the settlement date to the next 
coupon date 

COUPNCD function 

Returns the next coupon date after the settlement date 

https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/accrint-function-fe45d089-6722-4fb3-9379-e1f911d8dc74
https://support.office.com/en-us/article/accrintm-function-f62f01f9-5754-4cc4-805b-0e70199328a7
https://support.office.com/en-us/article/amordegrc-function-a14d0ca1-64a4-42eb-9b3d-b0dededf9e51
https://support.office.com/en-us/article/amorlinc-function-7d417b45-f7f5-4dba-a0a5-3451a81079a8
https://support.office.com/en-us/article/coupdaybs-function-eb9a8dfb-2fb2-4c61-8e5d-690b320cf872
https://support.office.com/en-us/article/coupdays-function-cc64380b-315b-4e7b-950c-b30b0a76f671
https://support.office.com/en-us/article/coupdaysnc-function-5ab3f0b2-029f-4a8b-bb65-47d525eea547
https://support.office.com/en-us/article/coupncd-function-fd962fef-506b-4d9d-8590-16df5393691f
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Financial Function Description 

COUPNUM function 

Returns the number of coupons payable between the settlement 
date and maturity date 

COUPPCD function 

Returns the previous coupon date before the settlement date 

CUMIPMT function 

Returns the cumulative interest paid between two periods 

CUMPRINC function 

Returns the cumulative principal paid on a loan between two 
periods 

DB function 

Returns the depreciation of an asset for a specified period by using 
the fixed-declining balance method 

DDB function 

Returns the depreciation of an asset for a specified period by using 
the double-declining balance method or some other method that 
you specify 

DISC function 

Returns the discount rate for a security 

DOLLARDE function 

Converts a dollar price, expressed as a fraction, into a dollar price, 
expressed as a decimal number 

DOLLARFR function 

Converts a dollar price, expressed as a decimal number, into a 
dollar price, expressed as a fraction 

DURATION function 

Returns the annual duration of a security with periodic interest 
payments 

EFFECT function 

Returns the effective annual interest rate 

FV function 

Returns the future value of an investment 

FVSCHEDULE function 

Returns the future value of an initial principal after applying a 
series of compound interest rates 

INTRATE function 

Returns the interest rate for a fully invested security 

IPMT function 

Returns the interest payment for an investment for a given period 

IRR function 

Returns the internal rate of return for a series of cash flows 

ISPMT function 

Calculates the interest paid during a specific period of an 
investment 

MDURATION function 

Returns the Macauley modified duration for a security with an 
assumed par value of $100 

MIRR function 

Returns the internal rate of return where positive and negative 
cash flows are financed at different rates 

NOMINAL function 

Returns the annual nominal interest rate 

NPER function 

Returns the number of periods for an investment 

NPV function 

Returns the net present value of an investment based on a series 
of periodic cash flows and a discount rate 

ODDFPRICE function 

Returns the price per $100 face value of a security with an odd 
first period 

ODDFYIELD function 

Returns the yield of a security with an odd first period 

ODDLPRICE function 

Returns the price per $100 face value of a security with an odd last 
period 

ODDLYIELD function 

Returns the yield of a security with an odd last period 

https://support.office.com/en-us/article/coupnum-function-a90af57b-de53-4969-9c99-dd6139db2522
https://support.office.com/en-us/article/couppcd-function-2eb50473-6ee9-4052-a206-77a9a385d5b3
https://support.office.com/en-us/article/cumipmt-function-61067bb0-9016-427d-b95b-1a752af0e606
https://support.office.com/en-us/article/cumprinc-function-94a4516d-bd65-41a1-bc16-053a6af4c04d
https://support.office.com/en-us/article/db-function-354e7d28-5f93-4ff1-8a52-eb4ee549d9d7
https://support.office.com/en-us/article/ddb-function-519a7a37-8772-4c96-85c0-ed2c209717a5
https://support.office.com/en-us/article/disc-function-71fce9f3-3f05-4acf-a5a3-eac6ef4daa53
https://support.office.com/en-us/article/dollarde-function-db85aab0-1677-428a-9dfd-a38476693427
https://support.office.com/en-us/article/dollarfr-function-0835d163-3023-4a33-9824-3042c5d4f495
https://support.office.com/en-us/article/duration-function-b254ea57-eadc-4602-a86a-c8e369334038
https://support.office.com/en-us/article/effect-function-910d4e4c-79e2-4009-95e6-507e04f11bc4
https://support.office.com/en-us/article/fv-function-2eef9f44-a084-4c61-bdd8-4fe4bb1b71b3
https://support.office.com/en-us/article/fvschedule-function-bec29522-bd87-4082-bab9-a241f3fb251d
https://support.office.com/en-us/article/intrate-function-5cb34dde-a221-4cb6-b3eb-0b9e55e1316f
https://support.office.com/en-us/article/ipmt-function-5cce0ad6-8402-4a41-8d29-61a0b054cb6f
https://support.office.com/en-us/article/irr-function-64925eaa-9988-495b-b290-3ad0c163c1bc
https://support.office.com/en-us/article/ispmt-function-fa58adb6-9d39-4ce0-8f43-75399cea56cc
https://support.office.com/en-us/article/mduration-function-b3786a69-4f20-469a-94ad-33e5b90a763c
https://support.office.com/en-us/article/mirr-function-b020f038-7492-4fb4-93c1-35c345b53524
https://support.office.com/en-us/article/nominal-function-7f1ae29b-6b92-435e-b950-ad8b190ddd2b
https://support.office.com/en-us/article/nper-function-240535b5-6653-4d2d-bfcf-b6a38151d815
https://support.office.com/en-us/article/npv-function-8672cb67-2576-4d07-b67b-ac28acf2a568
https://support.office.com/en-us/article/oddfprice-function-d7d664a8-34df-4233-8d2b-922bcf6a69e1
https://support.office.com/en-us/article/oddfyield-function-66bc8b7b-6501-4c93-9ce3-2fd16220fe37
https://support.office.com/en-us/article/oddlprice-function-fb657749-d200-4902-afaf-ed5445027fc4
https://support.office.com/en-us/article/oddlyield-function-c873d088-cf40-435f-8d41-c8232fee9238
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Financial Function Description 

PDURATION function 

 

Returns the number of periods required by an investment to reach 
a specified value 

PMT function 

Returns the periodic payment for an annuity 

PPMT function 

Returns the payment on the principal for an investment for a given 
period 

PRICE function 

Returns the price per $100 face value of a security that pays 
periodic interest 

PRICEDISC function 

Returns the price per $100 face value of a discounted security 

PRICEMAT function 

Returns the price per $100 face value of a security that pays 
interest at maturity 

PV function 

Returns the present value of an investment 

RATE function 

Returns the interest rate per period of an annuity 

RECEIVED function 

Returns the amount received at maturity for a fully invested 
security 

RRI function 

 

Returns an equivalent interest rate for the growth of an 
investment 

SLN function 

Returns the straight-line depreciation of an asset for one period 

SYD function 

Returns the sum-of-years' digits depreciation of an asset for a 
specified period 

TBILLEQ function 

Returns the bond-equivalent yield for a Treasury bill 

TBILLPRICE function 

Returns the price per $100 face value for a Treasury bill 

TBILLYIELD function 

Returns the yield for a Treasury bill 

VDB function 

Returns the depreciation of an asset for a specified or partial 
period by using a declining balance method 

XIRR function 

Returns the internal rate of return for a schedule of cash flows that 
is not necessarily periodic 

XNPV function 

Returns the net present value for a schedule of cash flows that is 
not necessarily periodic 

YIELD function 

Returns the yield on a security that pays periodic interest 

YIELDDISC function 

Returns the annual yield for a discounted security; for example, a 
Treasury bill 

YIELDMAT function 

Returns the annual yield of a security that pays interest at maturity 

 

Logical Functions 

Logical functions are used to compared data in different cells. Depending on the logical functions 

used, excel populates the cell with the logical formula as TRUE or FALSE depending on the calculation of 

https://support.office.com/en-us/article/pduration-function-44f33460-5be5-4c90-b857-22308892adaf
https://support.office.com/en-us/article/pmt-function-0214da64-9a63-4996-bc20-214433fa6441
https://support.office.com/en-us/article/ppmt-function-c370d9e3-7749-4ca4-beea-b06c6ac95e1b
https://support.office.com/en-us/article/price-function-3ea9deac-8dfa-436f-a7c8-17ea02c21b0a
https://support.office.com/en-us/article/pricedisc-function-d06ad7c1-380e-4be7-9fd9-75e3079acfd3
https://support.office.com/en-us/article/pricemat-function-52c3b4da-bc7e-476a-989f-a95f675cae77
https://support.office.com/en-us/article/pv-function-23879d31-0e02-4321-be01-da16e8168cbd
https://support.office.com/en-us/article/rate-function-9f665657-4a7e-4bb7-a030-83fc59e748ce
https://support.office.com/en-us/article/received-function-7a3f8b93-6611-4f81-8576-828312c9b5e5
https://support.office.com/en-us/article/rri-function-6f5822d8-7ef1-4233-944c-79e8172930f4
https://support.office.com/en-us/article/sln-function-cdb666e5-c1c6-40a7-806a-e695edc2f1c8
https://support.office.com/en-us/article/syd-function-069f8106-b60b-4ca2-98e0-2a0f206bdb27
https://support.office.com/en-us/article/tbilleq-function-2ab72d90-9b4d-4efe-9fc2-0f81f2c19c8c
https://support.office.com/en-us/article/tbillprice-function-eacca992-c29d-425a-9eb8-0513fe6035a2
https://support.office.com/en-us/article/tbillyield-function-6d381232-f4b0-4cd5-8e97-45b9c03468ba
https://support.office.com/en-us/article/vdb-function-dde4e207-f3fa-488d-91d2-66d55e861d73
https://support.office.com/en-us/article/xirr-function-de1242ec-6477-445b-b11b-a303ad9adc9d
https://support.office.com/en-us/article/xnpv-function-1b42bbf6-370f-4532-a0eb-d67c16b664b7
https://support.office.com/en-us/article/yield-function-f5f5ca43-c4bd-434f-8bd2-ed3c9727a4fe
https://support.office.com/en-us/article/yielddisc-function-a9dbdbae-7dae-46de-b995-615faffaaed7
https://support.office.com/en-us/article/yieldmat-function-ba7d1809-0d33-4bcb-96c7-6c56ec62ef6f
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the formula.  Information about the following functions is provided via support.office.com (anonymous, 

2020). 

Logical Function Description 

AND function Returns TRUE if all of its arguments are TRUE 

FALSE function Returns the logical value FALSE 

IF function Specifies a logical test to perform 

IFERROR 

function 

Returns a value you specify if a formula evaluates to an error; otherwise, returns the 

result of the formula 

IFNA function 

 

Returns the value you specify if the expression resolves to #N/A, otherwise returns the 

result of the expression 

IFS function 

 

Checks whether one or more conditions are met and returns a value that corresponds 

to the first TRUE condition. 

NOT function Reverses the logic of its argument 

OR function Returns TRUE if any argument is TRUE 

SWITCH 

function 

 

Evaluates an expression against a list of values and returns the result corresponding to 

the first matching value. If there is no match, an optional default value may be 

returned. 

TRUE function Returns the logical value TRUE 

XOR function 

 

Returns a logical exclusive OR of all arguments 

 

Text Functions 

Text functions are powerful components of Excel that convert numbers into letters and can also 

remove or copy letters or numbers from other cells into the current cell. Information about the 

following functions is provided via support.office.com (anonymous, 2020). 

Text Function Description 

ASC function 

Changes full-width (double-byte) English letters or katakana within a character string 
to half-width (single-byte) characters 

BAHTTEXT function 

Converts a number to text, using the ß (baht) currency format 

CHAR function 

Returns the character specified by the code number 

CLEAN function 

Removes all nonprintable characters from text 

CODE function 

Returns a numeric code for the first character in a text string 

CONCAT function 

 

Combines the text from multiple ranges and/or strings, but it doesn't provide the 
delimiter or IgnoreEmpty arguments. 

CONCATENATE 

function 

Joins several text items into one text item 

https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/and-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.office.com/en-us/article/false-function-2d58dfa5-9c03-4259-bf8f-f0ae14346904
https://support.office.com/en-us/article/if-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2
https://support.office.com/en-us/article/iferror-function-c526fd07-caeb-47b8-8bb6-63f3e417f611
https://support.office.com/en-us/article/iferror-function-c526fd07-caeb-47b8-8bb6-63f3e417f611
https://support.office.com/en-us/article/ifna-function-6626c961-a569-42fc-a49d-79b4951fd461
https://support.office.com/en-us/article/ifs-function-36329a26-37b2-467c-972b-4a39bd951d45
https://support.office.com/en-us/article/not-function-9cfc6011-a054-40c7-a140-cd4ba2d87d77
https://support.office.com/en-us/article/or-function-7d17ad14-8700-4281-b308-00b131e22af0
https://support.office.com/en-us/article/switch-function-47ab33c0-28ce-4530-8a45-d532ec4aa25e
https://support.office.com/en-us/article/switch-function-47ab33c0-28ce-4530-8a45-d532ec4aa25e
https://support.office.com/en-us/article/true-function-7652c6e3-8987-48d0-97cd-ef223246b3fb
https://support.office.com/en-us/article/xor-function-1548d4c2-5e47-4f77-9a92-0533bba14f37
https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/asc-function-0b6abf1c-c663-4004-a964-ebc00b723266
https://support.office.com/en-us/article/bahttext-function-5ba4d0b4-abd3-4325-8d22-7a92d59aab9c
https://support.office.com/en-us/article/char-function-bbd249c8-b36e-4a91-8017-1c133f9b837a
https://support.office.com/en-us/article/clean-function-26f3d7c5-475f-4a9c-90e5-4b8ba987ba41
https://support.office.com/en-us/article/code-function-c32b692b-2ed0-4a04-bdd9-75640144b928
https://support.office.com/en-us/article/concat-function-9b1a9a3f-94ff-41af-9736-694cbd6b4ca2
https://support.office.com/en-us/article/concatenate-function-8f8ae884-2ca8-4f7a-b093-75d702bea31d
https://support.office.com/en-us/article/concatenate-function-8f8ae884-2ca8-4f7a-b093-75d702bea31d
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Text Function Description 

DBCS function 

 

Changes half-width (single-byte) English letters or katakana within a character string 
to full-width (double-byte) characters 

DOLLAR function 

Converts a number to text, using the $ (dollar) currency format 

EXACT function 

Checks to see if two text values are identical 

FIND, FINDB 

functions 

Finds one text value within another (case-sensitive) 

FIXED function 

Formats a number as text with a fixed number of decimals 

LEFT, LEFTB 

functions 

Returns the leftmost characters from a text value 

LEN, LENB functions 

Returns the number of characters in a text string 

LOWER function 

Converts text to lowercase 

MID, MIDB 

functions 

Returns a specific number of characters from a text string starting at the position you 
specify 

NUMBERVALUE 

function 

 

Converts text to number in a locale-independent manner 

PHONETIC function 

Extracts the phonetic (furigana) characters from a text string 

PROPER function 

Capitalizes the first letter in each word of a text value 

REPLACE, REPLACEB 

functions 

Replaces characters within text 

REPT function 

Repeats text a given number of times 

RIGHT, RIGHTB 

functions 

Returns the rightmost characters from a text value 

SEARCH, SEARCHB 

functions 

Finds one text value within another (not case-sensitive) 

SUBSTITUTE 

function 

Substitutes new text for old text in a text string 

T function 

Converts its arguments to text 

TEXT function 

Formats a number and converts it to text 

TEXTJOIN function 

 

Combines the text from multiple ranges and/or strings, and includes a delimiter you 
specify between each text value that will be combined. If the delimiter is an empty 
text string, this function will effectively concatenate the ranges. 

TRIM function 

Removes spaces from text 

UNICHAR function 

 

Returns the Unicode character that is referenced by the given numeric value 

UNICODE function 

 

Returns the number (code point) that corresponds to the first character of the text 

 

https://support.office.com/en-us/article/dbcs-function-a4025e73-63d2-4958-9423-21a24794c9e5
https://support.office.com/en-us/article/dollar-function-a6cd05d9-9740-4ad3-a469-8109d18ff611
https://support.office.com/en-us/article/exact-function-d3087698-fc15-4a15-9631-12575cf29926
https://support.office.com/en-us/article/find-findb-functions-c7912941-af2a-4bdf-a553-d0d89b0a0628
https://support.office.com/en-us/article/find-findb-functions-c7912941-af2a-4bdf-a553-d0d89b0a0628
https://support.office.com/en-us/article/fixed-function-ffd5723c-324c-45e9-8b96-e41be2a8274a
https://support.office.com/en-us/article/left-leftb-functions-9203d2d2-7960-479b-84c6-1ea52b99640c
https://support.office.com/en-us/article/left-leftb-functions-9203d2d2-7960-479b-84c6-1ea52b99640c
https://support.office.com/en-us/article/len-lenb-functions-29236f94-cedc-429d-affd-b5e33d2c67cb
https://support.office.com/en-us/article/lower-function-3f21df02-a80c-44b2-afaf-81358f9fdeb4
https://support.office.com/en-us/article/mid-midb-functions-d5f9e25c-d7d6-472e-b568-4ecb12433028
https://support.office.com/en-us/article/mid-midb-functions-d5f9e25c-d7d6-472e-b568-4ecb12433028
https://support.office.com/en-us/article/numbervalue-function-1b05c8cf-2bfa-4437-af70-596c7ea7d879
https://support.office.com/en-us/article/numbervalue-function-1b05c8cf-2bfa-4437-af70-596c7ea7d879
https://support.office.com/en-us/article/phonetic-function-9a329dac-0c0f-42f8-9a55-639086988554
https://support.office.com/en-us/article/proper-function-52a5a283-e8b2-49be-8506-b2887b889f94
https://support.office.com/en-us/article/replace-replaceb-functions-8d799074-2425-4a8a-84bc-82472868878a
https://support.office.com/en-us/article/replace-replaceb-functions-8d799074-2425-4a8a-84bc-82472868878a
https://support.office.com/en-us/article/rept-function-04c4d778-e712-43b4-9c15-d656582bb061
https://support.office.com/en-us/article/right-rightb-functions-240267ee-9afa-4639-a02b-f19e1786cf2f
https://support.office.com/en-us/article/right-rightb-functions-240267ee-9afa-4639-a02b-f19e1786cf2f
https://support.office.com/en-us/article/search-searchb-functions-9ab04538-0e55-4719-a72e-b6f54513b495
https://support.office.com/en-us/article/search-searchb-functions-9ab04538-0e55-4719-a72e-b6f54513b495
https://support.office.com/en-us/article/substitute-function-6434944e-a904-4336-a9b0-1e58df3bc332
https://support.office.com/en-us/article/substitute-function-6434944e-a904-4336-a9b0-1e58df3bc332
https://support.office.com/en-us/article/t-function-fb83aeec-45e7-4924-af95-53e073541228
https://support.office.com/en-us/article/text-function-20d5ac4d-7b94-49fd-bb38-93d29371225c
https://support.office.com/en-us/article/textjoin-function-357b449a-ec91-49d0-80c3-0e8fc845691c
https://support.office.com/en-us/article/trim-function-410388fa-c5df-49c6-b16c-9e5630b479f9
https://support.office.com/en-us/article/unichar-function-ffeb64f5-f131-44c6-b332-5cd72f0659b8
https://support.office.com/en-us/article/unicode-function-adb74aaa-a2a5-4dde-aff6-966e4e81f16f
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Date & Time Function 

Date & Time functions calculate numbers into dates. There are many options available to return 

the date as desired from a variety of data sets. Information about the following functions is provided via 

support.office.com (anonymous, 2020). 

Date & Time Function Description 

DATE function 

Returns the serial number of a particular date 

DATEDIF function 

Calculates the number of days, months, or years between two dates. This 
function is useful in formulas where you need to calculate an age. 

DATEVALUE function 

Converts a date in the form of text to a serial number 

DAY function 

Converts a serial number to a day of the month 

DAYS function 

 

Returns the number of days between two dates 

DAYS360 function 

Calculates the number of days between two dates based on a 360-day year 

EDATE function 

Returns the serial number of the date that is the indicated number of months 
before or after the start date 

EOMONTH function 

Returns the serial number of the last day of the month before or after a 
specified number of months 

HOUR function 

Converts a serial number to an hour 

ISOWEEKNUM function 

 

Returns the number of the ISO week number of the year for a given date 

MINUTE function 

Converts a serial number to a minute 

MONTH function 

Converts a serial number to a month 

NETWORKDAYS function 

Returns the number of whole workdays between two dates 

NETWORKDAYS.INTL 

function 

 

Returns the number of whole workdays between two dates using parameters 
to indicate which and how many days are weekend days 

NOW function 

Returns the serial number of the current date and time 

SECOND function 

Converts a serial number to a second 

TIME function 

Returns the serial number of a particular time 

TIMEVALUE function 

Converts a time in the form of text to a serial number 

TODAY function 

Returns the serial number of today's date 

WEEKDAY function 

Converts a serial number to a day of the week 

WEEKNUM function 

Converts a serial number to a number representing where the week falls 
numerically with a year 

WORKDAY function 

Returns the serial number of the date before or after a specified number of 
workdays 

https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/date-function-e36c0c8c-4104-49da-ab83-82328b832349
https://support.office.com/en-us/article/datedif-function-25dba1a4-2812-480b-84dd-8b32a451b35c
https://support.office.com/en-us/article/datevalue-function-df8b07d4-7761-4a93-bc33-b7471bbff252
https://support.office.com/en-us/article/day-function-8a7d1cbb-6c7d-4ba1-8aea-25c134d03101
https://support.office.com/en-us/article/days-function-57740535-d549-4395-8728-0f07bff0b9df
https://support.office.com/en-us/article/days360-function-b9a509fd-49ef-407e-94df-0cbda5718c2a
https://support.office.com/en-us/article/edate-function-3c920eb2-6e66-44e7-a1f5-753ae47ee4f5
https://support.office.com/en-us/article/eomonth-function-7314ffa1-2bc9-4005-9d66-f49db127d628
https://support.office.com/en-us/article/hour-function-a3afa879-86cb-4339-b1b5-2dd2d7310ac7
https://support.office.com/en-us/article/isoweeknum-function-1c2d0afe-d25b-4ab1-8894-8d0520e90e0e
https://support.office.com/en-us/article/minute-function-af728df0-05c4-4b07-9eed-a84801a60589
https://support.office.com/en-us/article/month-function-579a2881-199b-48b2-ab90-ddba0eba86e8
https://support.office.com/en-us/article/networkdays-function-48e717bf-a7a3-495f-969e-5005e3eb18e7
https://support.office.com/en-us/article/networkdays-intl-function-a9b26239-4f20-46a1-9ab8-4e925bfd5e28
https://support.office.com/en-us/article/networkdays-intl-function-a9b26239-4f20-46a1-9ab8-4e925bfd5e28
https://support.office.com/en-us/article/now-function-3337fd29-145a-4347-b2e6-20c904739c46
https://support.office.com/en-us/article/second-function-740d1cfc-553c-4099-b668-80eaa24e8af1
https://support.office.com/en-us/article/time-function-9a5aff99-8f7d-4611-845e-747d0b8d5457
https://support.office.com/en-us/article/timevalue-function-0b615c12-33d8-4431-bf3d-f3eb6d186645
https://support.office.com/en-us/article/today-function-5eb3078d-a82c-4736-8930-2f51a028fdd9
https://support.office.com/en-us/article/weekday-function-60e44483-2ed1-439f-8bd0-e404c190949a
https://support.office.com/en-us/article/weeknum-function-e5c43a03-b4ab-426c-b411-b18c13c75340
https://support.office.com/en-us/article/workday-function-f764a5b7-05fc-4494-9486-60d494efbf33
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Date & Time Function Description 

WORKDAY.INTL function 

 

Returns the serial number of the date before or after a specified number of 
workdays using parameters to indicate which and how many days are weekend 
days 

YEAR function 

Converts a serial number to a year 

YEARFRAC function 

Returns the year fraction representing the number of whole days between 
start_date and end_date 

 

Lookup & Reference Formulas 

Lookup and Reference formulas allow you to work with large sets of data, and especially useful 

when you need to reference between multiple data sets. They can provide information about a range of 

data, find the location of a given address or value, or look up certain values in a large set of data. 

Information about the following functions is provided via support.office.com (anonymous, 2020). 

Lookup & Reference Function Description 

ADDRESS function 

Returns a reference as text to a single cell in a worksheet 

AREAS function 

Returns the number of areas in a reference 

CHOOSE function 

Chooses a value from a list of values 

COLUMN function 

Returns the column number of a reference 

COLUMNS function 

Returns the number of columns in a reference 

FILTER function 

 

Filters a range of data based on criteria you define 

FORMULATEXT function 

 

Returns the formula at the given reference as text 

GETPIVOTDATA function 

Returns data stored in a PivotTable report 

HLOOKUP function 

Looks in the top row of an array and returns the value of the indicated cell 

HYPERLINK function 

Creates a shortcut or jump that opens a document stored on a network 
server, an intranet, or the Internet 

INDEX function 

Uses an index to choose a value from a reference or array 

INDIRECT function 

Returns a reference indicated by a text value 

LOOKUP function 

Looks up values in a vector or array 

MATCH function 

Looks up values in a reference or array 

OFFSET function 

Returns a reference offset from a given reference 

ROW function 

Returns the row number of a reference 

ROWS function 

Returns the number of rows in a reference 

RTD function 

Retrieves real-time data from a program that supports COM automation 

SORT function Sorts the contents of a range or array 

https://support.office.com/en-us/article/workday-intl-function-a378391c-9ba7-4678-8a39-39611a9bf81d
https://support.office.com/en-us/article/year-function-c64f017a-1354-490d-981f-578e8ec8d3b9
https://support.office.com/en-us/article/yearfrac-function-3844141e-c76d-4143-82b6-208454ddc6a8
https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/address-function-d0c26c0d-3991-446b-8de4-ab46431d4f89
https://support.office.com/en-us/article/areas-function-8392ba32-7a41-43b3-96b0-3695d2ec6152
https://support.office.com/en-us/article/choose-function-fc5c184f-cb62-4ec7-a46e-38653b98f5bc
https://support.office.com/en-us/article/column-function-44e8c754-711c-4df3-9da4-47a55042554b
https://support.office.com/en-us/article/columns-function-4e8e7b4e-e603-43e8-b177-956088fa48ca
https://support.office.com/en-us/article/filter-function-f4f7cb66-82eb-4767-8f7c-4877ad80c759
https://support.office.com/en-us/article/formulatext-function-0a786771-54fd-4ae2-96ee-09cda35439c8
https://support.office.com/en-us/article/getpivotdata-function-8c083b99-a922-4ca0-af5e-3af55960761f
https://support.office.com/en-us/article/hlookup-function-a3034eec-b719-4ba3-bb65-e1ad662ed95f
https://support.office.com/en-us/article/hyperlink-function-333c7ce6-c5ae-4164-9c47-7de9b76f577f
https://support.office.com/en-us/article/index-function-a5dcf0dd-996d-40a4-a822-b56b061328bd
https://support.office.com/en-us/article/indirect-function-474b3a3a-8a26-4f44-b491-92b6306fa261
https://support.office.com/en-us/article/lookup-function-446d94af-663b-451d-8251-369d5e3864cb
https://support.office.com/en-us/article/match-function-e8dffd45-c762-47d6-bf89-533f4a37673a
https://support.office.com/en-us/article/offset-function-c8de19ae-dd79-4b9b-a14e-b4d906d11b66
https://support.office.com/en-us/article/row-function-3a63b74a-c4d0-4093-b49a-e76eb49a6d8d
https://support.office.com/en-us/article/rows-function-b592593e-3fc2-47f2-bec1-bda493811597
https://support.office.com/en-us/article/rtd-function-e0cc001a-56f0-470a-9b19-9455dc0eb593
https://support.office.com/en-us/article/sort-function-22f63bd0-ccc8-492f-953d-c20e8e44b86c
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Lookup & Reference Function Description 

 

SORTBY function 

 

Sorts the contents of a range or array based on the values in a 
corresponding range or array 

TRANSPOSE function 

Returns the transpose of an array 

UNIQUE function 

 

Returns a list of unique values in a list or range 

VLOOKUP function 

Looks in the first column of an array and moves across the row to return the 
value of a cell 

XLOOKUP function 

 

Searches a range or an array, and returns an item corresponding to the first 
match it finds. If a match doesn't exist, then XLOOKUP can return 
the closest (approximate) match.  

XMATCH function 

 

Returns the relative position of an item in an array or range of cells.  

 

Math & Trig Function 

The Excel Math & Trig functions allow the user to perform mathematical equations like addition, 

subtraction, multiplication, and division, as well as trigonometry. Information about the following 

functions is provided via support.office.com (anonymous, 2020). 

Math & Trig Function Description 

ABS function 

Returns the absolute value of a number 

ACOS function 

Returns the arccosine of a number 

ACOSH function 

Returns the inverse hyperbolic cosine of a number 

ACOT function 

 

Returns the arccotangent of a number 

ACOTH function 

 

Returns the hyperbolic arccotangent of a number 

AGGREGATE function 

Returns an aggregate in a list or database 

ARABIC function 

Converts a Roman number to Arabic, as a number 

ASIN function 

Returns the arcsine of a number 

ASINH function 

Returns the inverse hyperbolic sine of a number 

ATAN function 

Returns the arctangent of a number 

ATAN2 function 

Returns the arctangent from x- and y-coordinates 

ATANH function 

Returns the inverse hyperbolic tangent of a number 

BASE function 

 

Converts a number into a text representation with the given radix (base) 

https://support.office.com/en-us/article/sortby-function-cd2d7a62-1b93-435c-b561-d6a35134f28f
https://support.office.com/en-us/article/transpose-function-ed039415-ed8a-4a81-93e9-4b6dfac76027
https://support.office.com/en-us/article/unique-function-c5ab87fd-30a3-4ce9-9d1a-40204fb85e1e
https://support.office.com/en-us/article/vlookup-function-0bbc8083-26fe-4963-8ab8-93a18ad188a1
https://support.office.com/en-us/article/xlookup-function-b7fd680e-6d10-43e6-84f9-88eae8bf5929
https://support.office.com/en-us/article/xmatch-function-d966da31-7a6b-4a13-a1c6-5a33ed6a0312
https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/abs-function-3420200f-5628-4e8c-99da-c99d7c87713c
https://support.office.com/en-us/article/acos-function-cb73173f-d089-4582-afa1-76e5524b5d5b
https://support.office.com/en-us/article/acosh-function-e3992cc1-103f-4e72-9f04-624b9ef5ebfe
https://support.office.com/en-us/article/acot-function-dc7e5008-fe6b-402e-bdd6-2eea8383d905
https://support.office.com/en-us/article/acoth-function-cc49480f-f684-4171-9fc5-73e4e852300f
https://support.office.com/en-us/article/aggregate-function-43b9278e-6aa7-4f17-92b6-e19993fa26df
https://support.office.com/en-us/article/arabic-function-9a8da418-c17b-4ef9-a657-9370a30a674f
https://support.office.com/en-us/article/asin-function-81fb95e5-6d6f-48c4-bc45-58f955c6d347
https://support.office.com/en-us/article/asinh-function-4e00475a-067a-43cf-926a-765b0249717c
https://support.office.com/en-us/article/atan-function-50746fa8-630a-406b-81d0-4a2aed395543
https://support.office.com/en-us/article/atan2-function-c04592ab-b9e3-4908-b428-c96b3a565033
https://support.office.com/en-us/article/atanh-function-3cd65768-0de7-4f1d-b312-d01c8c930d90
https://support.office.com/en-us/article/base-function-2ef61411-aee9-4f29-a811-1c42456c6342
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Math & Trig Function Description 

CEILING function 

Rounds a number to the nearest integer or to the nearest multiple of significance 

CEILING.MATH 

function 

 

Rounds a number up, to the nearest integer or to the nearest multiple of 
significance 

CEILING.PRECISE 

function 

Rounds a number the nearest integer or to the nearest multiple of significance. 
Regardless of the sign of the number, the number is rounded up. 

COMBIN function 

Returns the number of combinations for a given number of objects 

COMBINA function 

 

Returns the number of combinations with repetitions for a given number of items 

COS function 

Returns the cosine of a number 

COSH function 

Returns the hyperbolic cosine of a number 

COT function 

 

Returns the cotangent of an angle 

COTH function 

 

Returns the hyperbolic cotangent of a number 

CSC function 

 

Returns the cosecant of an angle 

CSCH function 

 

Returns the hyperbolic cosecant of an angle 

DECIMAL function 

 

Converts a text representation of a number in a given base into a decimal number 

DEGREES function 

Converts radians to degrees 

EVEN function 

Rounds a number up to the nearest even integer 

EXP function 

Returns e raised to the power of a given number 

FACT function 

Returns the factorial of a number 

FACTDOUBLE 

function 

Returns the double factorial of a number 

FLOOR function 

Rounds a number down, toward zero 

FLOOR.MATH 

function 

 

Rounds a number down, to the nearest integer or to the nearest multiple of 
significance 

FLOOR.PRECISE 

function 

Rounds a number down to the nearest integer or to the nearest multiple of 
significance. Regardless of the sign of the number, the number is rounded down. 

GCD function 

Returns the greatest common divisor 

INT function 

Rounds a number down to the nearest integer 

ISO.CEILING function 

 

Returns a number that is rounded up to the nearest integer or to the nearest 
multiple of significance 

LCM function 

Returns the least common multiple 

LN function 

Returns the natural logarithm of a number 

https://support.office.com/en-us/article/ceiling-function-0a5cd7c8-0720-4f0a-bd2c-c943e510899f
https://support.office.com/en-us/article/ceiling-math-function-80f95d2f-b499-4eee-9f16-f795a8e306c8
https://support.office.com/en-us/article/ceiling-math-function-80f95d2f-b499-4eee-9f16-f795a8e306c8
https://support.office.com/en-us/article/ceiling-precise-function-f366a774-527a-4c92-ba49-af0a196e66cb
https://support.office.com/en-us/article/ceiling-precise-function-f366a774-527a-4c92-ba49-af0a196e66cb
https://support.office.com/en-us/article/combin-function-12a3f276-0a21-423a-8de6-06990aaf638a
https://support.office.com/en-us/article/combina-function-efb49eaa-4f4c-4cd2-8179-0ddfcf9d035d
https://support.office.com/en-us/article/cos-function-0fb808a5-95d6-4553-8148-22aebdce5f05
https://support.office.com/en-us/article/cosh-function-e460d426-c471-43e8-9540-a57ff3b70555
https://support.office.com/en-us/article/cot-function-c446f34d-6fe4-40dc-84f8-cf59e5f5e31a
https://support.office.com/en-us/article/coth-function-2e0b4cb6-0ba0-403e-aed4-deaa71b49df5
https://support.office.com/en-us/article/csc-function-07379361-219a-4398-8675-07ddc4f135c1
https://support.office.com/en-us/article/csch-function-f58f2c22-eb75-4dd6-84f4-a503527f8eeb
https://support.office.com/en-us/article/decimal-function-ee554665-6176-46ef-82de-0a283658da2e
https://support.office.com/en-us/article/degrees-function-4d6ec4db-e694-4b94-ace0-1cc3f61f9ba1
https://support.office.com/en-us/article/even-function-197b5f06-c795-4c1e-8696-3c3b8a646cf9
https://support.office.com/en-us/article/exp-function-c578f034-2c45-4c37-bc8c-329660a63abe
https://support.office.com/en-us/article/fact-function-ca8588c2-15f2-41c0-8e8c-c11bd471a4f3
https://support.office.com/en-us/article/factdouble-function-e67697ac-d214-48eb-b7b7-cce2589ecac8
https://support.office.com/en-us/article/factdouble-function-e67697ac-d214-48eb-b7b7-cce2589ecac8
https://support.office.com/en-us/article/floor-function-14bb497c-24f2-4e04-b327-b0b4de5a8886
https://support.office.com/en-us/article/floor-math-function-c302b599-fbdb-4177-ba19-2c2b1249a2f5
https://support.office.com/en-us/article/floor-math-function-c302b599-fbdb-4177-ba19-2c2b1249a2f5
https://support.office.com/en-us/article/floor-precise-function-f769b468-1452-4617-8dc3-02f842a0702e
https://support.office.com/en-us/article/floor-precise-function-f769b468-1452-4617-8dc3-02f842a0702e
https://support.office.com/en-us/article/gcd-function-d5107a51-69e3-461f-8e4c-ddfc21b5073a
https://support.office.com/en-us/article/int-function-a6c4af9e-356d-4369-ab6a-cb1fd9d343ef
https://support.office.com/en-us/article/iso-ceiling-function-e587bb73-6cc2-4113-b664-ff5b09859a83
https://support.office.com/en-us/article/lcm-function-7152b67a-8bb5-4075-ae5c-06ede5563c94
https://support.office.com/en-us/article/ln-function-81fe1ed7-dac9-4acd-ba1d-07a142c6118f


Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

203 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

Math & Trig Function Description 

LOG function 

Returns the logarithm of a number to a specified base 

LOG10 function 

Returns the base-10 logarithm of a number 

MDETERM function 

Returns the matrix determinant of an array 

MINVERSE function 

Returns the matrix inverse of an array 

MMULT function 

Returns the matrix product of two arrays 

MOD function 

Returns the remainder from division 

MROUND function 

Returns a number rounded to the desired multiple 

MULTINOMIAL 

function 

Returns the multinomial of a set of numbers 

MUNIT function 

 

Returns the unit matrix or the specified dimension 

ODD function 

Rounds a number up to the nearest odd integer 

PI function 

Returns the value of pi 

POWER function 

Returns the result of a number raised to a power 

PRODUCT function 

Multiplies its arguments 

QUOTIENT function 

Returns the integer portion of a division 

RADIANS function 

Converts degrees to radians 

RAND function 

Returns a random number between 0 and 1 

RANDARRAY function 

 

Returns an array of random numbers between 0 and 1. However, you can specify 
the number of rows and columns to fill, minimum and maximum values, and 
whether to return whole numbers or decimal values. 

RANDBETWEEN 

function 

Returns a random number between the numbers you specify 

ROMAN function 

Converts an Arabic numeral to Roman, as text 

ROUND function 

Rounds a number to a specified number of digits 

ROUNDDOWN 

function 

Rounds a number down, toward zero 

ROUNDUP function 

Rounds a number up, away from zero 

SEC function 

 

Returns the secant of an angle 

SECH function 

 

Returns the hyperbolic secant of an angle 

SERIESSUM function 

Returns the sum of a power series based on the formula 

SEQUENCE function 

 

Generates a list of sequential numbers in an array, such as 1, 2, 3, 4 

SIGN function 

Returns the sign of a number 

SIN function 

Returns the sine of the given angle 

SINH function 

Returns the hyperbolic sine of a number 

SQRT function 

Returns a positive square root 

https://support.office.com/en-us/article/log-function-4e82f196-1ca9-4747-8fb0-6c4a3abb3280
https://support.office.com/en-us/article/log10-function-c75b881b-49dd-44fb-b6f4-37e3486a0211
https://support.office.com/en-us/article/mdeterm-function-e7bfa857-3834-422b-b871-0ffd03717020
https://support.office.com/en-us/article/minverse-function-11f55086-adde-4c9f-8eb9-59da2d72efc6
https://support.office.com/en-us/article/mmult-function-40593ed7-a3cd-4b6b-b9a3-e4ad3c7245eb
https://support.office.com/en-us/article/mod-function-9b6cd169-b6ee-406a-a97b-edf2a9dc24f3
https://support.office.com/en-us/article/mround-function-c299c3b0-15a5-426d-aa4b-d2d5b3baf427
https://support.office.com/en-us/article/multinomial-function-6fa6373c-6533-41a2-a45e-a56db1db1bf6
https://support.office.com/en-us/article/multinomial-function-6fa6373c-6533-41a2-a45e-a56db1db1bf6
https://support.office.com/en-us/article/munit-function-c9fe916a-dc26-4105-997d-ba22799853a3
https://support.office.com/en-us/article/odd-function-deae64eb-e08a-4c88-8b40-6d0b42575c98
https://support.office.com/en-us/article/pi-function-264199d0-a3ba-46b8-975a-c4a04608989b
https://support.office.com/en-us/article/power-function-d3f2908b-56f4-4c3f-895a-07fb519c362a
https://support.office.com/en-us/article/product-function-8e6b5b24-90ee-4650-aeec-80982a0512ce
https://support.office.com/en-us/article/quotient-function-9f7bf099-2a18-4282-8fa4-65290cc99dee
https://support.office.com/en-us/article/radians-function-ac409508-3d48-45f5-ac02-1497c92de5bf
https://support.office.com/en-us/article/rand-function-4cbfa695-8869-4788-8d90-021ea9f5be73
https://support.office.com/en-us/article/randarray-function-21261e55-3bec-4885-86a6-8b0a47fd4d33
https://support.office.com/en-us/article/randbetween-function-4cc7f0d1-87dc-4eb7-987f-a469ab381685
https://support.office.com/en-us/article/randbetween-function-4cc7f0d1-87dc-4eb7-987f-a469ab381685
https://support.office.com/en-us/article/roman-function-d6b0b99e-de46-4704-a518-b45a0f8b56f5
https://support.office.com/en-us/article/round-function-c018c5d8-40fb-4053-90b1-b3e7f61a213c
https://support.office.com/en-us/article/rounddown-function-2ec94c73-241f-4b01-8c6f-17e6d7968f53
https://support.office.com/en-us/article/rounddown-function-2ec94c73-241f-4b01-8c6f-17e6d7968f53
https://support.office.com/en-us/article/roundup-function-f8bc9b23-e795-47db-8703-db171d0c42a7
https://support.office.com/en-us/article/sec-function-ff224717-9c87-4170-9b58-d069ced6d5f7
https://support.office.com/en-us/article/sech-function-e05a789f-5ff7-4d7f-984a-5edb9b09556f
https://support.office.com/en-us/article/seriessum-function-a3ab25b5-1093-4f5b-b084-96c49087f637
https://support.office.com/en-us/article/sequence-function-57467a98-57e0-4817-9f14-2eb78519ca90
https://support.office.com/en-us/article/sign-function-109c932d-fcdc-4023-91f1-2dd0e916a1d8
https://support.office.com/en-us/article/sin-function-cf0e3432-8b9e-483c-bc55-a76651c95602
https://support.office.com/en-us/article/sinh-function-1e4e8b9f-2b65-43fc-ab8a-0a37f4081fa7
https://support.office.com/en-us/article/sqrt-function-654975c2-05c4-4831-9a24-2c65e4040fdf
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Math & Trig Function Description 

SQRTPI function 

Returns the square root of (number * pi) 

SUBTOTAL function 

Returns a subtotal in a list or database 

SUM function 

Adds its arguments 

SUMIF function 

Adds the cells specified by a given criteria 

SUMIFS function 

 

Adds the cells in a range that meet multiple criteria 

SUMPRODUCT 

function 

Returns the sum of the products of corresponding array components 

SUMSQ function 

Returns the sum of the squares of the arguments 

SUMX2MY2 function 

Returns the sum of the difference of squares of corresponding values in two arrays 

SUMX2PY2 function 

Returns the sum of squares of corresponding values in two arrays 

SUMXMY2 function 

Returns the sum of squares of differences of corresponding values in two arrays 

TAN function 

Returns the tangent of a number 

TANH function 

Returns the hyperbolic tangent of a number 

TRUNC function 

Truncates a number to an integer 

Statistical Functions: 
Statistical Functions are responsible for statistical analysis calculating items like mean, median, mode, 

etc. Information about the following functions is provided via support.office.com (anonymous, 2020). 

Statistical Function Description 

AVEDEV function 

Returns the average of the absolute deviations of data points from their 
mean 

AVERAGE function 

Returns the average of its arguments 

AVERAGEA function 

Returns the average of its arguments, including numbers, text, and 
logical values 

AVERAGEIF function 

Returns the average (arithmetic mean) of all the cells in a range that 
meet a given criteria 

AVERAGEIFS function 

 

Returns the average (arithmetic mean) of all cells that meet multiple 
criteria 

BETA.DIST function 

 

Returns the beta cumulative distribution function 

BETA.INV function 

 

Returns the inverse of the cumulative distribution function for a 
specified beta distribution 

BINOM.DIST function 

 

Returns the individual term binomial distribution probability 

BINOM.DIST.RANGE function 

 

Returns the probability of a trial result using a binomial distribution 

BINOM.INV function 

 

Returns the smallest value for which the cumulative binomial 
distribution is less than or equal to a criterion value 

https://support.office.com/en-us/article/sqrtpi-function-1fb4e63f-9b51-46d6-ad68-b3e7a8b519b4
https://support.office.com/en-us/article/subtotal-function-7b027003-f060-4ade-9040-e478765b9939
https://support.office.com/en-us/article/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89
https://support.office.com/en-us/article/sumif-function-169b8c99-c05c-4483-a712-1697a653039b
https://support.office.com/en-us/article/sumifs-function-c9e748f5-7ea7-455d-9406-611cebce642b
https://support.office.com/en-us/article/sumproduct-function-16753e75-9f68-4874-94ac-4d2145a2fd2e
https://support.office.com/en-us/article/sumproduct-function-16753e75-9f68-4874-94ac-4d2145a2fd2e
https://support.office.com/en-us/article/sumsq-function-e3313c02-51cc-4963-aae6-31442d9ec307
https://support.office.com/en-us/article/sumx2my2-function-9e599cc5-5399-48e9-a5e0-e37812dfa3e9
https://support.office.com/en-us/article/sumx2py2-function-826b60b4-0aa2-4e5e-81d2-be704d3d786f
https://support.office.com/en-us/article/sumxmy2-function-9d144ac1-4d79-43de-b524-e2ecee23b299
https://support.office.com/en-us/article/tan-function-08851a40-179f-4052-b789-d7f699447401
https://support.office.com/en-us/article/tanh-function-017222f0-a0c3-4f69-9787-b3202295dc6c
https://support.office.com/en-us/article/trunc-function-8b86a64c-3127-43db-ba14-aa5ceb292721
https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/avedev-function-58fe8d65-2a84-4dc7-8052-f3f87b5c6639
https://support.office.com/en-us/article/average-function-047bac88-d466-426c-a32b-8f33eb960cf6
https://support.office.com/en-us/article/averagea-function-f5f84098-d453-4f4c-bbba-3d2c66356091
https://support.office.com/en-us/article/averageif-function-faec8e2e-0dec-4308-af69-f5576d8ac642
https://support.office.com/en-us/article/averageifs-function-48910c45-1fc0-4389-a028-f7c5c3001690
https://support.office.com/en-us/article/beta-dist-function-11188c9c-780a-42c7-ba43-9ecb5a878d31
https://support.office.com/en-us/article/beta-inv-function-e84cb8aa-8df0-4cf6-9892-83a341d252eb
https://support.office.com/en-us/article/binom-dist-function-c5ae37b6-f39c-4be2-94c2-509a1480770c
https://support.office.com/en-us/article/binom-dist-range-function-17331329-74c7-4053-bb4c-6653a7421595
https://support.office.com/en-us/article/binom-inv-function-80a0370c-ada6-49b4-83e7-05a91ba77ac9
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Statistical Function Description 

CHISQ.DIST function 

 

Returns the cumulative beta probability density function 

CHISQ.DIST.RT function 

 

Returns the one-tailed probability of the chi-squared distribution 

CHISQ.INV function 

 

Returns the cumulative beta probability density function 

CHISQ.INV.RT function 

 

Returns the inverse of the one-tailed probability of the chi-squared 
distribution 

CHISQ.TEST function 

 

Returns the test for independence 

CONFIDENCE.NORM function 

 

Returns the confidence interval for a population mean 

CONFIDENCE.T function 

 

Returns the confidence interval for a population mean, using a Student's 
t distribution 

CORREL function 

Returns the correlation coefficient between two data sets 

COUNT function 

Counts how many numbers are in the list of arguments 

COUNTA function 

Counts how many values are in the list of arguments 

COUNTBLANK function 

Counts the number of blank cells within a range 

COUNTIF function 

Counts the number of cells within a range that meet the given criteria 

COUNTIFS function 

 

Counts the number of cells within a range that meet multiple criteria 

COVARIANCE.P function 

 

Returns covariance, the average of the products of paired deviations 

COVARIANCE.S function 

 

Returns the sample covariance, the average of the products deviations 
for each data point pair in two data sets 

DEVSQ function 

Returns the sum of squares of deviations 

EXPON.DIST function 

 

Returns the exponential distribution 

F.DIST function 

 

Returns the F probability distribution 

F.DIST.RT function 

 

Returns the F probability distribution 

F.INV function 

 

Returns the inverse of the F probability distribution 

F.INV.RT function 

 

Returns the inverse of the F probability distribution 

https://support.office.com/en-us/article/chisq-dist-function-8486b05e-5c05-4942-a9ea-f6b341518732
https://support.office.com/en-us/article/chisq-dist-rt-function-dc4832e8-ed2b-49ae-8d7c-b28d5804c0f2
https://support.office.com/en-us/article/chisq-inv-function-400db556-62b3-472d-80b3-254723e7092f
https://support.office.com/en-us/article/chisq-inv-rt-function-435b5ed8-98d5-4da6-823f-293e2cbc94fe
https://support.office.com/en-us/article/chisq-test-function-2e8a7861-b14a-4985-aa93-fb88de3f260f
https://support.office.com/en-us/article/confidence-norm-function-7cec58a6-85bb-488d-91c3-63828d4fbfd4
https://support.office.com/en-us/article/confidence-t-function-e8eca395-6c3a-4ba9-9003-79ccc61d3c53
https://support.office.com/en-us/article/correl-function-995dcef7-0c0a-4bed-a3fb-239d7b68ca92
https://support.office.com/en-us/article/count-function-a59cd7fc-b623-4d93-87a4-d23bf411294c
https://support.office.com/en-us/article/counta-function-7dc98875-d5c1-46f1-9a82-53f3219e2509
https://support.office.com/en-us/article/countblank-function-6a92d772-675c-4bee-b346-24af6bd3ac22
https://support.office.com/en-us/article/countif-function-e0de10c6-f885-4e71-abb4-1f464816df34
https://support.office.com/en-us/article/countifs-function-dda3dc6e-f74e-4aee-88bc-aa8c2a866842
https://support.office.com/en-us/article/covariance-p-function-6f0e1e6d-956d-4e4b-9943-cfef0bf9edfc
https://support.office.com/en-us/article/covariance-s-function-0a539b74-7371-42aa-a18f-1f5320314977
https://support.office.com/en-us/article/devsq-function-8b739616-8376-4df5-8bd0-cfe0a6caf444
https://support.office.com/en-us/article/expon-dist-function-4c12ae24-e563-4155-bf3e-8b78b6ae140e
https://support.office.com/en-us/article/f-dist-function-a887efdc-7c8e-46cb-a74a-f884cd29b25d
https://support.office.com/en-us/article/f-dist-rt-function-d74cbb00-6017-4ac9-b7d7-6049badc0520
https://support.office.com/en-us/article/f-inv-function-0dda0cf9-4ea0-42fd-8c3c-417a1ff30dbe
https://support.office.com/en-us/article/f-inv-rt-function-d371aa8f-b0b1-40ef-9cc2-496f0693ac00
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Statistical Function Description 

F.TEST function 

 

Returns the result of an F-test 

FISHER function 

Returns the Fisher transformation 

FISHERINV function 

Returns the inverse of the Fisher transformation 

FORECAST function 

Returns a value along with a linear trend 

Note: In Excel 2016, this function is replaced with FORECAST.LINEAR as 

part of the new Forecasting functions, but it's still available for 
compatibility with earlier versions. 

FORECAST.ETS function 

 

Returns a future value based on existing (historical) values by using the 
AAA version of the Exponential Smoothing (ETS) algorithm 

FORECAST.ETS.CONFINT 

function 

 

Returns a confidence interval for the forecast value at the specified 
target date 

FORECAST.ETS.SEASONALITY 

function 

 

Returns the length of the repetitive pattern Excel detects for the 
specified time series 

FORECAST.ETS.STAT function 

 

Returns a statistical value as a result of time series forecasting 

FORECAST.LINEAR function 

 

Returns a future value based on existing values 

FREQUENCY function 

Returns a frequency distribution as a vertical array 

GAMMA function 

 

Returns the Gamma function value 

GAMMA.DIST function 

 

Returns the gamma distribution 

GAMMA.INV function 

 

Returns the inverse of the gamma cumulative distribution 

GAMMALN function 

Returns the natural logarithm of the gamma function, Γ(x) 

GAMMALN.PRECISE function 

 

Returns the natural logarithm of the gamma function, Γ(x) 

GAUSS function 

 

Returns 0.5 less than the standard normal cumulative distribution 

GEOMEAN function 

Returns the geometric mean 

GROWTH function 

Returns values along an exponential trend 

HARMEAN function 

Returns the harmonic mean 

HYPGEOM.DIST function 

Returns the hypergeometric distribution 

INTERCEPT function 

Returns the intercept of the linear regression line 

KURT function 

Returns the kurtosis of a data set 

https://support.office.com/en-us/article/f-test-function-100a59e7-4108-46f8-8443-78ffacb6c0a7
https://support.office.com/en-us/article/fisher-function-d656523c-5076-4f95-b87b-7741bf236c69
https://support.office.com/en-us/article/fisherinv-function-62504b39-415a-4284-a285-19c8e82f86bb
https://support.office.com/en-us/article/forecast-function-50ca49c9-7b40-4892-94e4-7ad38bbeda99
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.linear
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.ets
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.ets.confint
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.ets.confint
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.ets.seasonality
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.ets.seasonality
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.ets.stat
https://support.office.com/en-us/article/forecasting-functions-reference-897a2fe9-6595-4680-a0b0-93e0308d5f6e#_forecast.linear
https://support.office.com/en-us/article/frequency-function-44e3be2b-eca0-42cd-a3f7-fd9ea898fdb9
https://support.office.com/en-us/article/gamma-function-ce1702b1-cf55-471d-8307-f83be0fc5297
https://support.office.com/en-us/article/gamma-dist-function-9b6f1538-d11c-4d5f-8966-21f6a2201def
https://support.office.com/en-us/article/gamma-inv-function-74991443-c2b0-4be5-aaab-1aa4d71fbb18
https://support.office.com/en-us/article/gammaln-function-b838c48b-c65f-484f-9e1d-141c55470eb9
https://support.office.com/en-us/article/gammaln-precise-function-5cdfe601-4e1e-4189-9d74-241ef1caa599
https://support.office.com/en-us/article/gauss-function-069f1b4e-7dee-4d6a-a71f-4b69044a6b33
https://support.office.com/en-us/article/geomean-function-db1ac48d-25a5-40a0-ab83-0b38980e40d5
https://support.office.com/en-us/article/growth-function-541a91dc-3d5e-437d-b156-21324e68b80d
https://support.office.com/en-us/article/harmean-function-5efd9184-fab5-42f9-b1d3-57883a1d3bc6
https://support.office.com/en-us/article/hypgeom-dist-function-6dbd547f-1d12-4b1f-8ae5-b0d9e3d22fbf
https://support.office.com/en-us/article/intercept-function-2a9b74e2-9d47-4772-b663-3bca70bf63ef
https://support.office.com/en-us/article/kurt-function-bc3a265c-5da4-4dcb-b7fd-c237789095ab
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Statistical Function Description 

LARGE function 

Returns the k-th largest value in a data set 

LINEST function 

Returns the parameters of a linear trend 

LOGEST function 

Returns the parameters of an exponential trend 

LOGNORM.DIST function 

 

Returns the cumulative lognormal distribution 

LOGNORM.INV function 

 

Returns the inverse of the lognormal cumulative distribution 

MAX function 

Returns the maximum value in a list of arguments 

MAXA function 

Returns the maximum value in a list of arguments, including numbers, 
text, and logical values 

MAXIFS function 

 

Returns the maximum value among cells specified by a given set of 
conditions or criteria 

MEDIAN function 

Returns the median of the given numbers 

MIN function 

Returns the minimum value in a list of arguments 

MINA function 

Returns the smallest value in a list of arguments, including numbers, 
text, and logical values 

MINIFS function 

 

Returns the minimum value among cells specified by a given set of 
conditions or criteria. 

MODE.MULT function 

 

Returns a vertical array of the most frequently occurring, or repetitive 
values in an array or range of data 

MODE.SNGL function 

 

Returns the most common value in a data set 

NEGBINOM.DIST function 

 

Returns the negative binomial distribution 

NORM.DIST function 

 

Returns the normal cumulative distribution 

NORM.INV function 

 

Returns the inverse of the normal cumulative distribution 

NORM.S.DIST function 

 

Returns the standard normal cumulative distribution 

NORM.S.INV function 

 

Returns the inverse of the standard normal cumulative distribution 

PEARSON function 

Returns the Pearson product-moment correlation coefficient 

PERCENTILE.EXC function 

 

Returns the k-th percentile of values in a range, where k is in the range 
0..1, exclusive 

PERCENTILE.INC function 

 

Returns the k-th percentile of values in a range 

https://support.office.com/en-us/article/large-function-3af0af19-1190-42bb-bb8b-01672ec00a64
https://support.office.com/en-us/article/linest-function-84d7d0d9-6e50-4101-977a-fa7abf772b6d
https://support.office.com/en-us/article/logest-function-f27462d8-3657-4030-866b-a272c1d18b4b
https://support.office.com/en-us/article/lognorm-dist-function-eb60d00b-48a9-4217-be2b-6074aee6b070
https://support.office.com/en-us/article/lognorm-inv-function-fe79751a-f1f2-4af8-a0a1-e151b2d4f600
https://support.office.com/en-us/article/max-function-e0012414-9ac8-4b34-9a47-73e662c08098
https://support.office.com/en-us/article/maxa-function-814bda1e-3840-4bff-9365-2f59ac2ee62d
https://support.office.com/en-us/article/maxifs-function-dfd611e6-da2c-488a-919b-9b6376b28883
https://support.office.com/en-us/article/median-function-d0916313-4753-414c-8537-ce85bdd967d2
https://support.office.com/en-us/article/min-function-61635d12-920f-4ce2-a70f-96f202dcc152
https://support.office.com/en-us/article/mina-function-245a6f46-7ca5-4dc7-ab49-805341bc31d3
https://support.office.com/en-us/article/minifs-function-6ca1ddaa-079b-4e74-80cc-72eef32e6599
https://support.office.com/en-us/article/mode-mult-function-50fd9464-b2ba-4191-b57a-39446689ae8c
https://support.office.com/en-us/article/mode-sngl-function-f1267c16-66c6-4386-959f-8fba5f8bb7f8
https://support.office.com/en-us/article/negbinom-dist-function-c8239f89-c2d0-45bd-b6af-172e570f8599
https://support.office.com/en-us/article/norm-dist-function-edb1cc14-a21c-4e53-839d-8082074c9f8d
https://support.office.com/en-us/article/norm-inv-function-54b30935-fee7-493c-bedb-2278a9db7e13
https://support.office.com/en-us/article/norm-s-dist-function-1e787282-3832-4520-a9ae-bd2a8d99ba88
https://support.office.com/en-us/article/norm-s-inv-function-d6d556b4-ab7f-49cd-b526-5a20918452b1
https://support.office.com/en-us/article/pearson-function-0c3e30fc-e5af-49c4-808a-3ef66e034c18
https://support.office.com/en-us/article/percentile-exc-function-bbaa7204-e9e1-4010-85bf-c31dc5dce4ba
https://support.office.com/en-us/article/percentile-inc-function-680f9539-45eb-410b-9a5e-c1355e5fe2ed
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Statistical Function Description 

PERCENTRANK.EXC function 

 

Returns the rank of a value in a data set as a percentage (0..1, exclusive) 
of the data set 

PERCENTRANK.INC function 

 

Returns the percentage rank of a value in a data set 

PERMUT function 

Returns the number of permutations for a given number of objects 

PERMUTATIONA function 

 

Returns the number of permutations for a given number of objects 
(with repetitions) that can be selected from the total objects 

PHI function 

 

Returns the value of the density function for a standard normal 
distribution 

POISSON.DIST function 

 

Returns the Poisson distribution 

PROB function 

Returns the probability that values in a range are between two limits 

QUARTILE.EXC function 

 

Returns the quartile of the data set, based on percentile values from 
0..1, exclusive 

QUARTILE.INC function 

 

Returns the quartile of a data set 

RANK.AVG function 

 

Returns the rank of a number in a list of numbers 

RANK.EQ function 

 

Returns the rank of a number in a list of numbers 

RSQ function 

Returns the square of the Pearson product-moment correlation 
coefficient 

SKEW function 

Returns the skewness of a distribution 

SKEW.P function 

 

Returns the skewness of a distribution based on a population: 
characterization of the degree of asymmetry of a distribution around its 
mean 

SLOPE function 

Returns the slope of the linear regression line 

SMALL function 

Returns the k-th smallest value in a data set 

STANDARDIZE function 

Returns a normalized value 

STDEV.P function 

 

Calculates standard deviation based on the entire population 

STDEV.S function 

 

Estimates standard deviation based on a sample 

STDEVA function 

Estimates standard deviation based on a sample, including numbers, 
text, and logical values 

STDEVPA function 

Calculates standard deviation based on the entire population, including 
numbers, text, and logical values 

STEYX function 

Returns the standard error of the predicted y-value for each x in the 
regression 

https://support.office.com/en-us/article/percentrank-exc-function-d8afee96-b7e2-4a2f-8c01-8fcdedaa6314
https://support.office.com/en-us/article/percentrank-inc-function-149592c9-00c0-49ba-86c1-c1f45b80463a
https://support.office.com/en-us/article/permut-function-3bd1cb9a-2880-41ab-a197-f246a7a602d3
https://support.office.com/en-us/article/permutationa-function-6c7d7fdc-d657-44e6-aa19-2857b25cae4e
https://support.office.com/en-us/article/phi-function-23e49bc6-a8e8-402d-98d3-9ded87f6295c
https://support.office.com/en-us/article/poisson-dist-function-8fe148ff-39a2-46cb-abf3-7772695d9636
https://support.office.com/en-us/article/prob-function-9ac30561-c81c-4259-8253-34f0a238fc49
https://support.office.com/en-us/article/quartile-exc-function-5a355b7a-840b-4a01-b0f1-f538c2864cad
https://support.office.com/en-us/article/quartile-inc-function-1bbacc80-5075-42f1-aed6-47d735c4819d
https://support.office.com/en-us/article/rank-avg-function-bd406a6f-eb38-4d73-aa8e-6d1c3c72e83a
https://support.office.com/en-us/article/rank-eq-function-284858ce-8ef6-450e-b662-26245be04a40
https://support.office.com/en-us/article/rsq-function-d7161715-250d-4a01-b80d-a8364f2be08f
https://support.office.com/en-us/article/skew-function-bdf49d86-b1ef-4804-a046-28eaea69c9fa
https://support.office.com/en-us/article/skew-p-function-76530a5c-99b9-48a1-8392-26632d542fcb
https://support.office.com/en-us/article/slope-function-11fb8f97-3117-4813-98aa-61d7e01276b9
https://support.office.com/en-us/article/small-function-17da8222-7c82-42b2-961b-14c45384df07
https://support.office.com/en-us/article/standardize-function-81d66554-2d54-40ec-ba83-6437108ee775
https://support.office.com/en-us/article/stdev-p-function-6e917c05-31a0-496f-ade7-4f4e7462f285
https://support.office.com/en-us/article/stdev-s-function-7d69cf97-0c1f-4acf-be27-f3e83904cc23
https://support.office.com/en-us/article/stdeva-function-5ff38888-7ea5-48de-9a6d-11ed73b29e9d
https://support.office.com/en-us/article/stdevpa-function-5578d4d6-455a-4308-9991-d405afe2c28c
https://support.office.com/en-us/article/steyx-function-6ce74b2c-449d-4a6e-b9ac-f9cef5ba48ab
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Statistical Function Description 

T.DIST function 

 

Returns the Percentage Points (probability) for the Student t-
distribution 

T.DIST.2T function 

 

Returns the Percentage Points (probability) for the Student t-
distribution 

T.DIST.RT function 

 

Returns the Student's t-distribution 

T.INV function 

 

Returns the t-value of the Student's t-distribution as a function of the 
probability and the degrees of freedom 

T.INV.2T function 

 

Returns the inverse of the Student's t-distribution 

T.TEST function 

 

Returns the probability associated with a Student's t-test 

TREND function 

Returns values along with a linear trend 

TRIMMEAN function 

Returns the mean of the interior of a data set 

VAR.P function 

 

Calculates variance based on the entire population 

VAR.S function 

 

Estimates variance based on a sample 

VARA function 

Estimates variance based on a sample, including numbers, text, and 
logical values 

VARPA function 

Calculates variance based on the entire population, including numbers, 
text, and logical values 

WEIBULL.DIST function 

 

Returns the Weibull distribution 

Z.TEST function 

 

Returns the one-tailed probability-value of a z-test 

 

Engineering Functions 
Engineering Functions are used to perform common engineering calculations. Information about the 

following functions is provided via support.office.com (anonymous, 2020). 

Function Description 

BESSELI function 

Returns the modified Bessel function In(x) 

BESSELJ function 

Returns the Bessel function Jn(x) 

BESSELK function 

Returns the modified Bessel function Kn(x) 

BESSELY function 

Returns the Bessel function Yn(x) 

BIN2DEC function 

Converts a binary number to decimal 

BIN2HEX function 

Converts a binary number to hexadecimal 

https://support.office.com/en-us/article/t-dist-function-4329459f-ae91-48c2-bba8-1ead1c6c21b2
https://support.office.com/en-us/article/t-dist-2t-function-198e9340-e360-4230-bd21-f52f22ff5c28
https://support.office.com/en-us/article/t-dist-rt-function-20a30020-86f9-4b35-af1f-7ef6ae683eda
https://support.office.com/en-us/article/t-inv-function-2908272b-4e61-4942-9df9-a25fec9b0e2e
https://support.office.com/en-us/article/t-inv-2t-function-ce72ea19-ec6c-4be7-bed2-b9baf2264f17
https://support.office.com/en-us/article/t-test-function-d4e08ec3-c545-485f-962e-276f7cbed055
https://support.office.com/en-us/article/trend-function-e2f135f0-8827-4096-9873-9a7cf7b51ef1
https://support.office.com/en-us/article/trimmean-function-d90c9878-a119-4746-88fa-63d988f511d3
https://support.office.com/en-us/article/var-p-function-73d1285c-108c-4843-ba5d-a51f90656f3a
https://support.office.com/en-us/article/var-s-function-913633de-136b-449d-813e-65a00b2b990b
https://support.office.com/en-us/article/vara-function-3de77469-fa3a-47b4-85fd-81758a1e1d07
https://support.office.com/en-us/article/varpa-function-59a62635-4e89-4fad-88ac-ce4dc0513b96
https://support.office.com/en-us/article/weibull-dist-function-4e783c39-9325-49be-bbc9-a83ef82b45db
https://support.office.com/en-us/article/z-test-function-d633d5a3-2031-4614-a016-92180ad82bee
https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
https://support.office.com/en-us/article/besseli-function-8d33855c-9a8d-444b-98e0-852267b1c0df
https://support.office.com/en-us/article/besselj-function-839cb181-48de-408b-9d80-bd02982d94f7
https://support.office.com/en-us/article/besselk-function-606d11bc-06d3-4d53-9ecb-2803e2b90b70
https://support.office.com/en-us/article/bessely-function-f3a356b3-da89-42c3-8974-2da54d6353a2
https://support.office.com/en-us/article/bin2dec-function-63905b57-b3a0-453d-99f4-647bb519cd6c
https://support.office.com/en-us/article/bin2hex-function-0375e507-f5e5-4077-9af8-28d84f9f41cc
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Function Description 

BIN2OCT function 

Converts a binary number to octal 

BITAND function 

 

Returns a 'Bitwise And' of two numbers 

BITLSHIFT function 

 

Returns a value number shifted left by shift_amount bits 

BITOR function 

 

Returns a bitwise OR of 2 numbers 

BITRSHIFT function 

 

Returns a value number shifted right by shift_amount bits 

BITXOR function 

 

Returns a bitwise 'Exclusive Or' of two numbers 

COMPLEX function 

Converts real and imaginary coefficients into a complex number 

CONVERT function 

Converts a number from one measurement system to another 

DEC2BIN function 

Converts a decimal number to binary 

DEC2HEX function 

Converts a decimal number to hexadecimal 

DEC2OCT function 

Converts a decimal number to octal 

DELTA function 

Tests whether two values are equal 

ERF function 

Returns the error function 

ERF.PRECISE function 

 

Returns the error function 

ERFC function 

Returns the complementary error function 

ERFC.PRECISE function 

 

Returns the complementary ERF function integrated between x and infinity 

GESTEP function 

Tests whether a number is greater than a threshold value 

HEX2BIN function 

Converts a hexadecimal number to binary 

HEX2DEC function 

Converts a hexadecimal number to decimal 

HEX2OCT function 

Converts a hexadecimal number to octal 

IMABS function 

Returns the absolute value (modulus) of a complex number 

IMAGINARY function 

Returns the imaginary coefficient of a complex number 

IMARGUMENT function 

Returns the argument theta, an angle expressed in radians 

IMCONJUGATE function 

Returns the complex conjugate of a complex number 

IMCOS function 

Returns the cosine of a complex number 

IMCOSH function 

 

Returns the hyperbolic cosine of a complex number 

IMCOT function 

 

Returns the cotangent of a complex number 

IMCSC function 

 

Returns the cosecant of a complex number 

https://support.office.com/en-us/article/bin2oct-function-0a4e01ba-ac8d-4158-9b29-16c25c4c23fd
https://support.office.com/en-us/article/bitand-function-8a2be3d7-91c3-4b48-9517-64548008563a
https://support.office.com/en-us/article/bitlshift-function-c55bb27e-cacd-4c7c-b258-d80861a03c9c
https://support.office.com/en-us/article/bitor-function-f6ead5c8-5b98-4c9e-9053-8ad5234919b2
https://support.office.com/en-us/article/bitrshift-function-274d6996-f42c-4743-abdb-4ff95351222c
https://support.office.com/en-us/article/bitxor-function-c81306a1-03f9-4e89-85ac-b86c3cba10e4
https://support.office.com/en-us/article/complex-function-f0b8f3a9-51cc-4d6d-86fb-3a9362fa4128
https://support.office.com/en-us/article/convert-function-d785bef1-808e-4aac-bdcd-666c810f9af2
https://support.office.com/en-us/article/dec2bin-function-0f63dd0e-5d1a-42d8-b511-5bf5c6d43838
https://support.office.com/en-us/article/dec2hex-function-6344ee8b-b6b5-4c6a-a672-f64666704619
https://support.office.com/en-us/article/dec2oct-function-c9d835ca-20b7-40c4-8a9e-d3be351ce00f
https://support.office.com/en-us/article/delta-function-2f763672-c959-4e07-ac33-fe03220ba432
https://support.office.com/en-us/article/erf-function-c53c7e7b-5482-4b6c-883e-56df3c9af349
https://support.office.com/en-us/article/erf-precise-function-9a349593-705c-4278-9a98-e4122831a8e0
https://support.office.com/en-us/article/erfc-function-736e0318-70ba-4e8b-8d08-461fe68b71b3
https://support.office.com/en-us/article/erfc-precise-function-e90e6bab-f45e-45df-b2ac-cd2eb4d4a273
https://support.office.com/en-us/article/gestep-function-f37e7d2a-41da-4129-be95-640883fca9df
https://support.office.com/en-us/article/hex2bin-function-a13aafaa-5737-4920-8424-643e581828c1
https://support.office.com/en-us/article/hex2dec-function-8c8c3155-9f37-45a5-a3ee-ee5379ef106e
https://support.office.com/en-us/article/hex2oct-function-54d52808-5d19-4bd0-8a63-1096a5d11912
https://support.office.com/en-us/article/imabs-function-b31e73c6-d90c-4062-90bc-8eb351d765a1
https://support.office.com/en-us/article/imaginary-function-dd5952fd-473d-44d9-95a1-9a17b23e428a
https://support.office.com/en-us/article/imargument-function-eed37ec1-23b3-4f59-b9f3-d340358a034a
https://support.office.com/en-us/article/imconjugate-function-2e2fc1ea-f32b-4f9b-9de6-233853bafd42
https://support.office.com/en-us/article/imcos-function-dad75277-f592-4a6b-ad6c-be93a808a53c
https://support.office.com/en-us/article/imcosh-function-053e4ddb-4122-458b-be9a-457c405e90ff
https://support.office.com/en-us/article/imcot-function-dc6a3607-d26a-4d06-8b41-8931da36442c
https://support.office.com/en-us/article/imcsc-function-9e158d8f-2ddf-46cd-9b1d-98e29904a323
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Function Description 

IMCSCH function 

 

Returns the hyperbolic cosecant of a complex number 

IMDIV function 

Returns the quotient of two complex numbers 

IMEXP function 

Returns the exponential of a complex number 

IMLN function 

Returns the natural logarithm of a complex number 

IMLOG10 function 

Returns the base-10 logarithm of a complex number 

IMLOG2 function 

Returns the base-2 logarithm of a complex number 

IMPOWER function 

Returns a complex number raised to an integer power 

IMPRODUCT function 

Returns the product of from 2 to 255 complex numbers 

IMREAL function 

Returns the real coefficient of a complex number 

IMSEC function 

 

Returns the secant of a complex number 

IMSECH function 

 

Returns the hyperbolic secant of a complex number 

IMSIN function 

Returns the sine of a complex number 

IMSINH function 

 

Returns the hyperbolic sine of a complex number 

IMSQRT function 

Returns the square root of a complex number 

IMSUB function 

Returns the difference between two complex numbers 

IMSUM function 

Returns the sum of complex numbers 

IMTAN function 

 

Returns the tangent of a complex number 

OCT2BIN function 

Converts an octal number to binary 

OCT2DEC function 

Converts an octal number to decimal 

OCT2HEX function 

Converts an octal number to hexadecimal 

 

Other Functions 
Other functions groups, such as Cube, Information, Compatibility, & Web are also located at 

support.office.com (anonymous, 2020). 

Defined Names Group: 

 

Cells can be named in excel to simplify equations in Excel. For example, I may decide to enter the 

numbers 1-5 in cells A1-A5. By highlighting cells A1-A5 we can name these cells “numbers” in the upper 

left-hand corner name box by entering the text. Now, these group of cells will be referred to by the title 

https://support.office.com/en-us/article/imcsch-function-c0ae4f54-5f09-4fef-8da0-dc33ea2c5ca9
https://support.office.com/en-us/article/imdiv-function-a505aff7-af8a-4451-8142-77ec3d74d83f
https://support.office.com/en-us/article/imexp-function-c6f8da1f-e024-4c0c-b802-a60e7147a95f
https://support.office.com/en-us/article/imln-function-32b98bcf-8b81-437c-a636-6fb3aad509d8
https://support.office.com/en-us/article/imlog10-function-58200fca-e2a2-4271-8a98-ccd4360213a5
https://support.office.com/en-us/article/imlog2-function-152e13b4-bc79-486c-a243-e6a676878c51
https://support.office.com/en-us/article/impower-function-210fd2f5-f8ff-4c6a-9d60-30e34fbdef39
https://support.office.com/en-us/article/improduct-function-2fb8651a-a4f2-444f-975e-8ba7aab3a5ba
https://support.office.com/en-us/article/imreal-function-d12bc4c0-25d0-4bb3-a25f-ece1938bf366
https://support.office.com/en-us/article/imsec-function-6df11132-4411-4df4-a3dc-1f17372459e0
https://support.office.com/en-us/article/imsech-function-f250304f-788b-4505-954e-eb01fa50903b
https://support.office.com/en-us/article/imsin-function-1ab02a39-a721-48de-82ef-f52bf37859f6
https://support.office.com/en-us/article/imsinh-function-dfb9ec9e-8783-4985-8c42-b028e9e8da3d
https://support.office.com/en-us/article/imsqrt-function-e1753f80-ba11-4664-a10e-e17368396b70
https://support.office.com/en-us/article/imsub-function-2e404b4d-4935-4e85-9f52-cb08b9a45054
https://support.office.com/en-us/article/imsum-function-81542999-5f1c-4da6-9ffe-f1d7aaa9457f
https://support.office.com/en-us/article/imtan-function-8478f45d-610a-43cf-8544-9fc0b553a132
https://support.office.com/en-us/article/oct2bin-function-55383471-3c56-4d27-9522-1a8ec646c589
https://support.office.com/en-us/article/oct2dec-function-87606014-cb98-44b2-8dbb-e48f8ced1554
https://support.office.com/en-us/article/oct2hex-function-912175b4-d497-41b4-a029-221f051b858f
https://support.office.com/en-us/article/excel-functions-by-category-5f91f4e9-7b42-46d2-9bd1-63f26a86c0eb
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“numbers” when using a formula or searching for specific cell locations and calculations.

 

I can create a formula in cell A6 =sum(numbers) and Excel will understand that I want to add all of the 

data in Cells A1-A5 because I named those cells numbers. The formula bar displays the cell name. 
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The Name Manager icon  in the Defined Names group allows for easy management of cell names. 

Users can delete, edit, and create new names to use in cells and formulas.

  

By selecting the Define Name/icon, users may utilize the New Name Dialog box to select name their cells 

and also provide a definition of what their name (or group) of cells is named for. This is another way to 

name a group of cells than was previously provided. 

 

The Use in Formula icon  contains a drop-down that contains a list of all the named 

ranges in the workbook. The Paste Names command displays the "Paste Name" dialog box that can 

paste a name into the formula bar for use when creating a formula.
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Finally, the Create from Selection   Displays the "Create Names from selection" dialog 

box. This enables you to name a selected range of cells using a row or column title previously entered. 

 

Formula Auditing Group 

The Formula Auditing group helps the user 

understand which cells are being used by formulas and check for errors to make sure formulas are 

calculating accurately. 

The Trace Precedents Icon Displays arrows that indicate what cells affect the value of the 

currently selected cell. Usually, these cells are included in a formula. As provided in the previous 

example, a Trace President shows that the Sum of cells A1-A5 is 15 and the cells included are outlined.



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

215 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

 

The Trace Dependents icon  Displays arrows that indicate what cells are affected by 

the value in the currently selected cell. Trace Dependents is the opposite of Trace Precedents. 

The Remove Arrows icon  Button with Drop-Down. The button removes all the arrows 

drawn by the trace precedents and trace dependents. The drop-down contains the commands for more 

fine-tuning: Remove Arrows, Remove Precedent Arrows and Remove Dependent Arrows. 

The Show Formulas icon - (Ctrl + ') allows the user to toggle between showing 

formulas in the cells and the result of the formula in all cells in a worksheet.  

The Error Checking icon  with more drop-down options displays the "Error Checking" 

dialog box. If you have created a formula that is not working correctly, the Error Checking dialog box can 

assist. As demonstrated below, the formula was changed to include the addition of cell B1, which 

contains no data. Error checking provides an analysis of the formula, and options to correct the error. 
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The drop-down contains the commands: Error Checking, Trace Error, and Circular References. All 

commands will only activate if the worksheet contains an error. 

The Evaluate Formula icon displays the Evaluate Formula dialog box. In the previous 

example provided, the formula did not include a value in cell B1, so it was incorrect, the Evaluate 

formula dialog box provides information that the problem is cell B1 because it is empty. The buttons 

Step in and Step Out allow the user to review each aspect of the formula to determine where the error is 

(in this case it is in Cell B1 as described in the dialog box.
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 Finally, the Watch Window icon - Displays the. Watch Window. 

Allows you to view the 

contents of cells and their results as you make changes in other places in the document. Using the watch 

window, you can Add Watch by selecting a range of cells and click Add Watch. This will allow the user to 

continue to view the value of those cells as they work in other places in the workbook. This can be 

helpful if a user is working in a complicated formula that may change a value that is very important.  

 

The Calculation Group 

 

By default, Excel automatically calculates every formula automatically. This means that when values in a 

cell change, the formula recalculates immediately to display the correct information. However, there 

may be occasions when you do not want this to happen. The Calculation group allows the user to have 

flexibility in terms of when values are calculated. In most cases, the user should not change the 

Calculation Options from automatic, but it is nice that Excel provides the user the flexibility. 

The first icon, Calculation Options contains a drop-down menu that allows the user to quickly change 

the calculation setting in the active workbook between Manual, Automatic and Automatic except for 

Data Tables.  

The Calculate Now icon (F9) allows the user to recalculate all formulas in a workbook if the calculation 

setting was set to manual. 

Likewise, the Calculate Sheet icon- (Shift + F9). Allows the user to update all of the calculations in a 

worksheet if calculation settings were sent to manual. 
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Checking for understanding 
1. Your supervisor has requested that you create a supplies budget request for your department 

for next year. Your supervisor would like you to create three budget request worksheets 

Elements of the Budget request should contain the following columns: 

a. Budget Item 

b. Quantity 

c. Price per item 

d. Subtotal Total cost 

e. Tax on item (6.5%) 

f. The grand total of item cost 

The Budget should contain a Grand Total of all Budget expenses. It is expected that you have at 

least ten (10) budgeted items. In addition, your supervisor has asked you to create three budget 

requests- one normal request, one for lean times (.95% of original budget request), and one for 

good times (107% of budget). 

Please create three budget requests on three worksheets using formulas. 
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Chapter 19: Data Tab 

 

The Data Tab contains a variety of commands in Excel import, organize, and ensure data is accurate. The 

Data Tab consists of the following groups: Get & Transform Data, Queries & Connections, Sort & Filter, 

Data Tools, and Forecast. 

Get & Transform Data 

 

The Get & Transform Data group is responsible for importing data from a variety of sources. You can 

search for data sources, make connections, and then change data (for example remove a column, 

change a data type, or merge tables) in ways that meet your needs. Once you’ve shaped your data, you 

can share your findings or use your query to create reports. The following information was retrieved 

from www.support.office.com  

You can begin a new query by selecting the  Get Data icon. Select a data source. Users will have the 

option to select from obtaining data from a file on their PC, from an Access Database, from Microsoft 

Azure, from an Online Service, or other services. 

https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-a8310388-2a12-438c-9d29-c6d29cb8df6a
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When you connect to a data source, Get & Transform displays a Navigator pane, which allows you to 

edit the data from its source. When you select Edit from the Navigator window, Get & Transform 

launches the Query Editor, which is a dedicated window that facilitates and displays your data 

connections and the transformations you apply.  

Queries & Connections Group 

 

Once you have imported data, you can use the Queries & Connections Group to also adjust the data. 

Queries and Connections launches a Queries & Connections dialog box, and the Refresh all command 

retrieves the data again from its original source. 
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Sort & Filter Group 

 

The Sort & Filter group is responsible for assisting the user in organizing their data. Sort allows a table to 

be organized by one column. An example of the utility of the Sort commands is as follows- data is 

currently organized by State in the following table. In this example, let us imagine that the user would 

like to display the data below from largest to smallest 

State Number 

Wisconsin 2 

Texas 4 

New York 9 

Minnesota 1 

Alabama 3 

Using the Sort command , the Sort dialog box appears, and the user can choose to sort Column B 

Largest to Smallest. 

  

  



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

223 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

After selecting OK, the data is now displayed accordingly. Note that each State previously associated 

with each value continues to move with that value.  It is important to ensure that all cells that should be 

associated with a sort are selected to ensure one group of data does not move without the other. 

State Number 

New York 9 

Texas 4 

Alabama 3 

Wisconsin 2 

Minnesota 1 

Continuing with this data set, selecting the Filter icon will create a small box with an arrow pointing 

downward in the lower right-hand corner of the screen  of the first row of the dataset. Selecting the 

arrow in the first column and row launches a filter options window. 

 

The Filter Options Window allows the user to sort the data in that column, and specify which 

information to include in the table. As an example, if only Minnesota was checked, only data with 

Minnesota in column one would be displayed.  The user can visually see that other rows are being 

omitted because there is a gap in rows, and the filter icon (box with a downward arrow) now appears 
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differently . The user can un-apply the filter, by selecting the filter icon again , or select the clear 

icon  in the Sort & Filter group. Likewise, the filter can be Reapplied by selecting the Reapply 

icon.  to add the filter back.

 

The Advanced icon  launches the Advanced Filter window which allows more customization 

of the cells that should be filtered and where the information should be displayed. 

 

Data Tools Group 

 The Data Tools group 

provides some powerful commands that allow a user to manipulate their data. Imagine you have 

imported a set of data from a web-based program that contains customer addresses interested in a 
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particular product. You would like to use the data to send out brochures with coupons to them about 

products they could buy. However, the data you received from your database contained all of the 

information in one cell per row. 

John Smith 111 East Road Paynesville, NY 11111 

Latisha Jones 1235 West Lane Sacramento, CA 22222 

Your mail merge program cannot print address labels for data in this format, as you require separate 

information in particular cells for first & last name, address, city, state, and zip code. Using the data tools 

group, you can manipulate the data to get the data into the required format.  

Converting Text to Columns 

By selecting Text to Columns icon, a Convert Text to Columns Wizard launches, allowing the user 

to determine how to separate the text into multiple columns.

 

The Delimited option allows the user to instruct Excel to separate text based upon a character in the 

text, while Fixed Width allows for the columns to be separated by their width. Usually, Delimited is the 

most useful option, but Fixed Width can be used if all of the data contain data sets that can be 

separated at the same measurements. For the purposes of this illustration, we will use Delimited. After 
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selecting Delimited and clicking Next, Step 2 of the Wizard is available. 

Now, the user can 

decide the specific type of Delimiter Excel can use to move the text into the next column. I have chosen 

the Space Delimiter (though I could also create a custom delimiter). A preview of the data is provided 

below. Selecting Next, the wizard will launch the final step of the wizard by allowing the user to 

determine which columns are to be included in the Wizard and the type of data in the cells and the 

location where the cells should be entered. The default is to begin in the same column as the original.  
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Finally, the user 

can select Finish to complete the Wizard. Now displayed is the information completely separated by 

spaces.  

John Smith 111 East Road Paynesville, NY 11111 

Latisha Jones 1235 West Lane Sacramento, CA 22222 

While the Excel function has correctly completed the task, the fields still are not in the correct format, 

because certain fields are supposed to be together. As a reminder, cells should contain the first & last 

name, address, city, state, and zip code. Now, we must use formulas in Excel to merge the data as 

needed. We can use the Concatenate Formula in a newly created Column we will name Full Name to 

combine the First and Last Name Fields. We add the formula “=CONCATENATE(A2," ", B2)” into the Full 

Name cell with the “ “ added so Excel places a space between the first and last name. After executing 

the formula, the First and Last Names are merged. 
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Now, we can add this formula to merge the other applicable cells, and hide the cells with information 

that is unnecessary. Now, we have the following table:  

Full Name Column
1 

Column
2 

Column
3 

Address City State  Zip 

John Smith 111 East Road 111 East Road Paynesville, NY 11111 

Latisha 
Jones 

1235 West Lane 1235 West 
Lane 

Sacramento
, 

CA 22222 

 We are almost completed, but we must first remove the comma “,” that is in the City field. To do so, we 

will use the Replace feature of Excel. We wish to find all commas and replace them with a space. 
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Finally, now our data is accurate.  

Full Name Address City State  Zip 

John 
Smith 

111 East 
Road 

Paynesville  NY 11111 

Latisha 
Jones 

1235 West 
Lane 

Sacramento  CA 22222 

Remove Duplicates 

The Remove Duplicates feature in the Data Tools group is also very helpful when working with a 

large set of data. To continue the example, let us imagine that we downloaded a large set of data that 

contained the names of every customer who had expressed interest in a product. So as not to waste 

resources or mail individuals twice, you decide you want to remove duplicates. Usually, the data set can 

be too large to accomplish this. However, using the Remove Duplicates feature, it is not. 

Full Name Address City State  Zip 

John 
Smith 

111 East 
Road 

Paynesville  NY 11111 

Latisha 
Jones 

1235 West 
Lane 

Sacramento  CA 22222 

John 
Smith 

111 East 
Road 

Paynesville  NY 11111 

With a cell selected in your table, selecting the Remove Duplicates icon will launch the Remove 

Duplicates wizard. The wizard will ask the user to determine which columns should be evaluated for 

duplicates. I will select the full name column. 
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After clicking OK, Excel removes the duplicate row information and informs the user that 1 duplicate 

values were found and removed. 

 

Data Validation Tool 

Excel’s Data Validation Tool  allows the user to specify which kinds of information can be inserted 

into a cell. The user can require only specified text, or limit a text field to numbers only. Selecting the 

Data Validation icon will launch a Data Validation wizard 

. Using the wizard, users can 

determine program excel to require a whole number, or decimal, or a list of options (that you provide 



Computer Fundamentals for Technical Students  
By: Nick Heisserer 
 
 

231 | P a g e  
Updated 4/2/2020 
Creative Commons CC-BY Attribution 4.0 International https://creativecommons.org/licenses/by/4.0/ 
 

from a range of cells in the workbook), date, time, a limit for text, and any other custom options. Users 

can also program the cells to display a message with instructions for the user. 

Consolidate, Relationships, and Manage Data Model & Forecast Group 

 (Retrieved from Office.com Help). Users can select the Consolidate 

Icon to summarize and report results from separate worksheets, you can consolidate data from each 

sheet into a master worksheet. The sheets can be in the same workbook as the master worksheet, or in 

other workbooks. When you consolidate data, you assemble data so that you can more easily update 

and aggregate as necessary. 

For example, if you have an expense worksheet for each of your regional offices, you might use 

consolidation to roll these figures into a master corporate expense worksheet. This master worksheet 

might also contain sales totals and averages, current inventory levels, and the highest-selling products 

for the entire enterprise. 

The Relationships & Manage Data Model icons allow the user to create relationships between different 

tables and workbooks of data. This might allow data to be matched between tables, or to connect the 

tables for more batch processing. As this is not a Beginner to Intermediate class, Relationships and 

Manage Data Model will not be addressed in depth. 

The Forecast Group  is made to make projections based upon different variables in formulas 

and create forecasts. This information is also saved for an advanced class. 

Outline Group 

Perhaps you are working with large sets of data that contain 

information that you want to keep together or organize. The Outline Group has a variety of tools that 

allow the user to group, ungroup, or subtotal sets of data together. Reviewing the data previously used 

an example, perhaps you would like to group this data because each of these customers requested 

information on the same day. To do so, highlight the cells to be included in a group, and select the 

Group icon in the ribbon. The user is provided with the choice to group either rows or columns (we 

select rows) and the cells are grouped. 
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  line to the left 

of the row headings is set to indicate the rows are together. The user can simply click the Ungroup icon 

to remove these from a group.  The subtotal icon quickly and compute rows of numerical data to 

calculate a subtotal. The Show and Hide Detail icons collapse and hide the group. 
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Checking for understanding 
1. You have imported the following information into Excel from your customer relations 

management system (CRM) 

Jim Jones jjones@gmail.com 1123 East Street Reno, NV 55434 500 

Catherine Ford cford@yahoo.com 3432 West Street Lansing, MI 233423 600 

Jules Brown jbrown@msn.com 4322 North Lane Marietta, GA 53234 1200 

a. Using the data function of excel, organize the data and add it to the following header 

groups. 

i. First & Last Name 

ii. Email Address 

iii. Street 

iv. City 

v. State 

vi. Zip 

vii. Quantity (last number) 

b. Sort the data from the largest quantity to the smallest 

c. Add a Data Validation column to the right of quantity with the heading “Shipped”? Make 

the options available only “Yes” “No” or “NA” 

d. Format the data as a table. 

mailto:jjones@gmail.com
mailto:cford@yahoo.com
mailto:jbrown@msn.com
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